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Preface

Copyright and Trademark Notice
Copyright 2019 Telestream, LLC. All rights reserved. No part of this publication may be 
reproduced, transmitted, transcribed, altered, or translated into any languages without 
written permission of Telestream, LLC. Information and specifications in this document 
are subject to change without notice and do not represent a commitment on the part 
of Telestream.

Telestream, CaptionMaker, Episode, Flip4Mac, FlipFactory, Flip Player, Gameshow, 
GraphicsFactory, Lightspeed, MetaFlip, Post Producer, ScreenFlow, Split-and-Stitch, 
Switch, Tempo, TrafficManager, Vantage, VOD Producer and Wirecast, are registered 
trademarks and Cricket, e-Captioning, iQ, iVMS, iVMS ASM, Inspector, MacCaption, 
Pipeline, Vidchecker, and Surveyor are trademarks of Telestream, LLC. All other 
trademarks are the property of their respective owners.

QuickTime, Mac OS X, Final Cut Pro, and Safari are trademarks of Apple, Inc. Bonjour, the 
Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

x

Wirecast supports the use of NewTek NDI™ technology; "NDI™" is a trademark of 
NewTek, Inc. For information about NDI™ visit  http://NDI.NewTek.com/ 

All other brand, product, and company names are property of their respective owners, and 
are used only for identification purposes.

MPEG-2 License Requirements
Telestream has obtained a license from MPEG LA, to produce MPEG-2 video, to meet the 
following requirement on behalf of its FlipFactory and Pipeline licensees: The use of this 

http://NDI.NewTek.com/ 
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product in any manner that complies with the MPEG-2 standard is expressly prohibited 
without a license under applicable patents in the MPEG-2 patent portfolio, which license is 
available from MPEG LA, L.L.C., 250 Steele Street, Suite 300, Denver, Colorado 80206.

Customer Support
Telestream offers technical support through our Website and Email. 
Email contacts: 

• Sales:  sales@telestream.net

• Support:  desktopsupport@telestream.net

Website Links: 

• How to Buy:  http://www.telestream.net/purchase/store.htm

• Support: 
 http://www.telestream.net/telestream-support/wire-cast/support.htm

– View our Library of Tutorials & Webinars

– Browse our Knowledge Base 

– Explore our Community Forum

We'd Like to Hear from You!
Telestream welcomes comments, feedback, and suggestions about your experience with 
Wirecast. You can reach us at desktopsupport@telestream.net

If you have suggestions about improving the tutorials or this guide, other Telestream 
documents, or our Website, please Email us at techwriter@telestream.net.

Limited Warranty and Disclaimers
Telestream, LLC. (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of shipment 
from factory:
Hardware and Media. The Product hardware components, including equipment supplied 
but not manufactured by the Company but NOT including any third party equipment that 
has been substituted by the Distributor for such equipment (the “Hardware”), will be free 
from defects in materials and workmanship under normal operating conditions and use.
Software. If software is supplied as part of the product, the software will operate in 
substantial conformance with specifications set forth in its product user's guide. The 
Company does not warrant that the software will operate uninterrupted or error-free, will 
meet your requirements, or that software errors will be corrected.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

techwriter@telestream.net
sales@telestream.net
desktopsupport@telestream.net
http://www.telestream.net/purchase/store.htm
http://www.telestream.net/telestream-support/wire-cast/support.htm
http://www.telestream.net/telestream-support/wire-cast/training.htm
http://www.telestream.net/telestream-support/wire-cast/faq.htm
https://telestreamforum.forumbee.com/category/wirecast
desktopsupport@telestream.net
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Hardware and Media. The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new Hardware 
components or Software Media. Components may not be necessarily the same, but will be 
of equivalent operation and quality. 
Software. If software is supplied as part of the product and it fails to substantially conform 
to its specifications as stated in the product user's guide, the Company shall, at its own 
expense, use its best efforts to correct (with due allowance made for the nature and 
complexity of the problem) such defect, error or nonconformity. 

Software Updates
If software is supplied as part of the product, the Company will supply the registered 
purchaser/licensee with maintenance releases of the Company’s proprietary Software 
Version Release in manufacture at the time of license for a period of one year from the 
date of license or until such time as the Company issues a new Version Release of the 
Software, whichever first occurs. To clarify the difference between a Software Version 
Release and a maintenance release, a maintenance release generally corrects minor 
operational deficiencies (previously non-implemented features and software errors) 
contained in the Software, whereas a Software Version Release adds new features and 
functionality. The Company shall have no obligation to supply you with any new Software 
Version Release of Telestream software or third party software during the warranty period, 
other than maintenance releases.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, neglect, 
or shipping, or as a result of service or modification by a party other than the Company, or 
(ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF 
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT 
LIMITATION, ANY WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. No oral or written information or advice given by the Company, 
its distributors, dealers or agents, shall increase the scope of this Limited Warranty or 
create any new warranties.

Geographical Limitation of Warranty. This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies. YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE 
LIABILITY OF TELESTREAM, LLC. WITH RESPECT TO THE PRODUCT, SHALL BE AS 
STATED IN THIS LIMITED WARRANTY. Your sole and exclusive remedy for any and all 
breaches of any Limited Warranty by the Company shall be the recovery of reasonable 
damages which, in the aggregate, shall not exceed the total amount of the combined 
license fee and purchase price paid by you for the Product. 

Damages. TELESTREAM, LLC. SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, 
INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR 
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CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE OR INABILITY TO USE 
THE PRODUCT, OR THE BREACH OF ANY EXPRESS OR IMPLIED WARRANTY, 
EVEN IF THE COMPANY HAS BEEN ADVISED OF THE POSSIBILITY OF THOSE 
DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS ESSENTIAL PURPOSE.
Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC.
848 Gold Flat Road
Nevada City, CA 95959
You can call Telestream, LLC. via telephone at (530) 470-1300.
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 Installation

Introduction
This topic guides you through installing (or upgrading) and activating Wirecast.

Topics
 Installing

 Activating

 Uninstalling

 System Requirements

Installing
To install Wirecast, follow these steps:

1. Download the installer from the Website at:  http://www.telestream.net/Wirecast/
overview.htm.

2. Run the installer (.exe) program and follow the instructions provided

Note: During installation, you will be asked if you want to install the Virtual 
Microphone feature. If you do (recommended), check the displayed check box and 
continue the installation. Installing Virtual Microphone requires administrative rights.

3. If you have an older version of Wirecast already installed on your computer, the 
installer upgrades to the newer version. Agree to the license terms and follow the 
instructions displayed by the installer program.

http://www.telestream.net/wire-cast/overview.htm
http://www.telestream.net/wire-cast/overview.htm
http://www.telestream.net/wire-cast/overview.htm
http://www.telestream.net/wire-cast/overview.htm
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Activating
When you purchased Wirecast a serial number was provided. This serial number must 
be registered in the Wirecast program to unlock the features of Wirecast. To register 
Wirecast follow these steps:

1. Run the Wirecast program.

2. Select Preferences from the File menu, select Licenses, then click Purchase. Once you 
purchase and obtain your license number, enter it into the Serial Number field and 
click Activate.

   

3. Close the Preferences window.

Your Wirecast program should now be fully activated.

Uninstalling
To uninstall Wirecast, follow these steps:

1. Run the Wirecast installer (.exe) program. 

2. The installer asks if you want to repair or remove the existing version. Select 
Remove to uninstall the existing version of Wirecast.

System Requirements
Operating System

• Minimum: Windows 7

• Recommended: Windows 10

Processor   

• Minimum: i5 dual-core @ 2.3GHz
NOTE: May be insufficient for 1080p+ or 60 fps workflows

Select Licenses

Click Activate

Click Purchase

Enter serial 
number
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• Recommended: i7 quad-core @ 2.8GHz+

Memory   

• Minimum: 4GB RAM   

• Recommended: 16GB+ RAM

Hard Drive   

• Minimum: 2GB, 7200 RPM for record to disk   
NOTE: Additional hard disk space required for record to disk

• Recommended: 500GB+, Solid State OS Drive

Graphics Card   

• Minimum: Intel HD, DirectX 11 capable    
NOTE: Insufficient for advanced Multi-Viewer workflows

• Recommended: Nvidia GeForce or AMD Radeon, 1GB+ video memory

Internet Connectivity    

• Minimum: Open HTTP/HTTPS port 80, RTMP port 1935, 
port 7272 for Remote Desktop Presenter

• Recommended: If behind a firewall, check with your CDN for any sites to whitelist

Note: You are strongly advised to run Wirecast using the Windows Aero Theme, which 
includes a hardware accelerated window manager. Problems may result if you use the 
Windows Classic Theme.

Desktop Presenter

Use the remote version of Desktop Presenter 2.0.8 with Wirecast. It is available as a 
separate download at:   http://dynamic.telestream.net/downloads/download-desktop-
presenter.asp?prodid=desktoppresenter.

Rendezvous

Wirecast Rendezvous uses WebRTC technology that can be very resource intensive. For 
the best experience, we suggest considering the following when choosing hardware.

Note: The following recommendations are based on a single simultaneous stream of 
720p30 x264 @ 4.0Mbps.

Bandwidth

• Add 4 Mbps

• Add 5+ Mbps
NOTE: To maintain reliability, bandwidth per guest decreases as more are added 

Processor

• i5 quad-core

http://dynamic.telestream.net/downloads/download-desktop-presenter.asp?prodid=desktoppresenter
http://dynamic.telestream.net/downloads/download-desktop-presenter.asp?prodid=desktoppresenter
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• i7 quad-core

Note: These are minimum recommended processors.  More demanding workflows 
may require a more capable CPU.

Internet Connectivity

• Requires internet connectivity with HTTP/HTTPS port 80, and RTMP port 1935 open 
for streaming, Remote Desktop Presenter requires opening port 7272.

• An internet connection is recommended for Wirecast license activation.

• For lowest quality (240p) streaming an upload rate of at least 650Kbps is required.

• 720p streaming requires an upload rate of at least 2500 Kbps.

• 1080p streaming requires an upload rate of at least 4500 Kbps.

• Consider lowering your canvas frame rate and/or streaming resolution to lower 
CPU usage.

• It is recommended that an upload rate of at least double the desired rate be avail-
able.

• Solid State Drive or fast RAID array recommended for ISO Recording and Replay 
functionality. Actual data rates will vary depending on quality level selected for 
MJPEG recording, as well as the resolution and frame rate selected.

• Windows MJPEG Best Quality Guidelines (Megabytes per second):

– 1080i and 1080p 29.97 and 30 FPS, MJPEG Best Quality – ~25MB/sec

– 1080p 60 FPS, MJPEG Best Quality – ~50 MB/sec

– 720p 59.94 and 60 FPS, MJPEG Best Quality – ~20 MB/sec

Recommended Hardware Specifications

• Intel Core i3 CPU @ 1.7 Ghz or higher recommended for 540p streaming with x264 
@ 30 fps.

• Intel Core i5 CPU @ 2.5 Ghz or higher recommended for 720p streaming with x264 
@ 30 fps.

• Intel Core i7 CPU @ 3.0Ghz or higher recommended for 1080p streaming with x264 
@ 30fps. 

Note: 60 FPS streaming will result in increased CPU usage and a high bit rate (4Mbps 
or higher) for good quality.

• Intel HD, NVIDIA GeForce, or AMD Radeon class graphics adapter that is DirectX 11 
capable.

• Minimum 4GB RAM, 2GB free hard disk space. Additional hard disk space required 
for recording to disk. 

Hardware Accelerated Encoding Requirements
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• Intel Quick Sync Video encoding requires an Intel CPU with an Intel® QuickSync 
Video core. List of Intel CPUs supporting QuickSync.

NVIDIA NVENC encoding requires an nvidia GPU with Kepler architecture or newer. 
NVIDIA only maintains a general list of supported GPUs.
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Introduction

Introduction
This guide is intended to help you understand how each feature of Wirecast operates 
and to provide you with information to help you make the best presentations possible.

Topics
 Wirecast Versions

 Wirecast Workflow

 Tutorials

 Two Ways to Use this Application

 Using AutoLive

 Main Window Layout

Wirecast Versions

Wirecast  is available in three versions: One, Studio and Pro.

Wirecast One is an entry level version of Wirecast. It has all the essential features of 
Wirecast without including the features found in the Studio and Pro versions. It is the 
most affordable way to get streams up and running. It allows a single camera input and 
streaming to one selected destination.

Note: Wirecast One includes Basic Support:  Free software upgrades, Online Case 
Submission (with a 24-hour Response Time Target), Knowledge Base, Telestream 
Community Forum.

Wirecast Studio provides you with live video streaming that enables two guests on 
Rendezvous, unlimited capture, live production, and encoding of HD and SD sources 
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for live streams broadcast to multiple servers and platforms simultaneously. It also 
includes a Stock Media Library, an advanced audio mixer, remote desktop presenter, 
multi-viewer outputs, and more.  Wirecast streams to Facebook, YouTube, Twitter and 
many other providers.

Features that pertain specifically to Wirecast Studio are indicated by the Studio icon 
(shown below):

Wirecast Pro is the professional edition and includes all the features of Wirecast Studio. 
It adds, up to seven guests on Rendezvous, 8-track audio output, Replay, support for 
more capture devices and IP cameras, web stream input, program feed output, pro 
audio FX, custom transitions, 3D virtual sets, and ISO recording. NDI outputs, and more. 
Features that pertain specifically to Wirecast Pro are indicated by the Pro icon (shown 
below):

 

Note: Studio and Pro licenses include Standard Support:  All features of Basic Support 
plus the Stock Media Library and an 8-hour Case Submission Response Time Target.

Wirecast Workflow
Wirecast is a powerful cross-platform live video switching, production, and encoding 
software. Because of its versatility in handling a variety of inputs and outputs, it 
typically fits in the middle of your broadcasting workflow. Wirecast can take the place 
of more traditional T-bar hardware switchers, graphics and title generators, or simply 
act as the back-end encoder for large switching systems. 

STUDIO

PRO
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Below is a diagram of the basic Wirecast workflow. In general, you will capture your live 
input devices (such as live camera feeds, iOS cameras, computer desktop, web feeds 
and more), produce your show using the full range of Wirecast production features 
(chroma key, graphics, titles, scoreboards, etc.), and then stream it live to web, LAN, or 
record locally.

Wirecast works with cameras, capture cards, and audio devices. It prepares media and 
then outputs it either by streaming to the Internet, CDNs, multicast/unicasts via LAN, 
locally via virtual output or second display.  

Tutorials
It is suggested that you first work through the tutorials in the Tutorials section. They are 
quick, informative, and the easiest way to become familiar with Wirecast.

Wirecast also provides a built-in tutorial environment that corresponds with the 
tutorials provided in Tutorials. The tutorials take about thirty minutes and provide a 
brief overview of how to set up a basic presentation and create your own broadcast.



Introduction
Two Ways to Use this Application

24

It is also suggested that you read Making Great Broadcasts. This topic shows you how 
you can easily make changes in your setup and improves the quality of your 
presentations.

Two Ways to Use this Application
There are two different ways you can use Wirecast:

• Presenter Is Operator The person conducting the presentation also operates 
Wirecast.

• Presenter Plus Operator The presenter concentrates on the content and someone 
else operates Wirecast. In this mode, the presenter never needs to know in detail 
how Wirecast works.

Presenter Is Operator
In this mode of operation, the person conducting the presentation simultaneously 
operates Wirecast.

Here are some suggestions for using Wirecast when you are both the presenter and 
operator:

• Keep it simple Set up Wirecast to make it easy for you to be the operator and the 
presenter. Set up your logo and titles so that you need to make very few changes 
during your presentation. Use a minimum number of shots so it’s easy for you to 
see which shot to choose.

• Keep the AutoLive feature on This enables you to present your shots with just one 
click. Though this limits your ability to perform complex presentations, it is the best 
way when the presenter is also the operator. To turn AutoLive on or off, select it 
under the Switch menu.

• Pre-configure your shots Make sure that all the shots are created prior to your 
presentation. Do not try to create or modify shots while broadcasting them.

• Use hot-keys for switching shots Wirecast provides a hotkey editor that enables 
you to easily assign hotkeys to your shots. 

Presenter Plus Operator
In this mode of operation, an engineer (or operator) is responsible for using Wirecast, 
and the presenter concentrates on the content of the presentation. 

Here are some suggestions for using Wirecast when you have both an operator and a 
presenter:

• Keep the AutoLive feature off This enables you to make several changes at one 
time before taking the changes live. However, to quickly make a shot live, press the 
Shift+Ctrl keys and click the shot. The AutoLive control is located under the Switch 
menu
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• Open the Preview window The operator should use Preview mode to examine 
everything before it becomes live. The Preview display control is located under the 
Layout menu.

• Use the Layer Windows to make more shots available Select New Layer Window 
from the Window menu to open additional layer windows so you can quickly flip 
between shots on several layers.

Startup
To start Wirecast , double-click the Wirecast icon that was placed on your desktop 
during installation.

     

When Wirecast starts up, you can (optionally) view the new features by clicking on the 
play button. Click Continue when you are finished.

     

Double-click 
Wirecast icon

Click the play button Click Continue
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Main Window Layout
Wirecast enables you to select which functions are displayed in the Main window. 
These functions are added or removed from the main window using the Layout menu.

      

Master Audio Displays or hides the Master Audio controls. (A check mark to the left of 
the menu item indicates that the audio controls are displayed.) Master Audio controls 
are located on the left and right sides of the Main window.

      

Show Live and Preview Enables you to select between displaying: the Preview 
Window only, the Live Window only, or both. A check mark to the left of the menu item 
indicates which of these three modes are active. You can also select one of these three 
modes by clicking on the mode selection buttons in the top right corner of the screen.

      

Master Audio controls

Both

Preview only

Live only
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Show Preview Only selection:

      

Show Live Only selection:

      

Show Live and Preview selection:

      

Preview Only button

Live Only button

Live and Preview button
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Using AutoLive
Some users of Wirecast may want to single-click a shot to make it become live. Other 
users may want to make several changes to the broadcast before making them live. You 
can use both methods in Wirecast.

The AutoLive feature is designed to offer a single-click operation for those users who 
want to simply click from shot to shot. The Edit window (or other windows) is not 
affected by the status of AutoLive.

When AutoLive is on, clicking a shot in the Main window automatically places the shot 
in the Live window. As a result, the Go button becomes inactive.

     

When AutoLive is off, clicking on a shot displays it in the Preview window, then clicking 
the Go button is required to place the shot in the Live window.

Preview
Preview displays what the broadcast will look like when you click the Go button. (The 
Go button is only active when AutoLive is off.) To display the Preview window, select 
Layout > Show Live and Preview, or Layout > Show Preview Only.

Go button

Preview window

Go button

Live window
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When you select an image in the Preview window, Resize and Rotate handles appear. 
Click and drag any of these handles to resize or rotate your image.

You can also snap an image in the Preview window to various alignments:  Snap to 
Center, Snap to Edge, Snap to Corner, or Snap to an Image. The yellow guide lines 
appear when the image is ready to snap into place. To temporarily disable the snap 
action, hold down the Alt key while moving an image into place (the yellow snap lines 

Preview window

Rotate handle

Preview image

Resize handle

Resize handle
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will not appear). Additionally, after selecting an image, the arrows keys can be used to 
nudge it into placement.

Master Audio
The Master Audio panel enables you to control the output volume level, mute audio 
output, and mute the line-out feed for Preview and Live windows. To display Master 
Audio for Preview and Live displays, click Layout > Master Audio. Click again to hide the 
Master audio controls.

    

Snap to Center
Snap to Corner 

Snap to Edge Snap to an Image

Live Master 
Volume 

Live Master 
Mute button

Live Line-Out 
Mute button

Live Decibel scale

Preview Master 
Volume 

Preview Line-Out 
Mute button

Preview Decibel 
scale
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The Preview and Live Master Volume control enables you to adjust the master audio 
volume for Preview and Live separately. Click and drag the slider control up or down to 
set the volume. The decibel scale next to the slider indicates the audio level. When you 
take a Preview shot live, the Live audio controls are set to the levels set in Preview. 

The Master Mute button mutes the Live window audio (what your viewers hear). Even 
when you mute the output, the encoder still generates audio but it is silent. If you do 
not want to broadcast audio, modify the Encoder Presets to not process audio through 
the encoder.

The Preview Line-Out Mute button and Live Line-Out Mute button control local volume 
(what you hear), not broadcast volume. When Line-Out is muted, audio is not sent to 
your headphones or speakers, but your viewers still hear the audio. The two controls 
are mutually exclusive -- you cannot have both on at the same time, but you can mute 
both.

Main Shot List
The Main window displays the Shot List at the bottom of the window.

       

Control/Status Bar
Control buttons and status information are displayed at the top of the Main window.

    

Main shot list

Stream button

Recording time

ISO record time

Record button
Streaming time

ISO Record

Display 
Preview Only

Display Live 
Only

Display Preview 
and Live

FPS/Dropped

Bitrate

CPU Usage
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Wirecast displays the following controls and statistics:

• Stream button Click to begin streaming. 

• Streaming time Displays how long you have been streaming. This value does not 
reset when you start/stop the broadcast. It is cumulative, which enables you to save 
portions of a broadcast to disk and still know the total amount of time.

• Record Button Click to begin recording.

• Recording Time This displays how long you have been recording. This value does 
not reset when you start/stop the broadcast. It is cumulative, which enables you to 
save portions of a broadcast to disk and still know the total amount of time. 

• ISO Record Click to begin ISO recording.

• ISO Record Time Displays the ISO recording time.

• FPS/Dropped Displays the current FPS (frames per second) rate, or the number of 
frames dropped while streaming. Click on display to toggle between FPS and 
Dropped Frames modes. (Displayed only while streaming.)

• Bitrate Displays the streaming bitrate. (Displayed only while streaming.)

• CPU Usage Displays the usage of the CPU in percent. (Displayed only while 
streaming.)

• Display Buttons These three buttons enable you to choose to display the Preview 
window, the Live window, or both in a divided display.

Note: To avoid decrease in video quality, Wirecast should not be used at CPU usage 
above 80%. See the Telestream Website for suggested configurations. You can also 
view streaming statistics by selecting Output > Show Statistics.
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Layers
Wirecast displays five layers in the Main Shot List window. They are numbered 1 
through 5 along the right side of the window. Each layer contains multiple shots that 
can be selected by clicking one. A red LED indicates that a shot is Live. (If AutoLive is 
turned on, when a shot is selected it is displayed in the Live window.) If you select 
multiple shots -- by selecting shots on multiple layers -- they will all be displayed in the 
Live window. But the shots are displayed in a layering manner, where layer 1 is on top 
and layer 5 is at the bottom (and layers 2 through 4 are layered in between). In the 
example below, the Logo in layer 2 is displayed on top of the River shot in layer 3.

Layer Windows
You can also open the Shot List in a separate window. Select Window > New Layer 
Window to display a list of the layer windows you can open (Master Layer 1 through 5). 
Select the layer you want to open and a new, separate layer window is displayed. 

      +

Layer numbersRed LED

Layered shot 
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This separate Shot List window works exactly like the Shot List panel in the Main 
window, except it enables you to open multiple Shot List panels. 

      +
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Tutorials

Introduction
The best way to get started using Wirecast is to quickly work through all its main 
features. This tour presents a series of three tutorials, each designed to help you 
understand how to create and stream presentations using Wirecast. 

As you work through these tutorials, you will also become familiar with important 
Wirecast concepts and how you can use them to deliver high quality broadcasts. The 
more you know about Wirecast, the better it will serve your streaming objectives.

Because each tutorial builds on the skills and knowledge you learn in the previous 
tutorials, it is recommended that you take the tutorials in succession. Working through 
all the tutorials takes about thirty minutes.

As you gain hands-on experience creating video and audio presentations - which leads 
to a working knowledge of Wirecast and its components and architecture - you will 
gain proficiency in using Wirecast.

Tutorials
 Tutorial 1: Basic Concepts

 Tutorial 2: Editing Shots

 Tutorial 3: Broadcasting

Note: You can run all of the tutorials without a license. However, a watermark on the 
video and an occasional voice-over on the audio are present until a valid license is 
activated. 

Note: For licensing information, select Preferences from the File menu, select License, 
then click Purchase. Or, you can contact Telestream at: desktopsales@telestream.net.
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Tutorial 1: Basic Concepts
The goal of this tutorial is to provide you with a quick but successful experience 
creating and streaming a presentation using Wirecast. 

This tutorial requires that you open the tutorial document in Wirecast. To do this, select 
Create Document for Tutorial from the Help menu in Wirecast. 

Note: If you are running the tutorial with Wirecast in demonstration mode, the 
Wirecast logo appears from time to time and audio output has a periodic voice-over.
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Tutorial Prep
To prepare for this tutorial you need to make several changes. Under the Switch menu, 
make sure Smooth and AutoLive options are turned on (check mark displayed), and 
Live/Preview Swap is turned off (no check mark displayed).

Under the Layout menu, make sure Show Live Only is selected (check mark displayed). 

All of these options will be changed later in the tutorial. 

The Wirecast Main window shows the AutoLive LED turned on and the Live Broadcast 
window (only) displayed.

Live Broadcast window displayed

AutoLive LED on
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The Main Window
Wirecast has two main display areas: Live Broadcast area and the Shot List. The Live 
Broadcast area is in the upper portion of the window displaying what Wirecast streams 
to your viewers (or what it records to disk). The Shot List, in the lower half of the 
window, displays the shots available for streaming.

What Is a Shot?
Wirecast uses the concept of a “shot” to construct presentations. A shot contains some 
form of media (pictures, video, etc.), along with any settings for that media. In its 
simplest form, a shot contains one piece of media such as a photo or a video clip. But it 
can also be something more complex, like a live camera with a title and background 
music. Or a shot can even be something even more complex like a Playlist of shots.

A shot can be edited and its settings can be changed (See Tutorial 2: Editing Shots). 
Shots are important because they enable you to configure a lot of information before 
you stream your presentation. This enables you to concentrate on creating a good 
production during your broadcast. 

Live Broadcast Area

Shot List
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Switching Between Shots
Individual shots are displayed in the Shot List. Click the Ripples shot in the Shot List area 
and the image fades into the Live Broadcast Area display. This is called “taking a shot 
live”. 

Shot in Live Broadcast Area

Click Ripples shot
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Click the shot labeled Clear Layer and the Ripples image fades to a blank screen. The 
Clear Layer shot enables you to display a blank shot, which is sometimes needed. 

Transitions
In the previous examples, a “fade action” occurred when you clicked on a shot. This is 
because the smooth transition is the default. 

Note: Wirecast does not support a true Dissolve transition. The Smooth transition is 
the closest choice for dissolve. The main difference is that when Smooth is used in 
transitions that involve position or size changes in the images, the smooth transition 
migrates from one image to the other rather than dissolving out of one and into the 
other. 

If you are transitioning from an “A to A” shot (a shot that contains a “picture in picture” 
effect, or a “side-by-side” shot) then Smooth will interpolate the difference between 
the shot elements’ position and size and will smoothly animate the changes. This will 
make a shot element bigger or smaller and move it on the screen as needed. However, 
if you are transitioning from an “A to B” shot (from one shot to an entirely different 
shot), then the Smooth transition will act like a traditional Dissolve and fade between 
the two images.

Blank shot in Live Broadcast Area

Click Clear Layer
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Transition controls are located just below the Live Broadcast Area where the two 
default transitions are shown: Cut and Smooth.

When Cut is selected, transitions are executed immediately. When Smooth is selected, 
transitions fade in and out (as demonstrated above).

But there are more than just two kinds of transitions, and only two transitions can be 
assigned to the Transition Panel. To select a different transition, click the small arrow on 
the right side of either transition button. When the list appears, select a new transition 
to be assigned to that button. You can also click the transition button itself and drag the 
mouse downward until the menu of selections is displayed.

        

For example, to change the left transition button from Cut to Bands, click the Cut 
button and drag downward until the menu appears. Select Bands from the menu. 
Bands should now be displayed as the left button. 

Click arrow to open menu

Select a 
transition

new Bands button
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Now click back and forth between the River and Ripples shots using Bands (Bands 
button selected).

These two transition buttons can also be selected by using the following key 
combinations: Ctrl+1 and Ctrl+2. 

Transition Speed 
You can also control how fast a transition occurs, by selecting Switch >Transition Speed. 
Your choices range from Slowest to Fastest.

Go Button 
The Go Button (or Ctrl+G) enables you to make a transition.

 Bands transition

Go button
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Clicking the Go button does nothing when Wirecast is in AutoLive mode. The only 
exception is that it will update a live shot if you have made changes to it using the Shot 
Editor. Later in this tutorial you will discover how to use the Go button to transition 
between different shots when AutoLive is off.

Layers 

Note: Before you start this section, please select Smooth as your transition.

Wirecast enables you display several shots in the Preview and Live windows at the same 
time by rendering them one on top of another according to Wirecast's Layer system. 
This is an excellent way to add and remove objects in your broadcast. 

Wirecast displays five layers in the Main Shot List window. They are numbered 1 
through 5 along the right side of the window. Each layer contains shots that can be 
selected by clicking a shot. A red LED indicates that a shot is selected. When a shot is 
selected it is displayed in the Live Broadcast window. If you select multiple shots (by 
selecting a shot on more than one layer) they will all be displayed in the Live Broadcast 
window. The shots are displayed in a layering manner, where layer 1 is on top and layer 
5 is at the bottom (and layers 2 through 4 are layered in between). 
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Select the Logo shot in layer 2 and the River shot in layer 3. The result is a layered shot 
containing both images.

Layers are displayed in a particular order: Layer 1 is on top, Layer 2 below it, Layer 3 
below Layer 2, etc. This tutorial, so far, has been operating on Layers 2 and 3. Clear 
Layer, Ripples, River shots (and more) are on Layer 3, but Layer 2 has only a logo and a 
Clear Layer shot.

    

Layer numbersSelect River 
shot

Layered shot 

Select Logo 
shot
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Each layer can be turned on or off by clicking the white LED light on the far right side of 
the layer window. Click the Layer 2 LED to remove the Logo shot. 

Click the LED again to turn Layer 2 back on and restore the Logo image.

Auto Live 
So far in this Tutorial, Wirecast has been running in AutoLive mode. This means that any 
selection you make in the Shot List is automatically placed into your Live Broadcast 
window. This mode is very useful for those users who want to set up all of their shots at 
once and then single-click them as they run their presentation. But the disadvantage of 
this single-click method is that you can only see one shot change at a time. Once you 
click a shot, your viewers also see it (with no preview for you of how it looks before 
broadcasting the new shot). 

Turn AutoLive Off 
An red LED, next to the Go button is lit when you are in AutoLive mode.

Click white dot to 
turn Layer 2 off

Logo removed

AutoLive LED
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For this tutorial, make sure AutoLive is off by un-checking AutoLive in the Switch menu. 
When you do this a dialog box is displayed informing you that AutoLive is off and 
transitions must be made using the Go button. Click OK in the dialog box to continue. 

Try clicking the Ripples and River shots, and notice that nothing happens in the Live 
Broadcast window because AutoLive is turned off. Now click the Ripples shot and then 
click the Go Button. The Ripples shot is immediately placed into the Live Broadcast 
window. Click the River shot and, as expected, nothing happens. Click the Go button  
and the River shot replaces the Ripples shot in the Live Broadcast window. 

Note: When AutoLive is off, you must always click the Go button (or press the Ctrl+G 
keys) to display the selected shot in the Live Broadcast Area. 

Multiple Changes
The benefit of having AutoLive off is that you can make several changes to your shot 
first, and then have all changes placed into the Live Broadcast window at the same 
time. To do this, first verify that AutoLive is off. Click Sample Title in layer 1, click Clear 
Layer Shot in Layer 2, and then click the Ripples Shot in Layer 3. Click the Go button (or 
Ctrl+G) to make the Ripples and Sample Title shots live at the same time.

Select Sample 
Title shot

Select Ripples 
shot

Layered shotsClick Go buttonSelect Clear 
Layer shot
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Preview 
One problem you may have noticed while running this tutorial is that you cannot see 
the changes you are making before broadcasting them. To solve this problem, Wirecast 
enables you to see a preview of what you broadcast. 

Select Layout > Show Live and Preview from the Main menu. A preview window is 
displayed to the left of the Live Broadcast window. The Preview window uses a green 
LED to identify it. The Live Broadcast window uses a red LED to identify it. These two 
colors (green and red) are also used to identify which shots are associated with the 
Preview or Live windows.

      

Green LED Red LED
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Click the River shot on Layer 3. The River shot is displayed in the Preview window. When 
shots are selected they display a green or red LED to indicate selection for Preview or 
Live windows.

    

Preview window Live window

Red LED (Live window)
Green LED (Preview window)
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Now click the Go button to place the River shot into the Live window. Click the Clear 
Layer shot in Layer 1 to remove the title from the River shot in the Preview window.

       

Turn on the Live/Preview Swap option by selecting Switch > Live/Preview Swap (check 
mark displayed). Notice that the Go Button displays a double-arrow, indicating that the 
Live/Preview Swap option is on.  

Select the Ripples shot and click the Go button to place the Ripples Shot into the Live 
window. Notice that the Ripples and River shots have swapped (between Preview and 
Live windows). The shot LED’s have also changed color.  The green shot LEDs indicate all 
shots included in the Preview window and the red LEDs indicate the shots included in 

Click Clear Layer Shot Click Go button

Preview shot became Live shot

Double-arrow
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the Live window. This lets you know what your last Live window looked like as you 
prepare your next shot in the Preview window.

      

Red LEDs show Live window shots

Ripples and River shots swapped

Green LEDs show Preview window shots
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Tutorial 2: Editing Shots
The first tutorial used only the Main window, and explained various ways in which you 
can use an existing shot. But shots can also be created and edited. This tutorial 
demonstrates how to edit your shots.

To edit a shot, double-click its icon in the Shot List. This opens the Shot Editor panel.

Double-click 
a shot

Shot Editor panel
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The shot editor has six tabs: Shot Layers, Shot Layer Properties, Audio, Chroma Key 
Properties, Smooth Transition Properties, and Additional Properties.

   

Shot Properties Enables you to add and delete sources and change the display order 
(change layering within the shot).

Shot Layer Properties Enables you to change the size, position, and other properties 
of a shot source.

Audio Properties Enables you to set audio levels and other controls. You can also 
monitor audio levels. 

Chroma Key Properties If a source in your shot uses a chroma key, this tab enables you 
to configure the chroma key settings. Each source in a shot can have its own chroma 
key settings.

Additional Properties Enables you to set any additional properties for a source in your 
shot: System Device properties, Screen Display properties, Twitch Widgets (Chat and 
Followers), etc.

See Shot Editor for details on how to use the Shot Editor.

Shot Layers tab

Chroma Key Properties tab

Smooth Transition Properties tab

Shot Layer Properties tab

Audio tab

Additional Properties tab
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Tutorial 3: Broadcasting
This tutorial demonstrates how to setup and broadcast your Wirecast presentations. 
You can broadcast to a specific computer (Unicast), multiple viewers (Multicast), or 
even record your broadcast to disk.

There are two main components for broadcasting your presentation (or saving it to 
disk): Encoding and Selecting a Destination.

You need to decide how you are going to encode your broadcast. Encoding is the type 
of compression used (JPEG, MPEG4, etc.). Wirecast comes configured with many 
common encoding options.  (Dee The Encoder Presets Window for details.). 

A destination for the broadcast must be selected. You can send it to a server for 
broadcast or save it to disk.

Streaming
Click the Stream button to start streaming.

        

The Stream icon will blink until a connection is made. Once you are connected the 
Stream icon turns green. If you cannot connect an error message will display. 

        

Connection strength is indicated by how many bars are displayed in the Stream icon. 
Fewer bars indicates a weaker (slower) connection.

        

If the connection is ever broken, a no connection icon is displayed in place of the bars.

        

When the connection recovered, the no connection icon is replaced with the green bars.

Click the Stream button

Green Stream icon

Green connection 
strength bars

No connection icon
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Click Stream again to stop streaming. You can also record your broadcast by clicking 
Record. When you stop streaming, if you. 

        

While streaming, status is displayed.

       

If you are streaming to Facebook, additional status is displayed on the right side of the 
status bar.

         

If you are streaming via the Cloud, additional status is displayed on the right side of the 
status bar.

         

Telestream Cloud Settings

Note: Cloud-based streaming and distribution is available in Wirecast for an 
additional monthly subscription.  Visit the Telestream website for more information.

The Telestream Cloud enables you to add automated live captioning to your broadcast. 
But it also allows you to do “re-streaming” (multi-distribution of your broadcast 
through the Cloud).

When you request automated captioning, the Cloud server will send out the audio 
portion of your broadcast for translation into text. When the text is received, it is 
embedded as 608/708 captions in the outgoing stream.

Streaming 
time

Recording 
time

ISO Recording 
time

CPU usage

Frame rate
Streaming rate

Various 
reactions

Number of 
viewers

Cloud icon Cloud status
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When you request stream redistribution, the Cloud takes your single stream source 
received from Wirecast and distributes it to multiple endpoints in a high bandwidth 
environment.

Cloud settings are accessed on the Output Settings window (Output > Output Settings). 
Click Telestream Cloud Settings to open the Cloud Settings window.

If you are not already Logged In to the Cloud, a Welcome window will display.  Log in by 
clicking Log In.  If you are not Signed Up with Telestream Cloud, you can do so by 
clicking Sign up.

Click to open Settings window

Click to open Settings window

Click Sign Up or Log In
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If you click Sign Up, a sign up window will display.  Enter all requested information and 
click Sign Up.

When the Activate Account window displays, wait until you receive your Activation 
Code via phone call or text.  Enter the activation code and click Activate my account.  If 

Enter information

Click Sign Up
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you do not receive an activation code, or if the code does not work, request a new one 
by clicking Resend Code.

Once you are logged in, clicking the Telestream Cloud Settings button will open the 
Cloud Settings window. 

For captioning, select a language. You can, optionally, enable live captioning.  

Note: When you check this option, all of your streaming destinations via the Cloud 
will include automatic live captions. 

For re-streaming, select Encoding for all destinations that are re-streamed via the 
Cloud. Click the Get More or the Manage Account button to navigate to the Telestream 
Cloud Dashboard. 

When you are ready to select multiple streaming destinations to be used by the Cloud, 
open the Output Settings window (Output > Output Settings) and select multiple 
streaming destinations by clicking the Add button. Check Enable for all destinations to 

Click Activate

Enter activation 
code received

Click Manage account

Check Enable Live Captions

Select a language
Click Get More (optionally)

Select Encoding

Click Log Out
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be included in the Cloud streaming distribution. Click Telestream Cloud Settings to open 
the Cloud Settings window.

Note: When Enable is checked, Encoding is grayed-out.  This is because encoding for 
all distributed streams is set on the Cloud Settings page.

Click Add Check Enable

Click Telestream Cloud Settings 
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Main Window

Introduction
This section describes in detail how to use the Main Window in Wirecast.

Topics
 Overview

 Control/Status Bar

 Preview/Live Broadcast Area

 Countdown Clock Display

 Transition Controls

 Add Shot Menu

 Add Shot Menu

 Add Shot Menu

 Shot Selection Area

 Layers

 AutoLive

 Live Icons

Overview
The Main Window is comprised of these display areas: 

• Controls/Status Area The top area with the Stream and Record buttons.

• Preview/Live Broadcast Area The large area in the center.

• Transition Controls The area with the Transition (Cut and Smooth) and Go buttons.
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• Shot Selection Area The area displaying the shot icons (available shots).

Control/Status Bar
Control buttons and status information are displayed at the top of the Main window.

    

Wirecast displays the following controls and statistics:

• Stream button Click to begin streaming. 

Preview/Live 
Broadcast Area

Transition 
Controls

Shot Selection 
Area

Control/
Status Area

Stream button

Recording time

ISO record time

Record button
Streaming time

ISO Record

Display 
Preview Only

Display Live 
Only

Display Preview 
and Live

FPS/Dropped

Bitrate

CPU Usage
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• Streaming time This displays how long you have been streaming. This value does 
not reset when you start/stop the broadcast. It is cumulative. This enables you to 
save portions of a broadcast to disk and still know the total amount of time.

• Record Button Click to begin recording.

• Recording Time This displays how long you have been recording. This value does 
not reset when you start/stop the broadcast. It is cumulative. 

• ISO Record Click to begin ISO recording.

• ISO Record Time Displays the ISO recording time.

• FPS/Dropped Displays the current FPS rate or the number of frames dropped 
while streaming. Click on display to toggle between FPS and Dropped. (Displayed 
only while streaming.)

• Bitrate Displays the streaming bitrate. (Displayed only while streaming.)

• CPU Usage Displays the usage of the CPU in percent. (Displayed only while 
streaming.)

• Display Buttons These three buttons enable you to choose to display the Preview 
window, the Live window, or both in a divided display.

Note: To avoid decrease in video quality, Wirecast should not be used at CPU usage 
above 80%. See the Telestream Website for suggested configurations.

Preview/Live Broadcast Area
When you open a new document, the Live area shows what is broadcast to your 
viewers before the encoding or compression. When AutoLive is off, you can make 
several changes without your viewers seeing the change. This is most useful when you 
are using an engineer to run your broadcast. When you are making changes to your 
broadcast, you may want to see those changes before broadcasting them. Preview 
allows you to do this.
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To see the preview, select Preview from the Layout menu. This sets up the Main Window 
with the Preview Area on the left and the Live Broadcast Area on the right. Clicking the 
Go button makes the preview shot become Live.

     

Countdown Clock Display
The Main window displays a countdown clock whenever a video shot is playing. If you 
have multiple video shots playing, click the gear menu icon to select which shot will be 
associated with the countdown clock.

Preview Area Live Broadcast Area

Click Go button

Gear iconCountdown clock
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Transition Controls
The transition area is in the middle of the Main Window: 

   

There are two Transition buttons, but each can be configured to present one of many 
possible transition types. In the image above, the two configured transitions are: Cut 
and Smooth. Since Smooth is selected (button darkened), any transition executed by 
clicking Go is a smooth transition. 

Changing Transitions
If you click the Cut button, it becomes selected and making it the current transition 
type: 

You always have two different transition types available. You can also select one of the 
two buttons by pressing Ctrl+1 or 2 keys for the two transition types displayed.
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If you click the down-arrow on the right side of either transition button, you can select a 
new transition to assign to that button.

        

Transition Speed
The transition speed is set by selecting Switch > Transition Speed. There are five settings: 
Slowest, Slow, Normal, Faster, and Fastest.

Go Button 
The Go Button (or Ctrl+G) enables you to make a transition occur at any time.

   

Click arrow to open menu

Select a 
transition type

Go button
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Clicking the Go button does nothing when Wirecast is in AutoLive mode, except to 
update a live shot if you have made changes to it using the Shot Editor. 

Add Shot Menu
The Add Shot menu provides a way to add live sources, file sources, the Desktop 
Presenter program, shot graphics, shot audio, and shot templates, etc.  Click the Plus 
Button (+) to open the Add Shot menu.

When the Add Shot menu displays, select a shot category, select the type of shot to 
add, then click the Add button.To add a media file, click the Add Media File button., 
navigate to a media file, click Open, then click the Add button.

To select a source as a Favorite (cause it to display in the Favorites menu) click the star 
icon to turn it white.

          

Video Capture

• System Device Select a system device and click the Add button. (See Capture 
Devices Properties).

Click Add 
Shot button

Select shot 
category

Select 
shot type

Select as 
favorite

Click Add Media 
File button

Click Add
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• Wirecast Gear Video Inputs  If you using Wirecast Gear (and have a active license) 
all available video inputs will be listed.

          

Audio Capture

• System Device Select a system device and click the Add button. (See Capture 
Devices Properties).

• ASIO Audio Capture Select an ASIO audio capture device and click the Add button. 

• System Audio Capture Select an audio capture device and click the Add button. 

• WASAPI Audio Capture Select a WASAPI capture device and click the Add button. 

Media Files

• Browse Disk Select to navigate to a media file.

• Stock Media Library Select to display the Stock Media Library window.

Network

• IOS Cam Select an ISO Camera device and click the Add button.

• Rendezvous Select to create a new Rendezvous session, or select to reconnect to a 
previously created session.  Click the Add button when finished.

• Web Display  Creates a new Web Display shot. Select and click the Add button. (See 
Web Page Properties).

• Web Stream  Creates a new Web Stream shot. Select and click the Add button.  (See 
Web Stream Properties).
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Screen Capture

• Remote Desktop Presenter Creates a new Remote Desktop Presenter shot.  Select 
and click the Add button.  (See Remote Desktop Presenter Properties).

Screen Capture Creates a new Screen Capture shot of any monitor or window on your 
computer.  Select and click the Add button. (See Screen Capture Properties). Some apps 
when screen captured, take control of your mouse and the cursor is not displayed. You 
can, at any time, press Alt + Tab keys to reduce the capture window size and enable you 
to use your mouse. Overlays

• Clock   Creates a new Clock shot that displays time. Select and click the Add button. 
(See Clock Properties).

• Image Carousel   Creates a new Image Carousel shot that shows a sequence of 
images. Select and click the Add button.(See Image Carousel Properties).

• QR Code Generator   Creates a QR code display to present to your viewers in a live 
broadcast. (See QR Code Generator Properties). 

• Scoreboard  Creates a new Scoreboard shot. Select and click the Add button. (See 
Scoreboard Properties).

• Text  Creates a new Text shot. Select and click the Add button. (See Text Shot Proper-
ties).

• Title  Creates a new Title shot. When the window of titles displays, select a title and 
click OK. Click the Add button when finished. (See Titles Properties).

     

• Twitter Feed  Creates a Twitter Feed shot. Select and click the Add button. (See 
Twitter Feed Properties).

Backgrounds

• Web Page  Creates a new Web Display shot. Select and click the Add button. (See 
Web Page Properties).
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• Solid Color  Creates a new Solid Color shot. Select and click the Add button. (See 
Solid Color Properties).

• Virtual Set  Creates a new Virtual Set shot. When the window of sets displays, select 
a set and click OK. When finished, click the Add button. (See New Virtual Set Proper-
ties).

     

Shots

• New Shot  Creates a new shot. Select and click the Add button.

• New Playlist Shot  Creates a new Playlist shot. Select and click the Add button.

• New Shots From Clipboard  Creates a new shot that has been copied to the clip-
board. This is how you duplicate a shot. Select and click the Add button. 

Favorites Displays a list of shots that have been marked as a Favorite by clicking on the 
star on the right side of each shot in the Add Shot Menu.

     

Select as 
favorite
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All Displays all sources in one list.

Add Media File   Creates a Media File shot (video clip or picture). When selected, a 
navigation widow displays. Navigate to a media file location, select a media file, and 
click Open. (See Media File Properties).

Shot Selection Area 
The bottom part of the Main Window contains the Shot Selection Area, also called the 
Shot List. 

    

The shot icons can be made to display any live activity in the source it represents 
(cameras, streaming, etc.). See Performance in the Preferences section for turning on 
Live Icons.

Shot selection 
area
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Changing Shots
Right-click on any shot to display the shot menu.

Change Source Select Change Source to change the source of your shot. Upon 
selection, a menu of sources will display enabling you to make a selection.

Change Audio Select Change Audio to change the audio of your shot. Upon selection, 
a menu of audio sources will display enabling you to make a selection.

Change Template Select Change Template to change the template of your shot. Upon 
selection, a menu of templates will display enabling you to make a selection.

Keyboard Shortcut You can create a keyboard shortcut to any shot. To do this, select 
Keyboard Shortcut, then select a menu number to associate with that shot. After you 
have selected a menu number, that menu item is checked and the number is displayed 
in the shot icon.

Right-click shot

Select Keyboard Shortcut

Select a menu number

Menu item checked
Menu number displayed



Main Window
Shot Selection Area

71

To take a shot using the assigned hotkey, press the number key assigned to that shot.

You can assign multiple shots to the same menu number as long as they are on 
different layers. When you use the assigned hotkey all the shots assigned to it will be 
taken. Selecting a checked menu item will uncheck it and unassign the shot.

Select Unmap All Keys to remove all hotkey assignments.

Note: See also the section on Hot Keys for Hot Key management.

Edit Shot You can edit a shot by clicking the double arrows (located on the left side of 
the Preview window) to the right, revealing the shot editing panel. You can also edit a 
shot by double-clicking on it, by right-clicking it and selecting Edit Shot, by selecting 
Edit Shot from the Edit menu, or by selecting it and pressing the Ctrl+E keys.

Rename Shot You can rename a shot by right-clicking it and selecting Rename Shot, or 
by selecting Rename Shot from the Edit menu. You can also rename a shot by selecting 
it and pressing the Ctrl+R keys.

Duplicate Shot You can duplicate a shot by right-clicking it and selecting Duplicate 
Shot, or by selecting Duplicate Shot from the Edit menu. You can also duplicate a shot 
by selecting it and pressing the Ctrl+D keys.

Duplicate Shot Options Check a source to create a new instance of it when 
duplicating the shot containing it. Multiple selection is allowed.

      

Delete Shot You can delete a shot by right-clicking it and selecting Delete Shot, or by 
selecting Delete Shot from the Edit menu. You can also delete a shot by selecting it and 
pressing the Ctrl+Backspace keys.
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Move to Playlist Moves this shot to the selected playlist. If you have existing playlists, 
that can be viewed by selecting the Playlist tab. You can move a shot to another playlist, 
back to the main layer, by right-clicking the shot and selecting Move to Playlist.

Moving a Shot to Another Layer
You can move a selected shot to another layer by selecting Move to Layer from the Edit 
menu, then selecting the target layer from the drop-down menu. You can also move 
the cursor to the bottom of a shot icon (until the cursor becomes a hand), and then 
drag the shot icon to a different layer. 

When shots are created, they are assigned to a specific layer. They exist on that layer 
until they are moved or deleted. (See Layers.)

Resizing the Shot Icons
You can resize the shot icons on any layer by clicking the up or down arrow on the left 
side of the layer window. Click the up arrow to make all the icons larger; click the down 
arrow to make them smaller. Clicking the down arrow when the shot icons are in their 
smallest state causes the layer window to become hidden. 

     

Click Playlist tab

Click up or 
down arrow 
to resize
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To show or hide a layer, click the down arrow until layer is hidden. To show a layer, click 
the side arrow that represents a hidden layer.

     

Layers 
Wirecast allows you to put shots on any of five different layers. Layering shots enables 
Wirecast to merge them together, from back (lowest layer) to front, to form a single 
visual image during broadcast. 

When Wirecast first opens, all of the five layers of shots are displayed. You must scroll 
down (or expand the window) to see the other layers. 

   

What is a Layer? 
Layers are, by default, named 1 through 5. Layers determine the order when presenting 
images in the Live Broadcast Area. The Bottom layer (5) is drawn first, then the other 
layers are added, in order, up to Layer 1. Using multiple layers is a powerful way to show 
a company logo, a background, or a title, independent from each other. 

Click side 
arrow

Click down arrow 
repeatedly

Shot Layer 1

Shot Layer 2

Shot Layer 3
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Changing Layers
To select a layer, click its LED to turn it on (click it again to turn if off ). When a layer is 
selected, the selected shot in that layer is displayed in the Preview/Live Broadcast area. 
If multiple layers are selected all selected shots are displayed.

     

Moving a Shot to Another Layer
A shot can be moved to another layer by clicking and dragging the shot from one layer 
to another within the Main Shot window. To do this, hover over the shot Title Bar with 
the mouse until the hand icon displays, then click and drag the shot to another layer.

     

When shots are created, they are assigned to a specific layer. They exist on that layer 
until you move them or delete them. 

Click LED to 
select layer

Shot Title Bar

Hand icon
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AutoLive
AutoLive is turned on and off by selecting Switch > AutoLive. When AutoLive is on, 
changes made in the Shot List are automatically taken Live in the broadcast (using the 
current transition and duration). If you click a shot when AutoLive is off, the shot is not 
sent to live broadcast. In this mode you take the shot live manually, by clicking the Go 
button, or by pressing the Ctrl+G keys.

Live Icons
You can, optionally, make your live source icon display its source (camera, Web stream, 
etc.) in real time. This means that inside the icon, you will see what the live source sees.

     

To turn on the Live Icon option (default is off), select the Performance tab in Preferences, 
then check the Live Icons checkbox.

Live source icon

Live source

Check On
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Note: There tends to be a degrading quality when an icon is live. So, if the CPU is 
reaching its maximum, turn off Live Icons to reduce CPU usage.
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Keyboard Shortcuts

Introduction
This section provides a list all of keyboard shortcuts used in Wirecast. They are arranged according to 
how they appear in the drop-down menus in the main window.

Note: See also the section on Hot Keys for Hot Key management.

General Shortcuts

* See Keyboard Shortcut in Changing Shots.

Misc Shortcuts Keyboard Shortcut
Display Shot <shot number key*>
Enter Selects left-hand transition 

button and clicks Go button
Space bar Selects right-hand transition 

button and clicks Go button
i Sets the media IN point
o Sets the media OUT point
e Sets the Replay IN point
= Increments Home score
- Decrements Home score
] Increments Visitor score
[ Decrements Visitor score
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File Menu

Edit Menu

Switch Menu

Media Menu

Output Menu

Layout Menu

Replay Menu

Social Menu

Window Menu

Help Menu

File Menu Keyboard Shortcut
New Ctrl+N
Open Ctrl+O
Import Media Ctrl+Shft+I
Save Ctrl+S
Save As Ctrl+Shft+S
Close Window Ctrl+W
Preferences Ctrl+Comma

Edit Menu Keyboard Shortcut
Undo Ctrl+Z
Redo Ctrl+Shft+Z
Edit Shot Ctrl+E
Rename Shot Ctrl+R
Duplicate Shot Ctrl+D
Delete Shot Ctrl+Backspace+Delete

Switch Menu Keyboard Shortcut
Go Ctrl+G
Cut Ctrl+1
Smooth Ctrl+2
AutoLive Ctrl+L
Live/Preview Swap Ctrl+Alt+W

Media Menu Keyboard Shortcut
Start Playing All Movies Ctrl+P
Pause All Movies Ctrl+Shft+P
Play to Next Point Ctrl+RightArrow
Jump to Previous Point Ctrl+LeftArrow

Output Menu Keyboard Shortcut
Output Settings Ctrl+Y
Start/Stop Broadcasting > Start All Ctrl+B
Start/Stop Recording > Start All Ctrl+K

Layout Menu Keyboard Shortcut
Go to Layer > Master Layer 1 Shift+Ctrl+T
Go to Layer > Master Layer 2 Shift+Ctrl+F
Go to Layer > Master Layer 3 Shift+Ctrl+N
Go to Layer > Master Layer 4 Shift+Ctrl+B
Go to Layer > Master Layer 5 Shift+Ctrl+A

Replay Menu Keyboard Shortcut
NO SHORTCUTS

Social Menu Keyboard Shortcut
NO SHORTCUTS

Window Menu Keyboard Shortcut
Inspector Ctrl+I
Encoder Presets Ctrl+Shift+E
Audio Mixer Ctrl+U
New Layer Window > 
Master Layer 1

Ctrl+T

Help Menu Keyboard Shortcut
Wirecast Help Ctrl+?
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Adding Media

Introduction
In addition to live video from your cameras, Wirecast enables you to work with media 
created outside of Wirecast. This section introduces some common media types you 
can use with Wirecast. You can add media by selecting Import Media from the File 
menu.

Topics
 Images/Opacity

Images/Opacity
Wirecast supports a wide variety of still images types (TIFF, GIF, JPEG, PNG, etc.). Some 
of these formats offer some form of opacity (or transparency). This is often called an 
Alpha Channel. Wirecast works seamlessly with these formats making them the 
preferred methods for using graphics and logos which have transparency.

GIF and Transparency
GIF files are a special case because they only offer transparency and not a true Alpha 
Channel. The GIF format enables you to define part of the image as transparent 
(completely invisible), but does not enable you to define it as partially transparent. 
Some GIF images use transparency for much of the image. However, near the edges of 
the visible data, transparency cannot be used. This happens quite often when there is a 
shadow near the edges of the visible data. The author of the GIF often assumes a 
certain background color (white, for example) and that color becomes embedded in 
the actual image.

When Wirecast displays these types of images, the edges of the visible data shows the 
background that was saved in the GIF. This is not a defect in Wirecast and, therefore, 
Wirecast can only present the data as it exists in the GIF. The solution is to obtain the 
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original image and re-save the image as either TIFF or PNG. Both of these formats offer 
full Opacity.

Real Media
Real Media Files (.RM) are not supported by Wirecast. The solution is to convert the 
media into a different type such as MPEG-4.

Supported Codecs
Shown below is a list of supported video and audio codecs.

Video Codec MOV 
(M4V)

MP3 MPEG-4 
ISO (MP4)

WAV AIFF 
(AIFF, AIF) 

ASF 
(WMV)

WEBM

AVC YES NO YES NO NO NO
H264 YES NO YES NO NO NO
DVC25 YES NO NO NO NO NO NO
DVCPRO50 YES NO NO NO NO NO NO
DVCPRO100 YES NO NO NO NO NO NO
MJPEG YES NO NO NO NO NO NO
ProRes YES 

(mac only)
NO NO NO NO NO NO

QuickTime 
Animation

YES NO NO NO NO NO NO

VP8 NO NO NO NO NO NO YES
VP9 NO NO NO NO NO NO YES
Windows Media 
Video

NO NO NO NO NO YES 
(windows)

NO

Audio Codecs
AAC YES NO YES NO NO NO NO
MP3 YES YES NO NO NO NO NO
Opus NO NO NO NO NO NO YES
PCM YES NO NO YES YES NO NO
Vorbis NO NO NO NO NO NO YES
Windows Media 
Audio

NO NO NO NO NO YES 
(windows)

NO
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PTZ Controller

Introduction

 

The PTZ Controller enables you to control PTZOptics brand cameras. This feature is 
implemented using the VISCA-over-IP protocol, an IP-based protocol which sends 
specific camera control commands to the camera to change Pan, Tilt, Zoom, Focus, 
Exposure, and White Balance. You can configure, interact with, and create up to 255 
preset settings in the PTZ Controller window.

Topics
 Setting Up PTZOptics Camera

 Configuring Wirecast

 Setting Up Wirecast Shots

 PTZ Controller Panel

 PTZ Control in the Shot Editor

PRO
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Setting Up PTZOptics Camera
PTZOptics cameras ship with a Static IP address set to 192.168.100.88. To communicate 
with your cameras on your network, you will need to change this to be in range of your 
existing network.

To set up your PTZOptics camera IP address, follow these steps:

1. To obtain a usable IP address for your camera, ensure you can access the video feed 
of your camera over HDMI or SDI (not IP). Since the IP address will be changing, you 
need to use HDMI or SDI to access the video feed. Connect the HDMI port of the 
camera to a TV, or if you are already using a capture card with Wirecast simply add 
the source to your document and queue it up in Preview.

2. To set your Camera to DCHP (Automatic) and make it addressable by your PC, enter 
“# * 4” (sequentially) using the camera remote control. (Do not press the buttons 
simultaneously.) The camera will display a message in the video feed that says 
"DHCP OPEN", and then the camera will automatically reboot.

Note: If your camera did not display DHCP OPEN and restart automatically, you may 
need to contact PTZOptics for assistance unless you are proficient in manual IP 
assignment procedures not covered below.

3. When the video feed displays, enter “# * 4” (sequentially) using the remote control 
to view the new DHCP address. The camera will now always request a new IP 
address, whenever it is plugged into a new network. 

Note: This means the IP address can change, which is generally not preferable in a 
live environment.

If you prefer to set a static IP address for a permanent installation, follow these steps:

1. Open a web browser, and enter the IP address obtained in the previous steps. You 
can view that IP address by entering “# * 4” (sequentially) using the remote control

2. Enter admin for both the username and password.

3. Select Network in the navigation options, located at the top-left part of the web 
page. 

4.  Find the DHCP/STATIC setting. 

5. Set IP Configuration Type to Fixed IP Address.

6. When the confirmation dialog window displays, click Apply, then click OK.

7. Recycle to power on the camera to reboot it.

Note: If you are have trouble setting the IP address on your camera, contact 
PTZOptics for assistance.
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Configuring Wirecast
Now that you have an IP address for your camera, Wirecast can be configured by 
following these steps:

1. Select Window > PTZ Controller to display the PTZ Controller panel.

2. Select the video ingestion method from the Camera menu. This will be an HDMI or 
SDI capture device, or NDI if your device supports it.

3. Enter the IP address for your camera (determined previously in the camera setup).

4. Port and VISCA Address are set automatically to the default values for PTZOptics 
camera. You do not need to change these.

5. Click the Connection button to the far right of Status. Status will display connected 
when a connection is made.
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Setting Up Wirecast Shots
To setup a Wirecast shot using a camera setup, follow these steps:

1. Select D-Pad from the Pan/Tilt menu and move the camera to a desire position. 
(Pan the camera by clicking the left and right arrows, and tilt the camera by clicking 
the up and down arrows.)

2. Enter a preset number (0 to 255) and click the Save button to save this camera 
position.

3. In Wirecast, create a camera shot. 
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4. Select your camera shot, open the Shot Editor, and click the Shot Layer Properties 
tab. 

5. Click the PTZ triangle to display the PTZ controls. Check the Enable PTZ preset recall 
check box. Enter a preset number and click the Go arrow.

You are now able to move you camera by changing shots.

Select the camera shot

Open the Shot Editor

Click the Shot Layer Properties tab

Click the PTZ triangle
Check Enable PTZ

Enter preset number and click the Go arrow
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PTZ Controller Panel
The PTZ Controller panel is accessed by selecting Window -> PTZ Controller. In this panel 
you can enter a PTZ camera IP address, VISCA port, and VISCA address. The source 
selected in the Camera drop-down menu is associated with the settings entered in the 
PTZ Controller panel. You can switch between devices in the Camera drop-down menu 
and configure separate PTZ Cameras associated with that video source.

Camera

This drop-down list will show the currently selected video source and update the PTZ 
Controller window to display the associated VISCA and PTZ configuration. Clicking the 
drop-down list will display the available live video sources connected to Wirecast. Once 
a connection to a valid VISCA device has been established, the PTZ Controller panel will 
refresh to show the camera's current Pan/Tilt orientation.  Changing the Camera source 
will change all the settings in the panel accordingly.

Note: A PTZ camera's VISCA configuration is discrete from the video feed. You can 
associate any available video source with any manually-entered VISCA device 

Camera drop-down menu



PTZ Controller
PTZ Controller Panel

89

information. This accommodates a workflow where the camera's video feed is being 
captured via a Capture Card.

IP Address

Enter the IP address of a valid VISCA-over-IP source on the network. This IP address is 
configured in your camera's network settings.

Port

Enter the IP port for the VISCA connection of the camera. This IP port is configured in 
your camera's network settings.

VISCA Address

Select the correct VISCA Address of the camera. This VISCA Address is configured in 
your camera's VISCA settings.

Status / Reconnect Button

Displays the current VISCA connection status (“connected” or “invalid source”) of your 
camera. Click the Reconnect button to force a reconnection.

Home Button

Click the House icon to reorient the PTZ camera to its default position (default centered, 
no zoom).

Pan/Tilt

Select the desired PTZ control method (Map, D Pad, or Analog Pad) from this drop-
down menu.

• Map – displays an X/Y plane with a yellow cross-hair representing the current Pan/
Tilt orientation of the camera
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• D-Pad – Pan the camera by clicking the left and right arrows, and tilt the camera by 
clicking the up and down arrows.

• Analog Pad – Click in the analog circle to reposition the camera pan and tilt.

Zoom

Move the slider to adjust the zoom factor of your camera.

Note: When the PTZ Controller panel is the selected window, you can press the arrow 
keys on the keyboard to adjust the Pan (left and right arrow keys) and Tilt (up and 
down arrow keys) of the camera. Alternatively the W, A, S, and D keys can also be used 
(W = Up, A = Left, S = Down, D = Right)

Focus

Click the Plus and Minus buttons to adjust the focus of the camera. The yellow button in 
the center toggles auto-focus on and off. Any manual adjustments made to the focus  
will automatically disable the auto-focus.

Exposure

Select the exposure mode from the Exposure drop-down menu.

• Shutter  Move the slider to adjust the shutter of the camera. You can only adjust 
the Shutter when Exposure mode is not in auto-focus.

• Iris Move the slider to adjust the iris of the camera. You can only adjust the Iris 
when Exposure mode is not in auto-focus.
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Note: Refer to PTZOptics documentation for more details about each mode.

White Balance

Select the white balance mode from the White Balance drop-down menu. 

Note: Refer to PTZOptics documentation for more details about each White Balance 
mode.

One Shot

When the White Balance mode is set to One Shot, click this button to adjust the White 
Balance one time only.

Red Gain/Blue Gain

When not in auto-focus mode, you can use these sliders to adjust the red and blue gain 
of the video signal to compensate for white balance issues.

Presets

Enter a preset number and click Save to save current Pan, Tilt, and Zoom configurations 
of camera. To recall a preset, select a preset number by clicking the arrow buttons, then 
click the Recall button.
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PTZ Control in the Shot Editor
You can select PTZ Controller Presets associated with a Shot Layer's video source from 
the Shot Layer Properties tab of the Preview Inspector. PTZ Control Presets are 
configured in the PTZ Controller Panel and associated with individual video sources.

Open the PTZ control pane by clicking on the PTZ triangle. Check Enable PTZ preset 
recall checkbox. Enter a preset number or click the up/down arrow buttons. Click the 
Go button (right pointing arrow) to cause the associated PTZ camera to recall that 
preset.

Once a Shot Layer has been configured with a PTZ Preset, sending that Shot to Preview 
will tell the associated PTZ Camera to recall that preset. If multiple Shots share the same 
video source with different PTZ Presets configured, the Shot which is currently Live will 
take precedence over subsequent PTZ Preset recall actions, but only until it has been 
switched away from Live.

The Show PTZ Controller button will open the PTZ Controller panel.

PTZ controls
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  Shot Editor

Introduction
The Shot Editor is used to view a shot, edit it, or create a new one. This section describes 
how to use the Shot Editor.

Topics
 Overview

 Shot Layers Tab

 Shot Layer Properties Tab

 Audio Properties Tab

 Chroma Key Properties Tab

 Smooth Transition Properties Tab

 Additional Properties Tab

– Capture Devices Properties

– Rendezvous Properties

– Image Carousel Properties

– Clock Properties

– QR Code Generator Properties

– Media File Properties

– Remote Desktop Presenter Properties

– Scoreboard Properties

– Screen Capture Properties

– Solid Color Properties

– Text Shot Properties

– Web Page Properties

– Web Stream Properties

– Titles Properties
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– Twitter Feed Properties

– New Virtual Set Properties
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Overview
To edit a shot, double-click the shot to open the shot editor. You can also single-click 
the shot to select it, then click the double-arrow on the left of the Main window to open 
the shot editor panel. 

The shot editor has six tabs: Shot Layers, Shot Layer Properties, Audio, Chroma Key 
Properties, Smooth Transition Properties, and Additional Properties.

   

Click double-
arrow

Select a shot

Double-click 
a shot

Shot Layers tab

Chroma Key Properties tab

Smooth Transition Properties tab

Shot Layer Properties tab

Audio tab

Additional Properties tab
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Shot Layers Enables you to add and delete sources and to change the display order 
(layering within the shot).

Shot Layer Properties Enables you to change the size, position, and other properties 
of a shot.

Audio Enables you to set and monitor the audio level.

Chroma Key Properties If a source in your shot uses a chroma key, this tab enables you 
to configure the chroma key settings. Each source in a shot can have its own chroma 
key settings.

Additional Properties Enables you to set any additional properties for a source in your 
shot: System Device properties, Screen Display properties, Twitch Widgets (Chat and 
Followers), Text properties, etc.

Shot Layers Tab
The Shot Layers tab lists all of the sources in the shot. You can add sources by clicking 
the plus (+) button, or delete a sources by select selecting it and clicking the minus (-) 
button. You can also reorder the sources in the list by selecting a source then clicking 
the up or down arrow to move it. Additionally, you can toggle (on or off ) the visibility of 
a source  by clicking the eye icon, or toggle the source audio by clicking the speaker 
icon. 

     

Replay Layer
 

The Replay Layer is a placeholder layer that can be added to any Shot for the purpose of 
creating a Replay Template Shot. Once the Shot is selected in the Replay Settings it can 
be used as a template for any created Replay Shot. 

To configure and use a Replay Layer, follow these steps: 

Click to select 
a source

Click to move 
up or down

Click the eye or 
speaker icon

Click to add or 
remove source

PRO
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1. Create a new shot, then click the plus (+) button and select Replay Layer to add a 
source.

     

2. Add additional graphics, titles or other sources to the shot as needed.

     

Click plus (+) button

Select Replay Layer

Other sources 
added

Replay Layer 
added
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3. Select Replay+ISO > Configure, then select Replay Settings. Select a Replay Shot 
Template (the newly created shot with Replay Layer), check Program Replay, and 
click OK.

     

4. Enable the Replay system by selecting Replay+ ISO > Start All.

5. Click the Update Replay Shot button to create a Replay shot using the new 
template.

     

select Replay 
Settings

Check Program Replay

Select Replay 
Shot Template

Click the Update 
Replay Shot button

Newly created Replay 
shot
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Shot Layer Properties Tab
The Shot Layer Properties tab enables you to make adjustments to the sources in your 
shot. 

Position fields

 Rotation sliders

Matte selector

Stretch, Scale and Reset 
Position buttons

Click Crop arrow

Click Color arrow

Color adjustments

Opacity slider

Crop adjustments

Reset button

Scale slider

Drop Shadow 
adjustments

Reflection slider

Click Drop Shadow arrow
Check to enable

Defaults and Reset buttons

Click PTZ arrow
Check Preset recall (optionally)
Recall a PTZ preset

Click to open PTZ control panel
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Position Displays the position of the selected source in your shot. Position “0 0” 
represents the middle of the shot area. To move a source, click and drag it to a new 
location in the shot. 

Scale Slide the Scale slider to change the size of your source. (See also Scale To Fit 
below).

X Y Z Rotation Slide the X (Horizontal), Y (Vertical), or Z (Straight-through) axis sliders 
to rotate the source. (See also Reset Position below).

Opacity Slide the Opacity slider to adjust the degree of transparency of your image.

Reflection Slide the Reflection slider to adjust the degree of reflection below your 
image.

Matte A Matte is the boarder around a shot. Select a matte to be used by clicking the 
down-arrow on the Matte menu. Default is No Matte. You can also use any media file as 
a custom matte. To do this, create a new shot of the media file you want to use as a 
matte. This file now appears in the Matte drop-down menu where you can select it.

Stretch to Fit Click the Stretch to Fit button to stretch the source to expand to its 
maximum size in the shot. This may distort the display of the source.

Scale to Fit Click the Scale to Fit button to force the source to expand to its maximum 
size in the shot.

Reset Position Click the Reset Position button to force the source to return to its 
original size (scale) and rotation positions. 

Crop Click the Crop triangle to open the cropping adjustment pane. Slide the Left, 
Right, Top, and Bottom sliders to crop your source image.

Color Click the Color triangle to open the color adjustment pane. Slide the color 
controls to adjust the color.

Reset Click the Reset button to reset the color controls to their default settings.
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Drop Shadow Click the Drop Shadow triangle to open the Drop Shadow adjustment 
pane. Check the checkbox to enable the controls.

– Angle Move the slider to change the angle of the Drop Shadow.

– Color Click in the color field to open the color palette. Select a shadow color and 
luminance by sliding the vertical and horizontal sliders. Click outside the color 
edit box to close the palette.

– Offset Move the Offset slider to adjust the direction (0 to 360 degrees) the 
shadow text is offset from the actual text. 

– Opacity Slide the Opacity slider to adjust the degree of transparency of your 
source.

– Blur Size Move the slider to adjust the amount of blur in the drop shadow.

Use As Defaults Click to set the current drop shadow configuration as the default 
setting. All future enabled drop shadows will be set this by default. Clicking this button 
does not retroactively update previously created shots. Drop shadow settings on 
individual shots can still be changed.

Reset Click to restore the drop shadow settings back to the default values. You can also 
restore the drop shadow settings to Wirecast application defaults by holding the Shift 
key down and clicking Reset.

PTZ Click the PTZ triangle to open the PTZ control panel.

Enable PTZ Preset Recall Check the checkbox to enable the PTZ recall controls.

Preset Click the up and down arrows to find a PTZ preset to recall, then click the Right 
Pointing Arrow button to recall the preset.

Show PTZ Controller Click to display the PTZ Controller panel. (See PTZ Controller).

Audio Properties Tab
The Audio Properties tab enables you to control and monitor audio. You can set the 
audio level, mute and monitor the audio, and map channel outputs.

Volume Adjust the slider to set the audio volume level.

Map button

Meter control

Volume slider

Pan control

Speaker icon
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Pan Adjust the slider to pan between left and right audio.

Meter Monitors the audio level. You can also mute the audio by clicking the audio icon.

Speaker  Click to mute the audio output. Icon turns gray when muted. Click the icon 
again to un-mute the audio.

Map Click to open the audio mapping window. Check a square to map an audio 
channel to an audio track. Any audio can be tracked to any or all tracks. However, you 
will typically assign a group of channels to one track and other groups to other tracks.

If you have created a shot using a 16 input device, the mapping window will display all 
16 channels.

      



Shot Editor
Chroma Key Properties Tab

103

The audio track that is actually used is selected from the Audio Track menu in the 
Output Settings window. Unlike recording (below), only one track can be selected.

If you are recording, you can select multiple audio tracks.

Chroma Key Properties Tab
Chrome Key (also called “green screen”) enables you to replace all green areas of your 
display (or any other color you choose) with a background image.  For example, if you 

Audio Track menu

Multiple audio 
tracks selected
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are in front of the traditional green screen, by “keying out” the green and leaving the 
background transparent, you will appear to be in front of your background.

The Chroma Key Properties tab enables you to turn on/off chroma keying and make 
chroma key adjustments.

Use Chroma Key Check to turn on chroma keying. Uncheck to turn it off. Click the 
Defaults button to reset all Chroma Key controls.

Pick key color with mouse Check to use your mouse to select a chroma key color. 
Hover over the a desired color in the selected source, and click the left mouse button to 
select that color. All adjustments will be made using the selected color as the key.

Color Click the color square to open the Color Pallet. Select a color to use as the chroma 
key color and click OK.

Key Threshold Slide the Key Threshold slider to adjust the amount of keying in your 
source.

Black Clip Slide the Black Clip slider to adjust the black threshold level (how much black 
is used in keying).

White Clip Slide the White Clip slider to adjust the white threshold level (how much 
white is used in keying).

Set As Default Click to set the current Chroma Key configuration as the default setting. 
All future Chroma Keys will be set this by default. Clicking this button does not 
retroactively update previously created shots. Chroma Key settings on individual shots 
can still be changed.

Smooth Transition Properties Tab
The Smooth Transition Properties tab provides control over how objects (image, movie, 
title, etc.) are added or removed in the Live Broadcast window. Wirecast only performs 
motion during a Smooth transition. If you are using any other transition, the motion 
settings are ignored. 

Check to use mouse color selection

Click Defaults to reset controls

Check Use Chroma Key

Set chroma key adjustments

Click to set defaults
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There are two types of motion. When an object is added to your broadcast it is called 
Build In; When it is removed it is called Build Out. Motion only occurs when an object 
enters or leaves the Live Broadcast window. For example, if you have two shots, each 
with a foreground and the media in the foreground is the same, then a Smooth 
transition is performed between the foregrounds. However, no motion is performed. 
Or, if a logo is positioned in the top left corner in an existing shot, and it is in the bottom 
right corner in a new shot, when you make the new shot Live the logo smoothly 
transitions from the top left corner to the bottom right corner. But the Build In and 
Build Out settings are ignored. 

However, if you have two shots with a Foreground, but the media in each is different, 
the Build Out is performed for the existing shot, and the Build In is performed for the 
new shot.

Direction Menus These provide selections of where the Build In comes from (top, 
bottom, right, etc.) when it is added, and where the Build Out goes when it is removed. 

Fade In / Fade Out Checking these checkboxes causes an object to be added or 
removed gradually. If unchecked, the object is instantly added or removed, much like a 
cut transition. 

Spin In / Spin Out Checking these checkboxes causes an object to be added or 
removed in a spinning fashion. 

Scale In / Scale Out Checking these checkboxes causes an object to be added or 
removed in a scaled fashion. 

Apply To All Click this button to make the Transition Settings the same for all sources in 
a shot. This is useful if you want to make all of your motion the same for all of the 
elements in the shot. 

Set As Default Click this button to make these Transition Settings the default settings 
for all new shots.  These default settings will be applied in all future WC documents.

Direction Menus

Click to set defaults

Click to apply settings to all transitions
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Additional Properties Tab
The Additional Properties tab provides various adjustments to your selected source, 
depending on the kind of source selected. There are many kinds of sources: System 
Devices, Screen Captures, Web Displays, Scoreboards, etc.

Capture Devices Properties
Capture Device enables you to capture just the audio of the output. Capture Devices 
have a variety of settings. To open a Capture Device source, select Capture Devices from 
the source menu in the shot window. 

RealTek Example
Here is an example of a Realtek High microphone array.

Source Name Displays the name of the source. To change the source name, enter a 
new one. 

Audio Delay Enter the amount of time (in seconds, as short as 1 ms) to delay the audio 
signal to sync it up with a video source.

Monitor Click the Monitor icon to cause audio to play through your monitor output. 
The icon is gold when selected (turned on). If unselected, audio will not play through 
the monitor output for this source. Selected is the default.



Shot Editor
Additional Properties Tab

107

NDI™ Sources
Any NewTek NDI™ sources on your local network will be discovered by Wirecast and 
listed as an NDI™ Source under Capture Devices in the Source Input Menu. 

   

Adding an NDI™ source will create a new shot for that source. 

If you have selected an NDI™ source, the NDI™ Source Properties tab will display. In 
addition to the controls above, an NDI™ source has the following controls.

Video Delay Enter the amount of time (in seconds, as short as 1 ms) to delay video. 

NDI source

New NDI source
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Bandwidth Select the bandwidth to use: Highest (max quality), Lowest (max efficiency), 
or Audio Only (video bandwidth not applicable).

Reconnect Click to reconnect the NDI™ source.

Channel Select Stereo, Left, or Right to determine the audio source for both channels. 
Stereo sends the left audio source to the left channel and the right audio source to the 
right channel. Left sends the left audio source to the both channels (left and right). 
Right sends the right audio source to the both channels (left and right).

Monitor Check the Monitor check box to cause audio to play through your monitor 
output. If the check box is unchecked, audio will not play through the monitor output 
for this source. Checked is the default.

Note: NDI™ networking requires that your network has port 5353 open for mDNS 
device discovery, as well as one port per video channel (starting from port 5960 and 
onward) transmitted by an NDI™ source, plus one additional port for messaging.

ASIO and WASAPI Sources
Any ASIO or WASAPI source on your local network will be discovered by Wirecast and 
listed under Capture Devices in the Source Input Menu. These devices are generally 
used with multi-track audio outputs. ASIO Audio Capture is a very low latency 
professional audio capture API. It is used to connect to professional audio interfaces. 
WASAPI Audio Capture is also a low latency audio capture API. It replaces the old 
DirectShow-based audio capturing. 

   

Source Input Menu icon.
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Rendezvous Properties

Rendezvous provides an easy way to organize a video conference with up to two 
guests in Wirecast Studio, and up to seven guests in Wirecast Pro. You can bring in live 
video feeds from a computer or smart device running a supported web browser, or 
from iOS devices running the Wirecast Go app.

• Creating a Rendezvous Session

• Joining a Rendezvous Session

• Adding a Participant Shot

• Participant Options

• Ending a Rendezvous Session

Creating a Rendezvous Session
To open a Rendezvous session, select Rendezvous from the Shot Menu, then select 
Create Rendezvous Session.

STUDIO

Click Create

Shot 
Menu

Select 
Rendezvous 
Session
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In the Create Session window click on the Click to Copy button to copy the Rendezvous 
URL to the clipboard. Send this URL to the participants that you want to invite to the 
broadcast. Click OK when finished.

When the Rendezvous Dashboard displays, select video source, audio source, and 
audio output. You can also make a copy of the participant URL (if you have not already 
done so). 

Send the session URL (copied above) to your participants and instruct them to use this 
URL in a browser to join the Rendezvous session you just created.

Note: The only browsers supported by Wirecast for joining a Rendezvous session are 
Chrome and Firefox.

Click the “Click to 
copy” button

Click OK

Select audio source Select audio outputSelect video source

Copy URL
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Joining a Rendezvous Session
To join a Rendezvous session on a remote computer (or smart device), paste the 
obtained URL into a browser and press the Enter key to initiate a connection with 
Wirecast. 

Note: The only browsers supported by Wirecast for joining a Rendezvous session are 
Chrome and Firefox.

When theWirecast Rendezvous window appears, select a camera and microphone from 
the drop-down menus at the bottom of the window (if a camera and mic are not 
automatically chosen, or if you want to use others that are available). Enter an 
identification in the Your Name field and click Join.

Note: Wirecast Go, running on iOS devices, can join a Rendezvous Session by opening 
the URL. Android devices can join a session by opening a Session URL (sent to them) 
using a Chrome browser.

Enter an ID.

Click Join

Select camera and mic
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After you click Join, the Rendezvous window will display a Waiting to join message until 
the Wirecast host has added you as a participant.

Adding a Participant Shot
Whenever participants are waiting to join the Rendezvous session, a participant icon 
displays in both theWirecast Main window and the Rendezvous Dashboard. Click on 
the icon and select a participant to add it to the session.

Note: You can skip this step and go directly to creating a shot of a participant, which 
will automatically add them when the shot is created.

Participant icons

Click icon to 
add participant
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Create a shot of a participant by selecting Rendezvous Session > Add <target ID> to 
Rendezvous from the Shot Selection menu. The participant is automatically added 
when you create this shot.

Select 
participant

Shot Selection menu
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Your new Rendezvous shot will display on the shot level from where it was selected. 
Select the shot to have it display in the preview window where you can place it and size 
it as needed.

You can also select your local camera and mic as an integrated Webcam shot on 
another layer and add it to the preview window by selecting it.

New Rendezvous shot Shot placed 
and sized

Added local Webcam shot Shot placed 
and sized
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From the Rendezvous Dashboard in Wirecast, you can mute audio or hide the camera 
of your local sources (or of those who have joined).

You can also select the Live Broadcast window as your Rendezvous display (instead of 
your local camera).  To do this, click the gear icon and select Live Output. To end the 
Rendezvous session, click Disconnect.

Wirecast 
camera

Remote 
camera

Mute Wirecast audio 
or hide video

Mute remote audio 
or hide video

Select Live 
Output

Click gear 
icon

Click Disconnect
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Participant Options
Once you have successfully joined the Rendezvous session, the window will display the 
camera shot from Wirecast and from your local computer. In this window you can mute 
the audio or hide video of your resources or those coming from Wirecast.

You can also share your screen (instead of your camera) by Clicking on the gear icon 
and selecting Share Screen.

Wirecast 
host camera

Local 
camera

Mute Wirecast 
audio or hide 
video

Mute local 
audio or hide 
video

Select Share 
Screen

Click gear 
icon
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When the Share Screen window displays, select the screen you want to share and click 
Share.

Ending a Rendezvous Session
When you are ready to close your session, click Stop Session. 

Select a 
Screen

Click Share

Click 
Disconnect
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When you disconnect from a Rendezvous session, your camera is removed in the 
participant’s browser and the participant’s camera is removed from your local session 
window. To reconnect to the previous session click Reconnect to previous session. When 
you do this, everything is restored as long as the remote browsers are still open. If a 
remote browser has been closed, it can still reconnect by re-joining, using the same 
URL that was used previously. You can also start a new session by clicking Start Session, 
but you will have to copy and send a new URL to all potential participants.

Click to 
reconnect

Click to start 
new session



Shot Editor
Additional Properties Tab

119

Clock Properties
A Clock shot displays time. Clock Properties have the following settings.

   

Source Name   Displays the name of the source. To change the source name, enter a 
new one. 

Shutdown Check to force the clock to shutdown when not live. 
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Clock Modes Select Clock, Countdown, or Stopwatch.

Clock Mode:

• Basic  Select Basic for basic clock functionality. Select Date and Time display for-
mats from the drop-down menus. (Display Format window is disabled).

• Advanced Select Advanced to enter a custom hour-minute-second format. Enter 
custom time format into Display Format window. Click question mark (“?”) icon to 
display custom format types.

Countdown Mode:

• Timer  Enter the time value from which to start counting. 

• Start, Stop, Reset  Click Start to begin counting down.  Click Stop to end counting 
down.  Click Reset to reset clock to Timer value.

• Display Format  Select time elements to display: Hours, Minutes, Seconds, and 
Fractional Seconds.

Clock mode
Countdown mode

Stopwatch mode
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• Action After  Select Stop at 00:00 to prohibit count up mode.  Select Start count up 
clock  to cause clock to start counting up after count down is finished.

Stopwatch Mode:

• Start, Stop, Reset  Click Start to begin counting.  Click Stop to end counting.  Click 
Reset to reset stopwatch to zero.

• Display Format  Select time elements to display: Hours, Minutes, Seconds, and 
Fractional Seconds.

Background Select Solid and click in the color field to open the color palette. Select a 
color and luminance by sliding the vertical and horizontal sliders. Click outside the 
color edit box to close the palette.

Select Gradient and click in the color field to select a new background gradient color 
from the palette. 

Angle When Gradient is selected, the Angle slider is activated. Move the slider to 
change the angle of the gradient display. Select also Linear (line) or Radial (circle) to 
change the shape of the gradient display.

Text Color Click the box to open the color selection panel. Select a new text color from 
the palette.

Font Select the desired font used for your messages. If you select Web Font, a Web Font 
field will display below. You can also select any of the fonts installed on your computer.

Font Size Select the type of font size: points, small, medium, large, etc. If In Points is 
selected, a box to enter font size (in points) is displayed. 

Font Weight Select the font weight: 100 to 900.

Font Style Enter the font style: Normal, Italic, or Oblique. 

color sliders
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Font Variant Select a font variant: Normal (capital and small characters displayed 
normally), or Small-caps (Capitals with small letters displayed as small capital letters). 

Shadow Check to activate the text shadow slider controls. 

– Color Click in the color field to open the color palette. Select a shadow color and 
luminance by sliding the vertical and horizontal sliders. Click outside the color 
edit box to close the palette.

– Offset Move the Offset slider to adjust the direction (0 to 360 degrees) the 
shadow text is offset from the actual text. 

– Radius Move the Radial slider to adjust the distance the shadow text is offset 
away from the actual text.

– Blur Move the Blur slider to adjust the amount of blur in the shadow text

Image Carousel Properties
An Image Carousel shot shows a sequence of images. Image Carousel Properties have 
the following settings.

   

Source Name Displays the name of the source. To change the source name, enter a 
new one. 

Color sliders
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Width/Height Displays the width and height of the display source. To change the 
width or height, enter a new value.

Change Every Sets how often the images are changed, in seconds. 

Fade-In Time Sets how long it takes for each image to fade in, in seconds. Enter zero for 
instantaneous display of images.

Shuffle Images Check to shuffle the display order of the images. When unchecked, 
images are displayed as they are ordered in the image list. 

Image Displays Carousel images in a list. Click the plus (+) icon to add an image to the 
list. To remove an image, click the “X” to the right of the image on the list.  You can also 
click the browse button (...) to navigate to an image to add.

QR Code Generator Properties
QR Code Generation has the following settings.

Source Name Displays the name of the source. To change the source name, enter a 
new one. 

Video Delay Enter the amount of time (in seconds, as short as 1 ms) to delay video. 

Content Enter the message you want to be embedded in the QR code displayed in your 
broadcast.
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Media File Properties
A Media File is a video clip or a picture. To open a Media File source, select Media Files 
from the source menu in the shot window, and then navigate to your file. You can also 
click the Add Media File button at the bottom of the Add Shot window.

Media Files have the following settings.

Source Name Displays the name of the source. To change the source name, enter a 
new one. 

In Point Click Jump to move the play head to the In Point in the media file. The In Point 
is set by dragging the In Point icon to the desired beginning position on the play bar. 

Out Point Click Jump to move the play head to the Out Point in the media file. The Out 
Point is set by dragging the Out Point icon to the desired ending position on the play 
bar. The green triangle is the current location of the Play Head.

When Finished Select what happens when the media finishes playing. Loop causes the 
media to begin playing again. Hold cause the media to stop and hold the last frame in 
the Live window. Remove causes the media to be removed from the Live window when 
it finishes playing.

Begin playing when media becomes Live When checked, the media begins playing 
as soon as it is made Live. 

Remember position even when not Live When checked, the media will always start 
playing where ever it was playing when it was stopped, even if it was removed from the 
Live window and made Live again. When unchecked, the media will start from the 
beginning every time it is taken Live.

Set Default Click to set the media display to default settings. 

In Point icon Out Point icon

Play Head location
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Stock Media Library

When you open a Stock Media Library file, a widow presenting Terms and Conditions is 
displayed. Read the Terms and Conditions by scrolling down, check the  I Agree 
checkbox, then click the Proceed button. This agreement window only displays the first 
time you open a Stock Media Library file.

STUDIO
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You can also select Stock Media Library to open the Stock Media Library window. Use 
Source Type and Left/Right buttons to navigate to a media file, then click Download to 
include it as a shot. 

Source Type  You can toggle on/off any type of media to include in the display: Video, 
Images, and Audio.

Search  Enter key words to display just the media files including these words.  The 
display is updated as your enter words.

Left/Right arrows  Click the arrows to move to the next or previous set of Stock Media 
files.

Play button  Click to begin playing the selected media file.

File marker  Move the marker to view the media file quickly.

Download button  Click to download the selected media file into a shot.

Remote Desktop Presenter Properties

The Remote Desktop Presenter (RDTP) is a utility application that enables Wirecast to 
broadcast the desktop of any computer running the Telestream Desktop Presenter 
program. To open a Remote Desktop Presenter source, select Remote Desktop Presenter 
from the source menu in the shot window. 

Source Type Search Left/Right arrows

Play button

File marker

File Type

Download 
button

STUDIO
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Desktop Presenter is normally auto-detected by Wirecast and is automatically added to 
the list of sources. However, if a RDTP is not detected, or if you want to add one in a 
remote location you can manually add it by selecting New Remote Desktop Presenter 
from the Source menu in the Main window.

Remote Desktop Presenter Properties have the following settings.

     

Source Name   Displays the name of the source. To change the Source Name, enter a 
new one. 

Audio Delay Enter the amount of time (in seconds, as short as 1 ms) to delay audio.

IP Address Enter an IP address of the target computer.

Enable Audio When checked, the audio from the remote desktop is enabled.

Apply Click the Apply button to update any changes.

Monitor Click the Monitor icon to cause audio to play through your monitor output. 
The icon is gold when selected (turned on). If unselected, audio will not play through 
the monitor output for this source. Selected is the default.

Scoreboard Properties
 

Scoreboards allow you to add a scoreboard graphic to your broadcast that can be 
dynamically updated. Multiple scoreboards can be added. Unlike most other elements 
in Wirecast, changes to the Scoreboard go live instantly without requiring a transition. 
Once the scoreboard is live, the preview image is exactly as it is seen in your broadcast. 
To open a Scoreboard source, select Scoreboard from the source menu in the shot 
window. 

PRO
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Scoreboards Properties have the following settings.

    

Source Name   Displays the name of the source. To change the Source Name, enter a 
new one. 

Scoreboard   Select how the scoreboard will look using two drop-down menus. The 
upper menu selects the scoreboard style: Pipe, Shade, Corner, etc. The lower menu 
selects how the display fields are laid out: Basic, Right Stats, or Bottom. 

Home/Visitor/Score   The Home, Visitor, and Score fields contain the home and visitor 
team names and their current score. The three icons to the right of these fields control 
the text alignment, font size, and font color. Click on each icon to open its control 
window.

BG Color   Sets the background color for the Home or Visitor field display. Click the 
color icon to open the control window.

+1, +2, +3 Click these score increment buttons to increase the Home or Visitor score 
display.
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Field 1-4   Displays information inside the scoreboard depending on the layout chosen 
using the Scoreboard menus. The three icons to the right of these fields control the text 
alignment, font size, and font color. Click on each icon to open its control window.

Use a Custom Image   Check to enable the Choose button.

Choose   Click to navigate to the location of your custom image.

Reset   Click to remove a custom image.

Note: Because Wirecast updates the scoreboards dynamically, It is recommended 
that you fill in the additional information fields while using a layout that hides them. 
Then, change to a layout that reveals those fields when ready, otherwise your viewers 
see you typing in those fields live.

There are four hotkeys associated with the Scoreboard.

In order for these hotkeys to be active, the scoreboard must be displayed in the Live 
window and the Wirecast main window must be in focus (selected as the active 
Windows window).

= Increments Home score

-  Decrements Home score

]  Increments Visitor score

[  Decrements Visitor score
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Screen Capture Properties
A Screen Capture displays any monitor or window on your computer. To open a Screen 
Capture source, select Screen Capture from the source menu in the shot window. Screen 
Captures have the following settings.

Source Name Displays the name of the source. To change the source name, enter a 
new one. 

Audio Delay Enter the amount of time (in seconds, as short as 1 ms) to delay audio.

Video Delay Enter the amount of time (in seconds, as short as 1 ms) to delay video. 

Capture Video Check to enable Capture Type, Show Cursor, and fps settings (described 
below).

Capture Type   Select Monitor (captures your entire monitor), Window (captures the 
currently selected window), or Game (captures the game currently played on your PC). 
If you select Game, you can also configure how your game is captured by selecting 
options offered under Select Window/Monitor (described below).

Anti Cheat Support Enables anti-cheating support for game capture.

Show Cursor Check to show the cursor in your streaming. Uncheck to hide it. 

fps Select the FPS, from 10 to 60 frames per second as the capture rate. An FPS of 60 is 
the best frame rate, but it requires greater streaming bandwidth.

Capture System Audio Check to capture system audio when streaming. Uncheck to 
mute the audio. 
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Select Window/Monitor   Click the Configure button to display the Select Window 
dialog. If you selected Game for your Capture Type (described above), then the 
following configuration window displays

       

– Capture Any Full Screen Game Check this box to automatically capture a game 
running in a full monitor screen, or running in a full screen of a window.

– Support Multiple Video Cards/SLI Check this box if you have a Windows system 
with multiple discrete GPUs and are experiencing problems capturing a game. 
(Performance of the capture may be slower than when running on a single GPU.)

– Capture Third Party Overlays Check this box to capture overlays rendered on 
top of a game that are generated by applications external to the game. (For 
example, the Steam in-game overlay.

Choose Audio Device Click the Configure button to display the Select Audio Device 
dialog, then select an audio device from the drop-down menu.

Note: Some apps, when screen captured, take control of your mouse and the cursor is 
not displayed. You can, at any time, press Alt + Tab keys to reduce the capture window 
size and enable you to use your mouse.

Dynamic Range Select dynamic range setting: Default, Full or Limited.

Monitor Click the Monitor icon to cause audio to play through your monitor output. 
The icon is gold when selected (turned on). If unselected, audio will not play through 
the monitor output for this source. Selected is the default.
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Solid Color Properties
Solid Color displays a solid color background. To open a Solid Color source, select Solid 
Color from the source menu in the shot window. Solid Color Properties have the 
following settings.

Source Name   Displays the name of the source. To change the Source Name, enter a 
new one. 

Video Delay Enter the amount of time (in seconds, as short as 1 ms) to delay video. 

Width/Height Displays the width and height of the display source. To change the 
width or height, enter a new value.

Color Select Solid and click in the color field to open the color palette. Select a color 
and luminance by sliding the vertical and horizontal sliders. Click outside the color edit 
box to close the palette.

Select Gradient and click in the color field to select a new background gradient color 
from the palette. 

Angle When Gradient is selected, the Angle slider is activated. Move the slider to 
change the angle of the gradient display. Select also Linear (line) or Radial (circle) to 
change the shape of the gradient display.

color sliders
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Text Shot Properties
Text displays a text phrase. To open a Text source, select Text from the source menu in 
the shot window. Text Properties have the following settings.
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Source Name   Displays the name of the source. To change the Source Name, enter a 
new one. 

Width/Height Displays the width and height of the display source. To change the 
width or height, enter a new value.

Shutdown Check to cause the text to not be displayed until the shot is place into the 
Live window.

Source   Select the source of your text: Text (directly entered) or File (navigate to a text 
file), or RSS (ticker tape RSS feed). 

• If you select Text, enter your text in the text box below the source selector. 

• If you select File, enter a file name in the File Path box displayed, or click the naviga-
tion button (three dots) and find your text file. The text from your file will be auto-
matically displayed. The file has to contain UTF-8 encoded text in order for it to be 
rendered correctly. Only the first 64KB of the text file will be loaded and displayed. 
You can also check the Keep reading text file continuously to keep the text display 
in your broadcast up to date with file changes.

• If you select RSS, enter a URL in the URL box displayed.

Line Wrap When checked, the displayed text wraps around to the next line to fit into 
the window as it is resized. Select wrap mode from the drop-down menu: Wrap on Word 
or Break Word.

Align Enables you to align the text at the top, middle, or bottom of the display.

Justify Enables you to justify the text along the left, center, or right side of the display.

On Change When checked, a transition menu is displayed offering a choice of 
transition types: Fade, Drop In, Drop Out, and Slide. Transitions occur when text is 
changed. 

Transition Enter the length (in seconds) of the transition time. (This field is displayed 
only when the On Change box is checked.)

Scroll When Scroll is checked, you can enter both a scroll mode and a direction. There 
are two scroll modes: Non Stop and If it Does Not Fit.

Direction Select the direction of the scrolling: Top to Bottom, Bottom to Top, Left to 
Right, or Right to Left. This field is displayed only when the Scroll box is checked

Speed When Scroll is checked, enter the speed (in pixels per second) that you want 
your message to scroll through the display.

Auto Reverse When checked, the display reverses the scrolling direction when it 
reaches the top or bottom of the list.
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Background Select Solid and click in the color field to open the color palette. Select a 
color and luminance by sliding the vertical and horizontal sliders. Click outside the 
color edit box to close the palette.

Select Gradient and click in the color field to select a new background gradient color 
from the palette. 

Angle When Gradient is selected, the Angle slider is activated. Move the slider to 
change the angle of the gradient display. Select also Linear (line) or Radial (circle) to 
change the shape of the gradient display.

Text Color Click the box to open the color selection panel. Select a new text color from 
the palette.

Font Select the desired font used for your messages. If you select Web Font, a Web Font 
field will display below. You can also select any of the fonts installed on your computer.

Font Size Select the type of font size: points, small, medium, large, etc. If In Points is 
selected, a box to enter font size (in points) is displayed. 

Font Weight Select the font weight: 100 to 900.

Font Style Enter the font style: Normal, Italic, or Oblique. 

Font Variant Select a font variant: Normal (capital and small characters displayed 
normally), or Small-caps (Capitals with small letters displayed as small capital letters). 

Shadow Check to activate the text shadow slider controls. 

Color Click in the color field to open the color palette. Select a shadow color and 
luminance by sliding the vertical and horizontal sliders. Click outside the color edit box 
to close the palette.

color sliders

color sliders
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Offset Move the Offset slider to adjust the direction (0 to 360 degrees) the shadow text 
is offset from the actual text. 

Radius Move the Radial slider to adjust the distance the shadow text is offset away 
from the actual text.

Blur Move the Blur slider to adjust the amount of blur in the shadow text

Web Page Properties
Web Page shows a web source defined by a web address (URL). To open a Web Page 
source, select Web Page from the source menu in the shot window. Web Page 
Properties have the following settings.

Source Name Displays the name of the source. To change the source name, enter a 
new one. 

Address Displays the web address (URL) of the source. To change the address, enter a 
new one. 

Width/Height Displays the width and height of the display source. To change the 
width or height, enter a new value.

Transparent Background Check to make the background transparent in your shot.

Shutdown when inactive Check to turn off the audio and disable it from the shot 
when playing videos. 

Override CSS Enter Cascading Style Sheet code to override the default code for this 
web display.



Shot Editor
Additional Properties Tab

137

Web Stream Properties
The Web Stream option allows RTMP, RTSP, MMS, or HTTP streams to be taken directly 
into Wirecast. This is useful for incorporating remote IP Cameras or other network 
streams into a broadcast. Sources are automatically detected and are also identified by 
IP Camera Profile. To open a Web Stream source, select Web Stream from the source 
menu in the shot window. 

Web Stream Properties have the following settings.

     

Source Name   Displays the name of the source. To change the Source Name, enter a 
new one. 

Audio Delay Enter the amount of time (in seconds, as short as 1 ms) to delay audio.

Video Delay Enter the amount of time (in seconds, as short as 1 ms) to delay video. 

URI Enter the address of your input stream. (For example:  rtsp://127.0.0.1:8080/
my_stream.sdp, or http://10.0.0.1/my_stream, or rtmp://hades.telestream.net:1935/live/
myStream).

Username  Enter your username for your URI stream.

Password  Enter your password for your URI stream.

Buffer  Enter a buffer time in seconds.

Reconnect  Click to reconnect the Web Stream source.

Apply Click the Apply button to update any changes.

Monitor Click the Monitor icon to cause audio to play through your monitor output. 
The icon is gold when selected (turned on). If unselected, audio will not play through 
the monitor output for this source. Selected is the default.
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Titles Properties
A Title is a text displayed in a banner window. Wirecast offers a wide variety of title 
banner templates to use in your streaming. To open a Title source, select Titles from the 
source menu in the shot window. 

Titles have the following settings.
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Source Name Displays the name of the source. To change the source name, enter a 
new one. 

Width/Height Displays the width and height of the display source. To change the 
width or height, enter a new value.
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Shutdown Check to cause the text to not be displayed until the shot is place into the 
Live window.

Source   Select the source of your text: Text (directly entered) or File (navigate to a text 
file), or RSS (ticker tape RSS feed). If you select Text, enter your text in the text box below 
the source selector. If you select File, enter a file name in the File Path box displayed, or 
click the navigation button (three dots) and find your text file. The text from your file 
will be automatically displayed. The file has to contain UTF-8 encoded text in order for it 
to be rendered correctly. Only the first 64KB of the text file will be loaded and displayed. 
If you select RSS, enter a URL in the URL box displayed.

Line Wrap When checked, the displayed text wraps around to the next line to fit into 
the window as it is resized. Select wrap mode from the drop-down menu: Wrap on Word 
or Break Word.

Align Enables you to align the text at the top, middle, or bottom of the display.

Justify Enables you to justify the text along the left, center, or right side of the display.

On Change When checked, a transition menu is displayed offering a choice of 
transition types: Fade, Drop In, Drop Out, and Slide. Transitions occur when text is 
changed. 

Transition Enter the length (in seconds) of the transition time. This field is displayed 
only when the On Change box is checked.

Scroll When Scroll is checked, you can enter both a scroll mode and a direction. There 
are two scroll modes: Non Stop and If it Does Not Fit.

Direction Select the direction of the scrolling: Top to Bottom, Bottom to Top, Left to 
Right, or Right to Left. This field is displayed only when the Scroll box is checked

Speed When Scroll is checked, enter the speed (in pixels per second) that you want 
your message to scroll through the display.

Auto Reverse When checked, the display reverses the scrolling direction when it 
reaches the top or bottom of the list.

Background Select Solid and click in the color field to open the color palette. Select a 
color and luminance by sliding the vertical and horizontal sliders. Click outside the 
color edit box to close the palette.

Select Gradient and click in the color field to select a new background gradient color 
from the palette. 

color sliders
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Angle When Gradient is selected, the Angle slider is activated. Move the slider to 
change the angle of the gradient display. Select also Linear (line) or Radial (circle) to 
change the shape of the gradient display.

Text Color Click the box to open the color selection panel. Select a new text color from 
the palette.

Font Select the desired font used for your messages. If you select Web Font, a Web Font 
field will display below. You can also select any of the fonts installed on your computer.

Font Family Select the style of the font: Arial, Bookman, etc.

Font Size Select the type of font size: points, small, medium, large, etc. If In Points is 
selected, a box to enter font size (in points) is displayed. 

Font Weight Select the font weight: 100 to 900.

Font Style Enter the font style: Normal, Italic, or Oblique. 

Font Variant Select a font variant: Normal (capital and small characters displayed 
normally), or Small-caps (Capitals with small letters displayed as small capital letters). 

Shadow Check to activate the text shadow slider controls. 

Color Click in the color field to open the color palette. Select a shadow color and 
luminance by sliding the vertical and horizontal sliders. Click outside the color edit box 
to close the palette.

Offset Move the Offset slider to adjust the direction (0 to 360 degrees) the shadow text 
is offset from the actual text. 

Radius Move the Radial slider to adjust the distance the shadow text is offset away 
from the actual text.

Blur Move the Blur slider to adjust the amount of blur in the shadow text

color sliders
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Twitter Feed Properties
Twitter Feed displays a list of Twitter messages. Twitter Feed Properties have the 
following settings.
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Source Name Displays the name of the source. To change the source name, enter a 
new one. 

Width/Height Displays the width and height of the display source. To change the 
width or height, enter a new value.

Shutdown Check to cause the text to not be displayed until the shot is place into the 
Live window.

Source   Select the source of your text: Text (directly entered) or File (navigate to a text 
file), or RSS (ticker tape RSS feed). If you select Text, enter your text in the text box below 
the source selector. If you select File, enter a file name in the File Path box displayed, or 
click the navigation button (three dots) and find your text file. The text from your file 
will be automatically displayed. The file has to contain UTF-8 encoded text in order for it 
to be rendered correctly. Only the first 64KB of the text file will be loaded and displayed. 
If you select RSS, enter a URL in the URL box displayed.

Line Wrap When checked, the displayed text wraps around to the next line to fit into 
the window as it is resized. Select wrap mode from the drop-down menu: Wrap on Word 
or Break Word.

Align Enables you to align the text at the top, middle, or bottom of the display.

Justify Enables you to justify the text along the left, center, or right side of the display.

On Change When checked, a transition menu is displayed offering a choice of 
transition types: Fade, Drop In, Drop Out, and Slide. Transitions occur when text is 
changed. 

Transition Enter the length (in seconds) of the transition time. This field is displayed 
only when the On Change box is checked.

Scroll When Scroll is checked, you can enter both a scroll mode and a direction. There 
are two scroll modes: Non Stop and If it Does Not Fit.

Direction Select the direction of the scrolling: Top to Bottom, Bottom to Top, Left to 
Right, or Right to Left. This field is displayed only when the Scroll box is checked

Speed When Scroll is checked, enter the speed (in pixels per second) that you want 
your message to scroll through the display.

Auto Reverse When checked, the display reverses the scrolling direction when it 
reaches the top or bottom of the list.
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Background Select Solid and click in the color field to open the color palette. Select a 
color and luminance by sliding the vertical and horizontal sliders. Click outside the 
color edit box to close the palette.

Select Gradient and click in the color field to select a new background gradient color 
from the palette. 

Angle When Gradient is selected, the Angle slider is activated. Move the slider to 
change the angle of the gradient display. Select also Linear (line) or Radial (circle) to 
change the shape of the gradient display.

Text Color Click the box to open the color selection panel. Select a new text color from 
the palette.

Font Select the desired font used for your messages. If you select Web Font, a Web Font 
field will display below. You can also select any of the fonts installed on your computer.

Font Family Select the style of the font: Arial, Bookman, etc.

Font Size Select the type of font size: points, small, medium, large, etc. If In Points is 
selected, a box to enter font size (in points) is displayed. 

Font Weight Select the font weight: 100 to 900.

Font Style Enter the font style: Normal, Italic, or Oblique. 

Font Variant Select a font variant: Normal (capital and small characters displayed 
normally), or Small-caps (Capitals with small letters displayed as small capital letters). 

Shadow Check to activate the text shadow slider controls. 

Color Click in the color field to open the color palette. Select a shadow color and 
luminance by sliding the vertical and horizontal sliders. Click outside the color edit box 
to close the palette.

color sliders

color sliders
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Offset Move the Offset slider to adjust the direction (0 to 360 degrees) the shadow text 
is offset from the actual text. 

Radius Move the Radial slider to adjust the distance the shadow text is offset away 
from the actual text.

Blur Move the Blur slider to adjust the amount of blur in the shadow text.

New Virtual Set Properties
 

A Virtual Set is a pre-built source set, complete with graphics, to simulate a news-anchor 
desk in various configurations. For example, you can select a two-source virtual set that 
displays three layers of decor (overhead lighting, a curved desk and a pillared 
background) with two live sources. Virtual sets can be used as they are, or they can be 
edited to suit your needs. To open a New Virtual Set source, select New Virtual Set from 
the source menu in the shot window. 

Virtual Sets have the following settings.

     

Source Name Displays the name of the source. To change the source name, enter a 
new one. 

PRO
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Playlist

Introduction

Playlist enables you to create a list of clips and play them as a single group. You can 
have multiple playlists and edit them as needed after they are created. You can also 
replay playlists (see Replay + ISO). This makes the combination of Playlist and Replay a 
very powerful production tool.

Topics
 Creating a Playlist

 Adding Clips

 Playing Playlists

 Playlist Controls

 Countdown Clock Options

STUDIO
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Creating a Playlist
To create a new Playlist, select New Playlist Shot from the Shot Menu and a new Playlist 
shot icon is added in the shot window.

The Playlist shot icon displays a playlist badge, the playlist duration, and the playlist 
completion action.

Click the Shot 
Menu

Select New 
Playlist Shot

New Playlist 
shot

Playlist badge

Playlist duration

Playlist completion action
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Adding Clips
To add clips to the playlist, first click and drag them onto the layer where the new 
Playlist is located.

Click and drag each shot onto the playlist shot (you must click the bottom part of the 
shot icon to drag it). When you do this you must wait for the playlist shot to obtain a 
yellow border before releasing the click button.

Double-click the Playlist icon to open the Playlist tab.

 You can also add additional clips by selecting Add New Shot from the Shot menu.

Added clips
New Playlist

Click and drag clip

Release when yellow boarder appears

Shot List tab

Playlist tab

Shot menu

Select Add New Shot
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These added shots are now housed in the Playlist. You can still edit shots in the playlist 
by double-clicking on the shot in the playlist. You also have all of the Change Shot 
menu options available by right-clicking on the shot.

Note: Do not delete shots from a playlist while the playlist is running.

The Change Shot menu for Playlist shots has a Modify Duration option. By default, live 
sources have an infinite duration (since they are not a clip). So, you must assign a 
duration time. To do this, select Modify Duration.

When the Shot Duration window displays, enter a new duration time value. Optionally, 
check Apply to All if you want this duration applied to all items in the playlist. You can 

Right-click the 
playlist shot 

Change Shot 
menu

Select Modify 
Duration 
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also, optionally, reset the duration to its original value by clicking Reset. Click OK when 
finished.

You can add live sources to the playlist by clicking the Live Sources menu and selecting 
a live source from the list.

Note: Wirecast does not support nested playlists (playlists within playlists).

Click Reset 
(optionally)

Enter duration 
time

Click OK

Check Apply 
(optionally)

Select a live 
source

Click Live Source 
menu
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Playing Playlists
Playing back a playlist is the same as playing any other shot -- click the playlist shot to 
place it into preview, then click the Go button to place it into the Live window.

Playlist Controls
Playlists provide some basic playback controls, located at the bottom of the Playlist tab 
window. You can transition to the previous or next shot in the list, set playlist behavior, 
shuffle the playlist order, and more.

Number of Shots Displays the current number of shots in the playlist.

Duration Displays the duration of the playlist shots.

Click Playlist icon Click the Go button Playlist runs in live window

Duration
Transition to 
previous shot

Transition 
between 
shots

Transition to 
next shot

Set Playlist 
behavior

Number of 
shots

Resume 

Shuffle 
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Resume When checked, if you exit the playlist, when you return the playlist will resume 
playing at the location (same shot) as when you exited. 

Shuffle Click to shuffle the order of the playlist shots. 

Transition to previous shot Transitions to the previous shot in the playlist if the 
playlist is currently live.

Transition to next shot Transitions to the next shot in the playlist if the playlist is 
currently live.

Set Playlist behavior Sets the behavior of the playlist when the last shot in the list has 
been played. A check mark indicates what menu item (behavior) is selected.

• Loop transitions back to the first shot, endlessly.

• Hold stays on the last shot. If the last shot is a clip, the last frame in the clip is dis-
played. If the last shot is a live shot, the live source stays active. If the last shot in a 
Playlist is a video clip Shot, it will obey the rules set for the video clip in the Media 
Properties Inspector tab under Source Properties. However, it will hold the Playlist 
on that last Shot if Set Playlist Behavior is set to "Hold". Therefore, if you want to see 
the last video in the Playlist pause on the last frame, you must set When Finished to 
"Hold" under Source Properties, in addition to setting the playlist behavior to 
"Hold". If you set When Finished to "Loop", under Source Properties, the last video in 
the Playlist will continue to loop. 

• Available Shots transitions to another shot on the same layer. All available shots are 
listed as menu selections. (In the example shown, the only available shot is “Logo”.)

• Previous Live Shot transitions back to the shot that was live before the playlist began 
playing.

• Current Preview transitions the contents of Preview to the live window.

Transition between shots Sets the transition to use when switching between shots.
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Countdown Clock Options
When a Playlist is playing, a drop-down menu (the gear icon) and countdown timers are 
displayed.

Click the gear icon to open the counter display mode menu. Select the top item (the 
name of the currently playing shot) to display its countdown time only. 

Select the bottom item (New Playlist - Completion) to display the countdown time of the 
current shot and of the Playlist.  (Notice that the current shot countdown display has 
moved to the left.) 

     

Countdown timer

Drop-down menu

Select current shot

Click the gear icon

Current shot countdown time

Click the gear icon

Select New Playlist - Completion

Playlist countdown time

Current shot countdown time
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Social Media

Introduction
Two social media options are provided: Facebook and Twitter. Facebook enables you to 
receive poling data from viewers. Twitter enables you to add Twitter messages to your 
broadcast along with filtering what messages are displayed.

Topics
 Facebook

 Twitter

Facebook
Note: Facebook Polls are only shown in the Facebook UI when the Facebook Video is 
playing, and fully open.

Facebook polls are controlled through the Social menu in Wirecast. Select Social > 
Facebook > Create New Poll to create a new poll.

     

The Social > Facebook menu contains the Create New Poll option as well as any 
previously created polls. Polls are not saved with the document. They are saved with 
the WC application, the same as preferences are. 
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Note: Wirecast can only use Facebook Polls created within the WC application itself. 
Facebook Polls created within the Facebook Live User Interface cannot be imported to 
Wirecast.

When a new pole is created, a dialog for specifying the poll options is displayed. You 
may enter a question, select whether there are 2, 3, or 4 answer options, and you can 
specify each option. You must enter a question and the correct number of options for 
the poll to be created. There are also four optional check boxes to aid you in how your 
poling is implemented. Click OK to create your new poll.  

     

Once the poll has been created, it is listed in the menu. When you select a poll, you see 
additional options to edit the poll, or delete the poll. 

     

Note: Facebook does not allow you to edit a poll that is being shown, so this option is 
not enabled while streaming to Facebook and using a poll.

The options to Show Poll, Show Results and Hide are available when streaming to 
Facebook. As soon as you start streaming, the Show Poll option is enabled. Select Show 
Poll to show a poll in your stream.

New poll item
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There is a lag of 5 to15 seconds between selecting a poll and having it shown in your 
stream. When a poll is actually shown in your stream, a check mark is added to it’s menu 
item and the Show Results and Hide options are enabled.

     

You may show a poll or show its results (which closes voting) at any time while 
streaming to Facebook once the poll has been activated. You may only hide it if it is the 
active poll. Showing a different poll, or showing a different poll’s results, will hide any 
other polls being shown. This allows you to decide if you want to show a poll, or show 
the results of the poll, and then hide it. 

On Facebook, polls are not automatically shown. The viewer must click on the video to 
see or vote on a poll.

     

Select Show Poll

Check mark added

Show Results and 
Hide enabled
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Twitter

Settings
The first thing you need to do is Authenticate your account with Twitter. To do this 
select Social > Twitter > Settings, then click the Authenticate button. Enter your pin when 
the PIN field displays. Select a Feed Type: Home Timeline, User Timeline, Favorites, 
Search. If you select Search, the Search String field becomes active. Click OK when you 
are finished.

     

When the Twitter window displays, click Authorize app.

     

Click Authenticate

Click Authorize app
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When the PIN window displays copy the PIN number. and close the window.

     

In the Twitter Settings window, enter (or paste) the newly copied PIN number, select 
the Feed Type, enter a Search String, then click OK.

     

Feed Types:

• Home Timeline 

• User Timeline 

• Favorites 

• Search Displays Twitter feeds that contain a search string.

The Search String field is only active when you select Search as the Feed Type. Enter any 
word or phrase to use in searching for Twitter feeds that contain your selected words

Create Shot
To create a new Twitter shot, select Twitter > Create Shot. When the new shot icon is 
displayed in the Sot List, click it to place it in the Preview window. You can click and 

Copy PIN number

Enter PIN number

Click OK

Select Feed Type

Enter Search String
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drag the Twitter message box to any location in the shot. Click the Go button to take it 
live.

      

Note: when a message feed is selected (see the Message Feed section below), the 
message will be automatically filled in.

Click Twitter Shot Click the Go button
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Message Feed
Click Twitter > Message Feed to add some Twitter messages to your broadcast. When the 
message window displays, search (optionally) for the messages you want to broadcast.

To select messages to be rotated in your broadcast, first check Rotate Selected Every, and 
enter the number of seconds of the rotation interval. Select the messages you want 
rotated by checking the box at the left of each message. Select a starting message.

Enter search word

Check Rotate Selected Every

Enter rotation interval

Select messages

Select starting message optionally check Auto 
Refresh and enter 
number of seconds
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You can also (optionally) check Auto Refresh and enter number of seconds. The gear 
icon allows you to select or unselect all messages. Once you have selected your 
messages, close the Message Feed window.

      

Twitter message
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Replay + ISO

Introduction
 

Replay enables you to repeatedly play a clip, or even a portion of a clip, any number of 
times or endlessly. You can also replay playlists (see Playlist). This makes the 
combination of Playlist and Replay a very powerful production tool.

ISO (or Isolated Output) allows users to create recordings for system devices (cameras, 
capture cards, or mics) that are currently not being displayed in the Live canvas window. 
This enables you to be outputting one device while broadcasting with another. ISO's 
can also be setup as a replay source. This enables you to have all the Replay 
functionality (hotkeys, Mark-in, and Mark-out) in your ISO source but without it being 
displayed in the Live canvas window.

Replay and ISO share the same menu because ISO's have the ability to be setup to use 
replay functionality. This functionality is toggled in the ISO Settings window. If an ISO is 
set to use Replay then it will use all the replay settings that have been configured in the 
Replay+ISO window. 

Note: Multiple Replay clips captured during the same replay session will not render 
correctly when played at the same time on different master layers or different shot 
layers.

Topics
 Replay + ISO Menu

 Configuring Replay

 Replay Activation

PRO
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Replay + ISO Menu
To use Replay and ISO functionality, select the Replay + ISO menu.

      

Start All Activates the Create Replay Shot system. When activated, the menu item 
becomes Stop All. Click Stop All to deactivate the Create Replay Shot system.

      

Program Replay Allows you to Stop, Mark In, Create, or Update a relay shot.

      

 

Replay Mark All Allows you to tighten up your Replay Shot capture. Select Replay Mark 
In to mark the beginning point of your Replay Shot capture.

Click Plus icon Select a shot Adjust window 
layout

PRO
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Create All Replay Shots Select Create to create additional Replay shots. 

 

Update All Replay Shots If no replay shot exists, selecting Update creates a new Replay 
shot. There after, selecting Update updates the first Replay shot created.

 

Configure Displays the Replay Shot settings window (as shown above in Configure ISO 
Outputs.

Configure Once ISO outputs are created, all ISO outputs are listed in this menu. To 
configure an ISO output, click Configure, then click the Add ISO button.

      

PRO

PRO

PRO
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You can set the quality to: Best, High, Medium, or Low.

         

Configuring Replay 
To use Replay you need to set it up the way you want it to perform. To do this select 
Replay+ISO > Configure. Check the Program Replay box, make your desired settings, and 
click OK when finished.

Capture Audio in the Replay Check the Audio box to capture audio in the Replay you 
are creating. If unchecked all audio is ignored.

Video Quality Set the video quality for Standard or High. Depending on what quality 
you choose, an estimate of the write rate will be displayed.

Folder Click Browse and navigate to the location where you want to store your Replay 
shots.
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Create Replay Hotkey Select a hotkey from the drop-down menu that will activate the 
Create Replay function.

Update Replay Hotkey Select a hotkey from the drop-down menu that will activate 
the Update Replay function. 

Mark Replay Hotkey Select a hotkey from the drop-down menu that will activate the 
Mark Replay function. 

Manage Opens the Preferences > Hotkeys window so you can add, delete or change 
your hotkeys. The Global check box must be checked if you want that hotkey to be 
available in the drop-down menus above. 

Replay Activation
Note: When Replay is activated, CPU usage increases.

To activate Replay, select Replay > Start All. When you do this, the Start All menu item 
becomes Stop All and several buttons are added to the Wirecast main window: Set 
Replay Mark In and Update Replay Shot (same as selecting Replay > Update Replay 
Shot).

        

Once Replay has been activated it keeps all shot activity (playing of clips or capturing of 
live sources) in the Replay buffer on disk. The amount that is saved when the Create 
Replay Shot button is pressed depends on what value was entered into the Default 
Replay duration setting.

Start playing a clip (while Replay is activated), then click the Create Replay Shot button. 
Since the Default Replay Duration is set at 30 seconds, a Replay shot of 30 seconds 
(backward from when the Create Replays Shot button was pressed) is created. The new 

Set Replay Mark In button

Update Replay Shot button
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Replay Shot is placed in Layer 1 (as designated in the settings) as an icon and the Replay 
controls are displayed at the bottom of the Preview window.

     
Replay controls displayed

Select a clip to play

Click Go to play clip

Click Create Replay Shot

Replay Shot created
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Now that you have a 30-second Replay Shot displayed in the Preview window, you can 
use the controls to set the Replay In and Out points and then take the Replay Shot live 
by clicking the Go button.

       

The Replay Mark In button allows you to tighten up your Replay capture. When Replay 
is active, it captures all past activity of your source (clip or live source) into the buffer. 
But you can shorten how much of the capture you actually get in a Replay shot by 
clicking the Mark In button first (to establish when to start your Replay Shot), and then 
click the Create Replay Shot button when you are finished with your Replay shot. Your 
Replay Shot now has just the content you wanted.

        

Another control available at the bottom of the Preview window is the Magnification 
control. Click the magnifier icon (spyglass) to display a magnification slider. Slide the 
slider to the left for lower magnification of the In and Out controls, and to the right for 
greater magnification.

Click Go buttonSet In Point Set Out Point

Set Replay Mark In button

Create Replay Shot button

In and Out point 
controls

Magnifier slider

Magnifier icon
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For example, if you move the slider to the right, the In and Out controls move farther 
apart, increasing the magnification, so that you can more easily adjust the location of 
the In and Out controls. This is very helpful when you have long duration Replay shots. 
However, the slider will quit sliding when you have reached the maximum size of the 
Replay Shot. 

One more control is available at the bottom of the Preview window. It is the Replay the 
speed control. You can set the speed of the Replay Shot by clicking the speed icon 
(“1x”) and selecting a speed from the pull-down menu. Your choices are 1x (normal 
speed), 2x (double speed), .5x (half speed, and .25x (one-fourth speed). The audio is 
muted for any speed other than normal.

In and Out point 
controls moved

Magnifier slider 
moved right

Click the speed icon

Select a speed
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Preferences

Introduction
Wirecast is designed so that you can configure most of your options directly in your 
Wirecast document or the Shot Editor. The Preferences window enables you to set up 
Wirecast, set Desktop Presenter options, manage your licenses, update your software, 
and set advanced video options.

Topics
 Accessing Preferences

 General

 Performance

 Licenses

 Software Update

 Hot Keys

 Controllers

 Advanced

Accessing Preferences
To open the Preferences window, select Preferences from the File menu (or press the 
Ctrl+ Comma (“,”) keys). Preferences are grouped under five topics: General, 
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Performance, Licenses, Software Update, and Advanced. Click one of these topics to 
view and change its preferences.

    

Wirecast automatically saves your preferences every time you make a change. The 
changes are immediately applied.

Resetting Preferences
To reset your preferences, quit Wirecast and then delete the files located at:

Windows 7  C:\Users\USERNAME\AppData\Roaming\net.telestream.Wirecast.xml.

Or, you can use Support Assistant to reset preferences (see Send Support Information 
under Help Menu).

Note: You should match the output to the canvas size as close as possible to preserve 
video resolution and quality. For example, a 800x600 source results in significant loss 
of quality if an aspect ratio of 640x480 is selected. Using 720x576, which is much 
closer in size, helps preserve video quality. 
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General
General preferences enable you to setup the Wirecast environment.

    

Open last document on startup When checked, the last document you used is 
opened when Wirecast starts up. 

Show landing page on startup When checked, the Welcome screen is always 
displayed when Wirecast starts up. You can disable this automatic display by 
unchecking this option, or by unchecking the box in the corner of the Welcome display. 
But you can only turn this automatic display back on by checking this box in the 
Preferences > Advanced window.

Feedback Detection When checked, the computer audio is disabled (live feed is 
unaffected) whenever feedback is detected. Checked is the default. When feedback is 
detected, a warning is displayed with an option to turn off feedback detection.

Show Number of Viewers When checked, enables the viewership indicator while 
streaming.

    

Viewership indicator
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Show Master Layer Colors Check to display colors associated with each Master Layer.

        

Hide Unlicensed Features When checked, unlicensed features (Studio and Pro) are 
hidden from display in the menus. 

Transition Buttons Select the number of transition buttons (one to three) displayed in 
the main window. 

Maximum Reconnect Attempts Enter the number of times you want Wirecast to try to 
reconnect to a host provider. The default is three.

Audio Interface Select the audio playback driver used. 
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The Primary Sound Device is whatever device is selected as the default in the Sound 
Playback settings window (which is accessed by right-clicking the speaker icon in the 
Windows task bar). The other selections are a list of all sound devices installed.

        

Performance 
Performance preferences enable you to select the display rate used for all internal video 
rendering. 

You can set the Video Display Rate to 24, 25, 30, 50 or 60 fps. If using PAL sources, 
choosing 25 may eliminate dropped or duplicate frames. It is recommended that you 
set this frame rate to match the frame rate of your output video encoder. 

You can turn on the Live Icons feature, which makes all icons in the Shot Area display 
any live activity in the device it represents (cameras, streaming, etc.). You can also set 
the fps of the Live Icon display using the slide bar control.

     

List of all sound 
devices installed

Sound device 
selected as default
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Licenses
The licenses preferences enable you to register and license Wirecast. To purchase a 
license, click Purchase. To activate a license, enter your serial number and click Activate.

      

Serial Numbers
The Licenses Preference window displays the products and serial numbers that you 
have received forWirecast.

Note: The serial number is always composed of numbers and upper case letters 
(excluding upper case letter O), but it never contains quotation marks. When you 
receive a serial number, it may be enclosed in quotation marks (e.g., “123-456-789”). 

If you wish to purchase a serial number from the web store, click Buy. When Wirecast 
displays the Enter Serial Number window, enter the serial number and click Activate. 
Wirecast validates the serial number and unlocks Wirecast. If you previously purchased 
a copy of Wirecast and want to use that serial number, enter that serial number to 
unlock Wirecast 

Note: If you do not want to purchase a serial number directly in Wirecast, you can also 
purchase a serial number at www.telestream.net.

Manual Activation
If your computer is not on the Internet, you can use another computer to activate your 
license and unlock Wirecast. To manually activate your license, download the Manual 
Activation Guide at:  http://www.telestream.net/telestream-support/wire-cast/
training.htm and follow the steps in the guide to unlock Wirecast.

Click Purchase

Enter serial 
number

Click 
Activate

http://www.telestream.net/telestream-support/wire-cast/training.htm
http://www.telestream.net/telestream-support/wire-cast/training.htm
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Deactivate Serial Numbers
Deactivating a serial number allows you to re-activate it on another computer. You can 
always reactivate a serial number by re-entering it. To deactivate a serial number, click 
the Deactivate button on the Licenses tab in Preferences. Wirecast deactivates the serial 
number and adds water-marking to the video and audio whenever licensed features 
are used. When you deactivate a serial number, it is removed from the table.

     

Demonstration Mode
When no serial number is entered or activated, Wirecast water-marks all output (both 
to disk and network). The video water-mark is a periodic overlay of the Wirecast logo. 
Audio water-mark is a periodic voice over. If you have a Wirecast serial number and are 
using a Wirecast Pro feature without a Pro license, that output is also water-marked.

Software Update 
Software update preferences enable you to obtain Wirecast updates.

Automatically Check Updates Check the Automatically Check For Updates checkbox 
to cause Wirecast to check for updates on the Telestream Website each time Wirecast is 
launched. No personal information is transferred to Telestream during this action.

Check Now Click Check Now to immediately check for updates on the Telestream 
Website (www.telestream.net). No personal information is transferred to Telestream 
during this action.

Click to 
deactivate
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Upgrades Included
With each purchase of Wirecast – whether it is an upgrade purchase or full license – you 
receive a Standard Support subscription for 1 year from the date of purchase. This 
subscription can be renewed annually.

Optionally, customers can choose to upgrade this Standard Support subscription to a 
Premium Support subscription at any time, for an additional fee. Premium Support 
subscriptions can also be renewed annually.

Your support subscription is tied to your Wirecast license. As long as your license is 
entered into the software and your Premium or Standard support subscription is active, 
you will be allowed to upgrade to the latest unlocked version of Wirecast for free.  To do 
this, download and install the latest version of Wirecast and you will automatically have 
access to all the new features (depending on your license level).

If your support subscription is expired, or you have not entered your license into the 
software, you will not be able to upgrade to an unlocked version and the software will 
revert to demo mode. However, you may continue to use the last valid version of the 
software released during your support subscription coverage.

If your support subscription is about to expire (12 months from the date of purchase), 
Wirecast will prompt you to renew it. If you do not renew it before it expires, you may 
re-subscribe at any time for an additional fee.

Hot Keys 
Hot Key preferences enable you to create custom hot key assignments. To add a new 
hot key, click the add (+) button. Press the keys you want to define that hot key and 
enter a name for your hot key. To remove a hot key, select it in the hot key list and click 
the remove (-) button. Additionally, you check the Global check box to make your 
hotkey “global”. This means that even if the Wirecast window is not the active window, 
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the hot key will still work. Otherwise (if Global is not checked) the window must be 
selected in order for the hotkey to work.

Hot keys are associated with a shot by selecting the Keyboard Shortcuts menu (by 
clicking the shot gear icon), then selecting a hotkey. This selection binds the hot key to 
the shot. 

Click “+”  to add a hot key

Click “- “ to remove a hot key

press keys to create 
assignmentEnter a name 

Check Global 
(Optionally)

Click the 
gear icon

Select a 
hot key

Select Keyboard 
Shortcut
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Once a hot key is assigned to a shot, the name of the hot key displays in the shot icon.

You can assign multiple shots to the same hot key. This is useful when you want 
different shots on different layers to be activated at the same time using one hot key. To 
do this, assign the hot key to the first shot (as described above), then assign the same 
hot key to a second shot on another layer. The shot name will display in both shot icons.

Controllers

   

Controllers preferences enable you to adjust MIDI and X-keys controller settings for 
Wirecast. Select the Controllers tab in the Preferences window, then select a controller 
from the drop-down menu.

Wirecast provides control of three MIDI controllers: APC MINI, APC40mk2, Launchpad 
MK2, and one X-keys controller: XKeys 128.

        

Hot key 
name

STUDIO

Select a  controller
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MIDI Control Assignments
Each MIDI controller has up to six controls assigned to it. The locations of each of these 
controls are shown below for the three midi controllers supported.

The locations of APC MINI controls are shown below:

       

The locations of APC40mk2 controls are shown below:
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The locations of Launchpad MK2 controls are shown below:

       

Each MIDI controller has up to six controls assigned to it. The locations of each of these 
controls are shown below for the three midi controllers supported.

MIDI Control Descriptions
1. Shot Layers The matrix of buttons on the MIDI controller (five rows of eight 

buttons) automatically correspond to the five layers in the Wirecast shot list 
window. Up to eight shots in each layer are controlled by the MIDI controller 
buttons. Shots are automatically assigned to MIDI controller buttons as they are 
created. If less than eight shots exist on a layer, the corresponding buttons (to the 
right) are inactive.

2. Go Live Pressing this MIDI controller button is the same as clicking the Go Live 
button in the Wirecast Main window.

3. Transition 1 Pressing this MIDI controller button is the same as clicking the Left 
Transition button in the Wirecast Main window.
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4. Transition 2 Pressing this MIDI controller button is the same as clicking the Left 
Transition button in the Wirecast Main window.

       

5. Audio Mixer Volumes Sliding these MIDI controls adjusts up to eight volume 
controls in the Wirecast Audio Panel. Each MIDI slider corresponds (left to right) to a 
volume control in the Audio Panel. Volume controls are automatically assigned to 
MIDI controller sliders as they are created. If less than eight volume controls exist in 
the Audio Panel, the corresponding MIDI sliders (to the right) are inactive.

6. Channel Pan Adjusting these MIDI controls sets up to eight Channel Pan controls 
in the Wirecast Audio Panel (located just below the volume controls). Each MIDI 
control corresponds (left to right) to a Channel Pan control in the Audio Panel. 
Channel Pan controls are automatically assigned to MIDI controls as they are 
created. If less than eight Channel Pan controls exist in the Audio Panel, the 
corresponding MIDI controls (to the right) are inactive

Transition 1 (left) button

Transition 2 (right) button

Go Live button

Channel Pan Controls
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X-keys Control Assignments

   

The X-keys controller has multiple controls assigned to it. All of the assigned controls 
are shown below. 

     

General Key Operations
• Key lamps turn red when a function is on, and turn blue when off (except for keys 

that do not have dual states, like the Hot Keys).

– Function lamps turn red when a function is on, and turn blue when off (except 
for keys that do not have dual states, like the Hot Keys).

– Shot switching key lamps turn Blue when shot is in Preview and Red when in 
Live. Otherwise they are off.

• The Wirecast software and the X-keys panel stay in sync when keys are pressed or 
changes are made in Wirecast.

• Some keys are interactive. In such a case, pressing one key affects the status of 
another (like the PREV and LIVE keys).

Key Descriptions
1. Five Layers keys  Controls the first twelve shots (plus the Clear Layer shot) on each 

of the five layers.

2. Hot Keys  The twelve keys represent the twelve Hot Keys that have been assigned 
in Wirecast. Pressing a key executes the matching numbered Hot Key (1 through 
13). The key lamps momentarily turn red, then turn back to blue.

STUDIO

1

2
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15

16
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3. Live/Preview Swap Mode   Toggles the Live/Preview Swap mode. When in this 
mode, the Live and Preview shots are swapped.

4. Auto Live Mode   Toggles the Live Auto mode. When in this mode, selected shots 
are displayed in the Live Output window immediately.

5. Rendezvous   Toggles (show/hide) the display of the Rendezvous window.

6. Audio Mixer   Toggles (show/hide) the display of the Audio Mixer window.

7. Preview Monitor Audio  Toggles the Preview monitor audio (what you hear 
locally) on and off.  (It is mutually exclusive with Live Monitor audio).

8. Mute Live Streaming audio  Toggles the Live Streaming audio (what your viewers 
hear) on and off.

9. Live Monitor Audio  Toggles the Live monitor audio (what you hear locally) on and 
off. (It is mutually exclusive with Preview Monitor audio).

10. Streaming   Toggles streaming on and off.

11. Recording   Toggles recording on and off.

12. ISO Recording   Toggles ISO recording on and off.

13. Multi Viewer   Enables all displays. Pressing this key is the same as selecting 
Output > Multi-Viewer Output > Enable All Displays.

14. NDI   Enables/Disable NDI output.

15. Fade to Black  Pressing this key acts as a “master transition-to-black”. The transition 
used is the one currently selected.  It is very helpful when needed to make the Live 
Output black in an emergency. If Wirecast is in Live/Preview Swap mode, the live 
shot is moved to Preview and the pre-fade condition can be restored by pressing 
the Go key.

16. Live Media Play and Pause Press the Play button to play a selected media file, and 
press the Pause key to pause it.  These keys are interactive.  Pressing one changes 
the lamp status of the other.
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17. Replay Create and Update  These keys execute Replay+ISO > Create All Replay 
Shots and Replay+ISO > Update All Replay Shots. 

18. Mark In   Pressing this key executes Replay+ISO > Program Replay > Replay Mark In.

19. Transitions 1 and 2  These keys select Transition 1 or Transition 2 so that when the 
Go key is pressed, the selected transition will occur.

20. Go  Press this key to execute a transition of the shot from the Preview window to 
the Live Output window. If Wirecast is in the Live/Preview mode, the Live output 
shot will be moved to the Preview window when the Go key is pressed 
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Advanced 
Advanced preferences enable you adjust advanced settings for Wirecast.

        

Wirecast usually synchronizes its video display with the refresh rate of your display. 
However, this degrades performance when the Wirecast program window is not visible 
(due to the screen being locked, Wirecast minimized, or the Wirecast covered by 
another application). In order to avoid frame drop in these situations, check Disable 
Vertical Sync. However, the disadvantage of using this option is that disabling the 
synchronization can interfere with the smooth display of video in the Wirecast UI. It will 
not, however, have any negative effect on your broadcast.

Use High Quality Video

Check the Use High Quality Video checkbox to increase the quality of decoding 
performed on your source media files. If CPU usage is near 95%, or if the frames per 
second (fps) is consistently well below your target, uncheck Use High Quality Video to 
remedy this. Checked is the default.

Render using YUV Colorspace

If Render using YUV colorspace is checked, video frames will be rendered on the GPU 
using YUV rather than RGB. This will typically provide a performance advantage and 
save on memory. However, with some graphics cards this can result in very noticeable 
degradation of video quality. Performance will improve when streaming to most 
destinations (including Virtual Camera Out), except in combination with some graphics 
cards on Windows systems. The best way to know if this option is advantageous to use 
on your system is by trial and error, and observe the results. 

Use Legacy D3D9 readback

If you experience rendering issues or incompatibilities on older graphics hardware, try 
enabling this preference.
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Disable Vertical Sync

Check Disable Vertical Sync to receive frames as fast as possible when playing games, 
etc. This is useful when the application window is minimized or covered by another 
application.

Disable IP Camera Discovery

Check Disable IP Camera Discovery to turn off automatic discovery of IP Cameras.

Video Adapter

Select the video adapter that Wirecast uses for rendering and compositing. If you are 
using a discrete GPU, select the same GPU on which your application is running. This 
feature is designed for users with multiple graphics cards (NVIDIA/AMD/Intel), and it 
enables them to identify which video card Wirecast uses.

Note: Video Adapter defaults to the first discrete card that is discovered by Wirecast. If 
you have multiple GPUs, it is best to configure Wirecast to use the same card as used 
for your application (for optimal performance), otherwise a slower capture path will be 
used. Also, best performance is achieved by setting the Video Adapter to use the 
NVidia card.

Default Playlist Live Shot Duration

Enter a duration time you want as a default value used by Playlist live shots when they 
are created. If no values are entered, there is no default duration time for the newly 
created shot.

Global Hot Keys

Check Enable global hotkeys to define hotkeys for “Replay Mark-In” and “Create a Replay 
Shot” functionality. To assign a hot key, first select one of the functions by clicking in its 
edit box, then press a key stroke sequence to be used as the hot key (i.e.  Ctrl + 8).

        

Note: These Global Hot Key settings are specifically for Replay. This is so you can 
activate Replay functions when the application window is not in focus while playing 
games, etc.
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Audio Mixer

Introduction

   

The Audio Mixer enables you to monitor and control all of the audio sources from a 
single control panel. This section describes in detail how to use the Audio Mixer.

Topics
 Overview

Overview
To open the Audio Mixer panel, select Audio Mixer from the Window menu.

The Audio Mixer separates your audio by hardware and shot. Live Input is always the 
first section to the right of the Master control, and it contains all hardware audio 
sources that are live in your streaming event. This includes microphones, audio input 

STUDIO



Audio Mixer
Overview

190

feeds, cameras, capture cards, Web streams, etc. The remaining audio controls are 
associated with specific shots. 

The Monitor button toggles the source audio when monitoring Preview or Live output. 
This does not remove the audio from the output stream or recording. Delay enables 
you to delay the audio as needed, in seconds and milliseconds. Channel enables you to 
select left source only, right source only, or stereo (left and right).

Delay Enter the amount of audio delay needed (in seconds and milliseconds).

Channel Select the channel to use: Left, Right, or Stereo (both).

FX Click the down-arrow to display the audio effects panel.

Master Audio 
control panel

Master Level 

Headphone 
Mute 

Master Mute 

Live Sources 
control panel

Master display

Source 
selection

Level control 

Level display

 Mute button

Monitor button

 Delay

Channel
FX

Add new FX

Track 
selection
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Add New FX (+) Click the plus (+) icon to select an audio effect from the drop-down 
menu.

• Delay L and R Delay adjusts how much delay on each channel. Feedback is how 
much delay is used. Fb Tone is a frequency setting of highs and lows to be delayed. 
FX Mix is how much delay will be added to audio output. Output sets the delay out-
put level.

• Dynamics Thresh sets the threshold of engaging compression. Ratio sets the com-
pression ratio. Output sets the compression level. Attack sets the manner in which 
compression is applied. Release sets how compression in released. Limiter sets a 
max output level on the audio. Gate controls (Thresh, Attack, and Release) sets the 
noise gate that cuts off noise at the set level. Mix adjusts how much compression is 
applied to the audio.
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• De-ess Thresh sets the threshold of de-essing. Freq selects the frequency at which 
de-essing will be applied to the audio. HF Drive adjusts the high frequency aspect 
of de-essing.

• EQ Low, medium, and high adjusts low, mid, and high frequency components in 
the audio. 

• Loudness Loudness adjusts the amount of loudness (raising high and low frequen-
cies) in the audio. Output adjusts how much loudness is applied to the audio..

• Limiter Thresh sets the minimum threshold of limiting in the audio. Output sets 
the amount of limiting used in the audio. Release sets the manner in which limiting 
is released as the audio decreases. Attack sets the manner in which limiting is 
applied. Knee adjusts the frequency and shape of point where limiting begins.

• Multiband Listen selects which part of the frequency spectrum to hear: low, mid, 
high, or all (output). L<>M adjusts the cutoff frequency in the low to mid range (87 
to 1020 Hz). M<>H adjusts the cutoff frequency in the mid to high range (111 to 
19606 Hz). L, M, and H Comp adjusts the compression for low, mid, and high fre-
quencies. L, M, and H Out adjusts the output for low, mid, and high frequencies. 
Attack sets the manner in which compression is applied. Release sets the manner in 
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which compression is released. Stereo adjusts how the left and right channels are 
separated (width) from 0 to 200%. Process selects stereo or mono mode.

• Noise Reduction Amount sets the amount that noise reduction is applied.

Level Control Adjusts the audio level of the live audio output.

Level Display Displays the levels (left and right) of the live audio outputs.

Mute Mutes the live audio output.

Monitor Toggles the monitor audio output in the headphones without effecting the 
live audio output.

Master Level Adjusts the audio level of the Master audio output.

Master Display Displays the levels (left and right) of the Master audio outputs.

Master Mute Mutes the Master audio output.

Headphone Mute Toggles the monitor audio output in the headphones without 
effecting the Master audio output.

Source Selection Click the down arrow to select an audio source from the drop-down 
menu.

Track Selection Click the down arrow to select an audio track from the drop-down 
menu. 
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Asset Manager

Introduction
The Asset Manager is used to change the sources of media in your document. It is 
accessed by selecting Media > Show Asset Manager.

Topics
 Documents

 Reassigning Media

Documents
Wirecast stores a path to your media in the Wirecast document. If you relocate your 
media, Wirecast no longer is able to find them. In this case, use the Asset Manager to 
reassign the new media locations. However, Wirecast does keep track of the relative 
path to your media. If you move both the document and media to a new position, 
Wirecast still finds the media. 

Reassigning Media
To reassign media, follow these steps:

1. To open the Asset Manager, select Show Asset Manager from the Wirecast Media 
menu.

2. Select the media you want to assign to another source.

3. Some media assets (i.e. cameras) enable you to set the aspect ratio by displaying a 
Device Aspect Ratio menu. You can select an aspect ratio from this menu.

4. Select the new media from the Assign To  menu, or click Browse and locate the 
replacement media on disk.

Note: When Desktop Presenter is selected as the source, you can enter the IP address 
for the Desktop Presenter. This enables you to build a Wirecast presentation with 



Asset Manager
Reassigning Media

196

place-holders and then reconfigure at a later date to accommodate a new presenter 
with a new Desktop Presenter as a source. Click Apply, then click the corresponding 
icon in the Shot Selection.

5. Click Apply to replace the existing media, then close the Reassign Media window.

Select media

Select assignment 
or click Browse

Click Apply 
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   Menus and
Windows

Introduction
These topics describe the menus, menu items, and keyboard shortcuts in Wirecast. 

Topics


 File Menu

 Edit Menu

 Switch Menu

 Media Menu

 Output Menu

 Layout Menu

 Replay + ISO Menu

 Twitter Menu

 Window Menu

 Help Menu
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File Menu
New Creates a new, empty Wirecast document.

Open Displays the Open dialog window for opening a Wirecast document.

Open Recent Displays up to fifteen of the most recently accessed documents. Every 
time a document is opened or saved it is entered into this list.

Import Media Enables you to import media into Wirecast. A new shot is automatically 
created using the new media.

Save Saves the document. If the document has not already been saved, the Save As... 
dialog window is displayed.

Note: Wirecast  auto-saves your Stream/recording. All formats (WMV, MOV, MP4) will 
be recoverable in increments of 20 seconds. Any recording less than 20 seconds is 
corrupted. ISO also recovers. In the case of an unexpected shutdown, the recoverable 
video is available in increments of one minute.

Save As Displays the Save As... dialog window so that the document can be saved using 
a new file name.

Close Window Closes the currently active Wirecast window. If the window is a 
document, all of its Shot Editor windows are closed as well. If Wirecast is still 
broadcasting, you are asked to stop the broadcast. If the document has not been saved, 
you are asked to save the document before closing.

Preferences Opens the Preferences window. If the Preferences window is already open, 
it is made active.

Exit Closes all documents and then exits. If the broadcast is playing, you are asked to 
stop the broadcast. If a document has not been saved, you are asked to save the 
document before exiting.

Edit Menu
Undo Reverses your last change in Wirecast. Undo is only available in some windows 
(such as the Preview window). Wirecast offers an unlimited number of undo actions 
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(within computer memory limitations). Undo information is stored on a per-window 
basis. Also, if you close a window then reopen it, your undo information is lost. 

Redo Reverses your last undo action. Redo is only available in some windows (such as 
the Preview window). Wirecast offers an unlimited number of redo actions (within your 
computer’s memory limitations). Redo information is stored on a per-window basis. 
Also, if you close a window then reopen it, your redo information is lost.

Cut Cuts selected text.

Copy Copies selected text to clipboard.

Paste Pastes selected text from clipboard to location of cursor.

Paste as new Consolidated Shot  A consolidated shot is a shot created by selecting 
multiple sources in the Shot Layers tab of the Shot Editor and then creating a new shot 
using these selected sources. To do this. select multiple inputs, select Edit >  Copy, then 
selecting Edit > Paste as new Consolidated Shot to create a new shot in the selected layer.

      

Select All Selects all text in the active window.

Edit Shot Opens the Shot Editor. (See Shot Editor). You can also double-click a shot, or 
right-click and select Edit Shot, to open the Shot Editor. 

Rename Shot Enables you to rename a shot. You can also right-click a shot and select 
Rename Shot.

Duplicate Shot Duplicates the currently selected shot. You can also right-click a shot 
and select Duplicate Shot.

Select multiple inputs

Consolidated shot
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Duplicate Shot Options Check a source to create a new instance of it when 
duplicating the shot containing it. Multiple selection is allowed.

      

Add Shot Creates a new empty shot. You can also right-click a shot and select Add 
Shot.

   

Add Playlist Shot Creates a new Playlist shot. You can also select New Playlist Shot from 
the shot menu in the layer window.

Delete Shot Deletes the currently selected shot. You can also right-click a shot and 
select Delete Shot.

Move To Layer Moves a shot to the selected layer. When shots are created, they are 
assigned to a specific layer. They exist on that layer until they are moved or deleted. You 
can also click and drag a shot to another layer. 

Switch Menu
Go Performs a transition (same action as clicking the Go button).

Transitions Wirecast  has two transition buttons that can be assigned any transitions 
(cut, smooth, etc.) that Wirecast  supports. The Switch menu lists the currently assigned 
transitions by name. These two transitions can also be selected by pressing the control 
key and either the 1 or 2 key. (See Transition Controls to modify which transitions appear 
in this menu.) 

Transition Speed Enables you to select one of five transition speeds ranging from 
Slowest to Fastest.

   

Manage Stinger Transitions Enable you to import and use custom transitions that 
employ transparent backgrounds.  These transitions are typically created using 
applications such as Adobe After Effects, Apple Motion or ScreenFlow.  

STUDIO

STUDIO
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Select Switch > Manage Stinger Transitions to display the Stinger Transition Manager. To 
import a transition file, click the plus (+) button and navigate to the location of the file.

Note: Wirecast  only support MOV and MP4 transition. 

      

Once the transition file is imported, you can preview the transition from shot A to shot 
B by clicking the play button. To set the location of where the shot will change from A 
to B, slide the scrubber to a location in the transition, then click the A/B button.

      

Note: Stinger transitions are stored in the preferences (including the path to the 
media file). This allows the you to re-use transitions in other WC documents. When 
Wirecast  cannot find a media file associated with a Stinger transition (file deleted or 
moved), the transition will be removed from the transition bank list and the name will 
be highlighted red in the Stinger Transition Manager.

Click plus 
button

Click play to 
preview

Move scrubber 
to a location

Click the A/B 
button
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To delete a transition, select it and click the minus (-) button. Click the help (?) button to 
display help instructions (this portion of the user guide). Check (optionally) the Keep all 
video frames in memory check box. When checked, CPU spiking (which can cause 
streaming problems) is prevented, but more memory is used. Click Close to exit the 
Stinger Transition Manager.

      

To execute a Stinger Transition, open a transition menu and select a Stinger transition.  
Click the Go button to execute the Stinger transition.

      

AutoLive Toggles (turns on and off ) the AutoLive feature. AutoLive is a fundamental 
feature of Wirecast which enables you to control how you make shots become part of 
the live broadcast. (See AutoLive.)

Live/Preview Swap Toggles (turns on and off ) the Live/Preview Swap feature. When 
on, the Live Broadcast and Preview windows trade panes (swap) when the Go button is 
clicked.

Disable PTZ Preset Recall  Enables/Disables PTZ preset recall. (See PTZ Controller).

Click minus 
to delete

Check checkbox (optionally)

Select a file

Click ? button 
for help

Click Close to exit

Select a 
transition

Open a transition menu
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Media Menu
Start Playing All Movies Starts playing any movies that are not currently playing.

Pause All Movies Pauses all movies that are currently playing.

Shuffle Playlist Randomly rearranges the order of media in the playlist. 

Show Asset Manager Displays devices that can be configured. Some devices (cameras, 
etc.) may be configurable. For example, you can configure a USB camera to manually 
change its focus, contrast, brightness, etc. Other devices have multiple inputs you can 
choose (AlchemyTV Card, etc.). (See Asset Manager.)

Note: The Configure Devices menu selection is present only if a device is connected 
to Wirecast. The configuration user interface is provided by the device maker. It is 
beyond the scope of this document to describe all of the features available for all 
devices. See the documentation provided with your device on how to configure it.

Output Menu
Output Settings Opens the Output Settings window.

Start/Stop Broadcasting Starts (or stops) broadcasting to the network. 

Start/Stop Recording Starts (or stops) recording to disk. If you have not yet configured 
the Output Settings for this document, you are prompted to do so. 

Show Recordings Opens all the folders of all the file directories in the Output Settings. 

   

Multi-Viewer Output Enables you to setup and use a Multi-Viewer display on and or all 
monitors. You can configure your displays, enable all displays, select a display to be 
active, or show (or hide) all displays when the application is in the background.

     

Configure Displays 

Select Configure Displays to open the configuration window.

STUDIO

Configure Displays
Enable Displays

Select a Display

Hide/Show Displays
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Setup your Multi-Viewer by choosing a Monitor which determines where the Multi-
Viewer will display.

Also select a Layout which determines how the Multi-Viewer will be displayed. The 
layout choices are: one, two, or four slots. In the Pro version ten or seventeen slots can 
also be selected. Each panel slot can then be mapped to any source: Preview, Live or 
any existing Shot in your document. Click inside a panel to select a source. Each 
Monitor is configured separately using the Configuration window. So, when you select 
a different monitor, the configuration panel (slots) also change. Additionally, all the 
monitors are automatically numbered. Clicking the Identify Displays button causes each 
of the monitors to display it number on it. 

You can also control how each panel is labeled by making a selection from the Labels 
menu: 

• Draw Labels Below each Slot  Displays the label below each shot in each panel.

• Superimpose Labels Over Each Shot  Displays the label over each shot in each 
panel.

• Do Not Draw Labels  No labels are displayed.

Click on any slot panel to open the source menus, then select a source from the list to 
display it in the slot. Click Identify Display to cause the display number on each display 
to be shown.

Enable/Disable All Displays 

Select to hide or display all of your configured Multi-Viewed monitors.

Select a Monitor

Select a Layout

Select a Label mode

Select a source

Click to identify 
monitors

Click to open 
source menu
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Select a Display 

Select one of your configured Multi-Viewed monitors to hide or display. Shown below is 
a typically configured monitor with four slots.

Hide All Displays When App is in the Background 

When selected, all Multi-Viewer Displays are hidden if Wirecast  itself is put into the 
background or minimized. Turning this option off allows the Multi-Viewer outputs to 
stay on if Wirecast  is put in the background or minimized.

Note: Multi-Viewer displays can also be disabled by clicking on the Multi-Viewer 
display itself (on its target monitor), and then pressing the Escape (Esc) key.

Virtual Camera Out Enables you to present the output of Wirecast as if it were a 
camera (a virtual camera), allowing it to be automatically detected by other 
applications when they are launched. Outputs only the Live Program feed. (See Virtual 
Camera in Broadcasting section for more detailed information).

Active Broadcast Once you have logged into your YouTube or Twitch account and you 
start streaming, you can select Active Broadcast to display the YouTube broadcast 
window in a browser.



Menus and Windows
Output Menu

206

Control Room (YouTube only) Once you have logged into your YouTube account, you 
can select Control Room to display the YouTube control room window in a browser.
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Dashboard (Twitch Only) Once you have logged into your Twitch account, you can 
select Dashboard to display the Twitch dashboard window in a browser.

     

VOD of Last Broadcast Enables you to view the most recent completed broadcast.

Note: Active Broadcast is enabled only for Periscope/Twitter and YouTube., Control 
Room and VOD of Last Broadcast are enabled only when you are logged into YouTube.
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Facebook (Facebook Live Only)  Select Active Broadcast to display your Facebook Live 
event. 

     

Periscope/Twitter Opens menu to monitor your Periscope/Twitter broadcast.

• Active Broadcast Once you have logged into your Periscope/Twitter account and 
you start streaming, you can select Active Broadcast to display the your broadcast 
window in a browser.

• Producer Dashboard Once you have logged into your Periscope/Twitter account, 
you can select Producer Dashboard to display the Periscope/Twitter dashboard 
window in a browser. In the dashboard you can start your broadcast by clicking the 
Go Live button. 
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To stop your broadcast click the Stop Broadcast button.

     

• Toggle Broadcast Click to toggle between Go Live and Stop Broadcast on the 
Producer Dashboard.

Canvas Size Sets the canvas size resolution used when broadcasting a Wirecast 
document.

Note: You should match the output to the canvas size as close as possible to preserve 
video resolution and quality. For example, a 800x600 source results in significant loss 
of quality if a resolution of 640x480 is selected. Using 720x576, which is much closer in 
size, helps preserve video quality. 

Show Statistics Displays the statistics window for your broadcast. You can select (for 
display): Bitrate, RTMP Queue Size, Framerate, System CPU Usage, and System Memory 
Usage.
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NDI Output Sends the output of the Live Program feed. Select the output resolution for 
your NDI output. You can also select a link that will take you to NDI.NewTek.com for 
additional information. 

    

Blackmagic Cards

You can use Blackmgic cards to send live feeds directly into editing, effects and 
broadcast design systems. In order to use this feature, install a Blackmagic card with 
associated drivers, then restart Wirecast. The Blackmagic card with then be listed in the 
Output menu.

Under the Output menu, select a Blackmagic card, and then select an HD setting for its 
output. If your card has multiple outputs, you can select more than one and all will 
output simultaneously at independent resolutions and Frame rates.

STUDIO
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To begin outputting, select Start Output and chose a setting.  

    

You can stop the Blackmagic card output by selecting Stop Output. If you have multiple 
outputs selected, they will all stop outputting.

Note: Some Blackmagic cards do allow input and output simultaneously, but need to 
be configured in the Blackmagic software.

Layout Menu
Master Audio Shows (or hides) the Master Audio controls.

Show Live and Preview Displays the Live and Preview windows.

Show Preview Only Displays the Preview window only.

Show Live Only Displays the Live window only.

Note: The above three controls are the same as the Live/Preview Control buttons at 
the top of the main window.            

Go to Layer Displays the selected layer. You can also press Ctrl + Shift keys with the T, F, 
N, B, or A keys to select a layer. Each of these letter keys represents a layer name: Title, 
Foreground, Normal, Background, and Audio.
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Activate layer Activate (checked) or deactivate (unchecked) a layer. You can also click 
the LED on the right side of each layer window.

Game Overlay Shows or hides an overlay that displays streaming statistics.

Replay + ISO Menu

 

Start All Activates the Create Replay Shot system. When activated, the menu item 
becomes Deactivate. Click Deactivate to deactivate the Create Replay Shot system.

Activate Activates the Create Replay Shot system. When activated, the menu item 
becomes Deactivate. Click Deactivate to deactivate the Create Replay Shot system.

Configure ISO Outputs Once ISO outputs are created, all ISO outputs are listed in this 
menu. To configure an ISO output, click Configure, then click the Add ISO button.

        

Replay Mark All Allows you to tighten up your Replay Shot capture. Select Replay Mark 
In to mark the beginning point of your Replay Shot capture.

Create All Replay Shots Select Create to create additional Replay shots. 

Update All Replay Shots If no replay shot exists, selecting Update creates a new Replay 
shot. There after, selecting Update updates the first Replay shot created.

PRO
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Configure Displays the Replay Shot settings window (as shown above in Configure ISO 
Outputs.

Settings Displays the Replay settings window.  Use this to configure your Replay then 
click OK when finished.

      

For more information about Replay Shots see Replay. 

Social
Two social media options are provided: Facebook and Twitter.  Facebook enables you to 
receive poling data from viewers. Twitter enables you to add Twitter messages to your 
broadcast along with filtering what messages are displayed.

Facebook

Note: Facebook Polls are only shown in the Facebook UI when the Facebook Video is 
playing, and fully open.

Facebook polls are controlled through the Social menu in Wirecast. Select Social > 
Facebook > Create New Poll to create a new poll.

     



Menus and Windows
Window Menu

214

The Social > Facebook menu contains the Create New Poll option as well as any 
previously created polls. Polls are not saved with the document. They are saved with 
the WC application, the same as preferences are.  

(See Facebook in the Social Media section of this user guide for more detailed 
information).

Twitter Menu
Message Feed Brings up your Twitter feed.

Create Shot Creates a shot with a social media title in Master Layer 1.

Settings Brings up the Social Media Settings dialog.

     

• Authenticate  Click to authenticate your account with Twitter. Enter your pin when 
the PIN field displays.

• Feed Type Select a Feed Type:  Home Timeline, User Timeline, Favorites, Search. If 
you select Search, the Search String field becomes active.

• Search String Enter a search string. (Active only when Search is selected in Feed 
Type above.)

(See Twitter in the Social Media section of this user guide for more detailed 
information).

Window Menu
Welcome to Wirecast Displays the Welcome screen.

Encoder Presets Opens the Encoder Presets window.

   

Audio Mixer Opens the Audio Mixer window.

 

PTZ Controller Opens the PTZ control panel. (See PTZ Controller).

Show USB Devices Opens a list of all USB devices.

STUDIO

PRO
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Open Rendezvous Dashboard Opens a Rendezvous Dashboard. Click Start Session to 
use.. (See Rendezvous Properties).

     

 

Open Advanced Rendezvous Audio Mixer Displays the Rendezvous Audio Mixer 
window. 

     

– Output from document Select document source via the pull-down menu.

– Channel  Output level indicators for each channel.

– Include In Mix When checked, this audio source is included in your Rendezvous 
session.

– Audio Level (Sliders) Move the sliders Library to adjust the audio level.

Download Manager Opens the Stock Media download monitor window.  Whenever 
you add a Stock Media Library file, the downloading progress is displayed.  You can 

STUDIO
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cancel a download by clicking on the X icon. To navigate to the location of a 
downloaded file, click the spyglass icon.

     

 

New Layer Window Opens a new Master Layer window for the layer selected.

Document Windows All open document windows are listed at the bottom of this 
menu.

Help Menu
Wirecast Help Opens the online help version of the User Guide.

Open Wirecast PDF User Guide Opens the PDF version of the User Guide.

Open Tutorial HTML Opens the Wirecast  Tutorial in your browser. To follow the 
tutorial, you'll need to Create a Document for the Tutorial as well.

Create Document for Tutorial Creates a new Wirecast  Document which contains the 
media necessary for following the Tutorial.

Buy/Upgrade Opens Licenses in the Preferences window. This window allows you to 
purchase licenses and to activate or deactivate them.

Provide Feedback Opens the Telestream Website feedback page where you can enter 
any feedback you may have about our product or company.

Click X icon

Click spyglass icon

STUDIO
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Send Support Information Opens a Support Assistant dialog window. To create a new 
support ticket, select Create a support ticket. The information is sent to the Telestream 
support team for evaluation. If you have been previously issued a case number, select 
Link with existing support case # and enter your case number. You can also select Do not 
receive follow-up from Telestream. This enables you to send support information to 
Telestream without receiving a response. Click Save Report to save the information to a 
file on your computer. Click Send Report to send the information to Telestream. 

Note: You must click Send Report to create a ticket. If you click Save Report, a ticket will 
not be created.

         

Open Scripting Documentation Opens the Wirecast Scripting Help document.

Show Scripting Examples Opens the directory where the Wirecast Scripting examples 
are located.

Visit Telestream Website Opens the Telestream Website home page.

Visit Wirecast / Desktop Presenter Download Page Opens the Telestream Website 
download page for Desktop Presenter.

Acknowledgments Opens an on-line help to Acknowledgments.

About Wirecast Displays version and copyright information about Wirecast.
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Broadcasting

Introduction
Note: Wirecast will not prevent your computer from entering sleep mode. Therefore, 
to ensure uninterrupted streaming, you should disable sleep mode on your computer 
while using Wirecast.

Note: To avoid a decrease in video quality, Wirecast should not be used at CPU usage 
above 80%. See the Telestream Website for suggested configurations.

Topics
 Canvas Size
 Virtual Camera
 Output Settings
 Encoder Presets
 WM-Push To Server
 WM-Pull From Server
 RTMP Server
 Telestream Cloud Settings
 Bambuser, BoxCast, Churchstreaming.tv, Dailymotion, DaCast Streaming Services, ESE 

Networks, Lightcast, Livestream, Meridix Live Sports Platform, Onstream media, Pitch-
time, SermonAudio, StreamingChurch.tv, StreamShark.io, StreamSpot, Streaming 
Media Hosting, Stretch Internet, Sunday Streams, Titled Globe, Tulix Streaming, 
Ustream, WebCast-TV, WorshipStream,

 Azure Media Services, Sermon.net, Verizon Digital Media Services.
 Brightcove, Limelight
 Akamai
 Twitter/Periscope
 Twitch
 Vimeo
 Wowza Streaming Engine.
 Zixi
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 Facebook Live
 Facebook Live - With User Code
 Microsoft Stream
 YouTube
 Streaming
 Record To Disk

Canvas Size
When Output > Canvas Size is selected, a drop-down menu with various canvas sizes is 
displayed allowing you to select the canvas size you want. You can also select Auto. This 
automatically sets the canvas size to the highest resolution that was selected when the 
encoder was chosen.

   

Note: Canvas size selection 1080p Anamorphic (1440x1080) is a narrower (1440) 
display stretched to display as 1080.

There is also a Custom option that enables you to set the canvas width and height.

Select Auto (optionally)

Select a custom size

Click Canvas Size

Select a canvas size

Set width and height



Broadcasting
Virtual Camera

221

Wirecast  can manage a wide variety of input sources, enabling you to have several live 
camera sources. However, really high-quality video sources can cause more harm than 
good. For example, an HD camera feed into a Wirecast  canvas that is set to HD 
resolution and then broadcast out in HD, requires a lot of work for the graphics 
processor. If the frame rate starts to drop but the CPU usage stays steady, it creates a 
bottleneck. The solution is to reduce the frame size going through Wirecast . Therefore, 
there is no need to bring input video in at HD resolution if Wirecast  is streaming out a 
lower resolution. 

Keep in mind that resizing down is good but resizing up reduces quality. As a rule, you 
should try to keep your resolution as constant as possible from source to output. There 
is no benefit from using an HD camera if you’re only broadcasting a low resolution 
stream. This only increases the work your computer must do without any increase in 
output quality.

Virtual Camera 
Wirecast enables you to present the output of Wirecast as if it were a camera (a virtual 
camera), allowing it to be automatically detected by other applications when they are 
launched. To setup Wirecast as a virtual camera, select Output > Virtual Camera Out, 
then select the output resolution to use. You can also select Match Canvas to cause the 
resolution to be the same as the current canvas size.

   

Start  Once you have selected an output resolution, select Start to make Wirecast 
output available to other applications on your computer.

Some of the applications Wirecast can work with using virtual camera are:

• Google+ Hangouts 

• Skype

• GoToMeeting

Select a resolution

Select Virtual Camera Out
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Flip Video Horizontally  When checked (selected) the Virtual Camera video is flipped 
horizontally.

DirectShow Audio  When selected, outputs DirectShow audio. 

Virtual Microphone When selected, enables you to present the audio output of 
Wirecast as if it were a microphone (a virtual microphone), allowing it to be 
automatically detected by other applications when they are launched.

Note: Virtual Microphone can only be installed during Wirecast installation.

Output Settings
To configure output settings select Output > Output Settings to open the Output 
Settings window.

When the dialog box displays, select a destination, then click OK.

       

You can also click More to display a list of all available destinations. Check the checkbox 
for each destination you want to include in the destination menu list.

         

Select Destination

Click OK

Check 
destinations to 
include them in 
Destination 
menu list
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The Output Settings window displays the destination you selected. Each destination 
window has a unique set of controls including a way to authenticate your connection.

        

Multiple Output Settings
Wirecast enables you to specify many output settings for your presentation. This means 
you may configure Wirecast to broadcast multiple data rates simultaneously, or even 
broadcast and record with different encoders at the same time. You can also broadcast 
to multiple RTMP Server destinations while recording to disk.

At the top of the Output Settings window is a list of the current settings. Uncheck the 
checkbox of any setting you want removed from your broadcast. You can add as many 
output settings as you need, but keep in mind that each additional destination will 
require more system resources.

Click the Gear icon to access actions that enable you to create reference movies you can 
distribute to your viewers. Each destination type provides a unique set of actions.

Configuration
There are two items to configure before broadcasting: Destination and Encoding.

When you broadcast with Wirecast, you must pre-configure at least one destination. A 
destination can be a broadcast server, content distribution network or local disk 
recording.

Each encoding preset uses a different broadcast technology (RTMP, Windows Media, 
etc.). The destinations described below depend on the Encoder Presets you have 
chosen.
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The Encoder determines how your presentation is encoded (or compressed). There are 
many options available. Wirecast simplifies this process by providing several simple 
presets to choose from. (See also The Encoder Presets Window).

Windows Media Destinations
Windows Media enables you to record your presentation to disk. You can do this 
whether or not you are broadcasting to a server. 

Encoder Presets
The Encoder menu is located near the top of the Output Settings window. The 
Destination menu is located above the Encoder menu. The More button and Gear 
menu provide optional settings.

       

More Click More to display a list of all available destinations. Check the checkbox for 
each destination you want to include in the destination menu list.

         

Encoding menu

More button

Destination menu

Gear menu

Check 
destinations to 
include them in 
Destination 
menu list
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Filter Select Filter from the Gear menu to display a check list of encoder presets. Check 
the presets you want to display in the Encoder presets menu. Click Save when finished.

     

New Preset Select New Preset from the Gear menu to create a new encoder preset. 
Enter a name for your new preset and click OK. (See Creating New Presets).

    

Check presets

Click Save

Enter name

Click OK
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View Details Select View Details from the Gear menu to modify an encoder preset. (See 
Creating New Presets). One important option is Strict Constant Bitrate. When checked, 
the bitrate is strictly held at the bitrate entered in Average bit rate.

     

More Click the More button to display a check list of destinations. Check the 
destinations you want to display in the Destination menu. Click Save when finished.

        

Check (optionally) 
Strict Constant bitrate

Check destinations

Click Save
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Windows Media Settings
Wirecast offers several default presets. The first choice you need to make is whether 
you'll be using RTMP Server, Windows Media, or some combination as the broadcast 
technology. This decision depends on what you expect your viewers to use. Given 
enough bandwidth, you can stream to combinations of RTMP Server, and Windows 
Media by adding new destinations to the output settings. Windows Media can be used 
to broadcast WMV8, WMV9 and WMV9 Advanced.

WM-Push To Server 
To access the WM-Push To Server window, select Output > Output Settings (or press the 
Ctrl+Y keys). From the encoder presets drop-down menu, select the Windows Media 
presets, and check the Push to Server checkbox.

To use Push To Server, you must have access to a Windows Media Server, either in your 
organization or hosted by an ISP (search the Internet for Streaming Windows Media 
Server to find one). This is the professional way of creating a stream because it places 
the bandwidth strain on the remote server. All you need is a good local connection to 
the internet to push to the Windows Media Server.

Configuration Settings
Address Enter the Internet address of the Windows Media Server you use to broadcast.

Publish Point Enter the name of the file that is put on the server, and that is used as 
part of the URL that your users use. Wirecast cannot know the resulting URL that your 
users use, as this may vary depending on the installation of the Windows Media Server. 
Contact your Windows Media Server administrator to understand how to build a 
proper URL for your viewers, based on the Publish Point.

Select  
Windows 
Media preset

Check Push 
to Server
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Auto Remove Check Auto Remove to remove the file used as the publish point when 
the broadcast is over.

Username/Password Enter the user name and password for the Windows Media 
Server. Contact your Windows Media Server administrator to obtain these. If there is no 
user name or password required, leave these fields empty.

WM-Pull From Server 
To access the WM-Pull From Server window, select Output > Output Settings (or press 
the Ctrl+Y keys). From the encoder presets drop-down menu, select any of the 
Windows Media based presets, and check the Pull From Server checkbox.

This option turns your local computer into a mini Windows Media Server, enabling you 
to broadcast immediately. There are, however, some limitations: 

1. User Requirement You cannot have more than 50 users connected at any one 
time.

2. Bandwidth Requirement You must have enough bandwidth on your Wirecast 
computer to supply all of your viewers.

3. CPU Requirement Since the Wirecast computer is acting as a server the CPU must 
be fast enough to handle all of the user connections.

The greatest issue with this method is bandwidth. If, for example, all of your viewers are 
on a local network (a business or school), then you should be able to use this method. 
However, if you have a DSL connection to the internet and you want to broadcast a 
200k stream to 20 viewers, you may not have enough upload bandwidth to 
accommodate this. 

Note: Be aware that when you use Wirecast with an internet connection what matters 
is your upload bandwidth. Most ISP businesses offer packages that have a higher 
download than upload bandwidth (e.g., a 512k DSL package is often only 256k 
upload).

Configuration Settings
To use the Network-Pull from Server option, set the port number that your users use to 
connect to your computer. They connect by using the Open URL option in Windows 
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Media Player, and enter a URL. For example, if your computer IP address is 10.0.5.55 and 
your port is 1755, use mms://10.0.5.55:1755.

Port Number Enter the port on your computer to use as the broadcast port. This can 
be, effectively, any port number as long as it doesn't conflict with any existing ports on 
your computer. Be aware that if you have any firewall software installed, you need to 
enable the port entered here.

Maximum Connections The maximum number of connections your server accepts is 
50 users. Your CPU is affected by the number of users you have connected, therefore 
you may need to limit the number of connections.

Multicast and Unicast
You can select Multicast or unicast from the Destination menu. Multicast lets you 
broadcast to multiple computers simultaneously. Unicast lets you broadcast to a 
specific computer.

Check Pull 
from Server

Select Multi 
or Unicast

Select Save 
SDP file
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You need to create an SDP File, and you must do so every time you change any option 
on this page (including the encoder preset). To create an SDP file click the gear icon and 
select Save SDP File, navigate to the desired location, and click Save in the Save File 
dialog window. The SDP file must be given to the user to place on the computer that 
receives your broadcast. 

During multicast, your broadcasting computer sends data across your local network, 
identifying it as a broadcast that it has no specific destination. Since many applications 
could be doing the same thing, the broadcasting computer must have a unique way of 
defining the data that is being multicast. This enables clients to choose between the 
available multicast streams.

The multicast protocol uses unique addresses, one for video and one for audio. 
Although these unique addresses look like TCP/IP addresses, they are not. Instead, they 
provide a way to define uniqueness among all multicast data flowing over the network. 
Once the broadcasting computer is streaming this data through the local network, any 
computer on the network can receive it.

The SDP file becomes the glue between your broadcast computer and the viewer 
computers. The SDP file contains multicast addresses, encoding format, and other 
important information.

RTMP Server
Wirecast can stream to an RTMP/ H.264-compatible streaming server (RTMP Server 
Media Server, Wowza Media Server, etc.).

To configure RTMP Server Streaming, follow these steps:

1. Select Destination > RTMP Server.

2. Select an encoder. 

3. Enter the Address to the RTMP server. The default RTMP port is 1935, but you may 
need to configure your firewall to allow connections on this port.

4. Wirecast can import a RTMP Server Encoder configuration file (XML file). Click Open 
FMLE XML File, and navigate to the configuration file and select either version 2.5 or 
version 3.0. Wirecast reads the Address and Stream information from that file. Many 
online streaming services offer FMLE configuration files which Wirecast can use.

Note: Only the Address and Stream information from the XML configuration file is 
used. No Encoding information is imported.
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5. Click OK to save your settings:

Telestream Cloud Settings
Note: Cloud-based streaming and distribution is available in Wirecast for an 
additional monthly subscription.  Visit the Telestream website for more information.

The Telestream Cloud enables you to add automated live captioning to your broadcast. 
But it also allows you to do “re-streaming” (multi-distribution of your broadcast 
through the Cloud).

When you request automated captioning, the Cloud server will send out the audio 
portion of your broadcast for translation into text. When the text is received, it is 
embedded as 608/708 captions in the outgoing stream.

When you request stream redistribution, the Cloud takes your single stream source 
received from Wirecast and distributes it to multiple endpoints in a high bandwidth 
environment.

Select a 
Destination

Enter the 
Address to the 
RTMP server

Select an 
encoder



Broadcasting
Telestream Cloud Settings

232

Cloud settings are accessed on the Output Settings window (Output > Output Settings). 
Click Telestream Cloud Settings to open the Cloud Settings window.

If you are not already Logged In to the Cloud, a Welcome window will display.  Log in by 
clicking Log In.  If you are not Signed Up with Telestream Cloud, you can do so by 
clicking Sign up.

Click to open Settings window

Click to open Settings window

Click Sign Up or Log In
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If you click Sign Up, a sign up window will display.  Enter all requested information and 
click Sign Up.

When the Activate Account window displays, wait until you receive your Activation 
Code via phone call or text.  Enter the activation code and click Activate my account.  If 

Enter information

Click Sign Up
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you do not receive an activation code, or if the code does not work, request a new one 
by clicking Resend Code.

Once you are logged in, clicking the Telestream Cloud Settings button will open the 
Cloud Settings window. 

For captioning, select a language. You can, optionally, enable live captioning.  

Note: When you check this option, all of your streaming destinations via the Cloud 
will include automatic live captions. 

For re-streaming, select Encoding for all destinations that are re-streamed via the 
Cloud. Click the Get More or the Manage Account button to navigate to the Telestream 
Cloud Dashboard. 

When you are ready to select multiple streaming destinations to be used by the Cloud, 
open the Output Settings window (Output > Output Settings) and select multiple 
streaming destinations by clicking the Add button. Check Enable for all destinations to 

Click Activate

Enter activation 
code received

Click Manage account

Check Live Captions

Select a language
Click Get More (optionally)

Select Encoding

Click Log Out
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be included in the Cloud streaming distribution. Click Telestream Cloud Settings to open 
the Cloud Settings window.

Note: When Enable is checked, Encoding is grayed-out.  This is because encoding for 
all distributed streams is set on the Cloud Settings page.

Click Add Check Enable

Click Telestream Cloud Settings 
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CDN Partners
Listed below are the Content Distribution Network (CDN) partner destinations available 
in Wirecast. Most destinations share a common user interface and only require a user 
name and password. Destinations that do not conform to this paradigm, or require 
additional parameters, are presented separately.

Note: The list of CDN partners in Wirecast is subject to change at any time. 

Bambuser, BoxCast, Churchstreaming.tv, Dailymotion, 
DaCast Streaming Services, ESE Networks, Lightcast,  
Livestream, Meridix Live Sports Platform,  Onstream media, 
Pitchtime, SermonAudio, StreamingChurch.tv, 
StreamShark.io, StreamSpot, Streaming Media Hosting, 
Stretch Internet, Sunday Streams, Titled Globe, Tulix 
Streaming, Ustream, WebCast-TV, WorshipStream, 

To stream to one of these CDN partners, follow these steps:

1. Optionally, enter a Name for your destination.

2. Select a CDN partner from the Destination menu.

      

3. You can (optionally) click the Map button to open the Muti-Track Input Mapper.  For 
each Channel, select (by checking the box) one or more inputs.

        

4. Enter your username or email.

5. Click Authenticate to enter your password and generate the RTMP URL. You only 
need to do this one time because Wirecast stores the channel information for 
future streams. The default RTMP port is 1935. You may need to configure your 
firewall to enable connections on this port.

Select 
Destination

Click Map 
(optionally)

Select an 
encoder 
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Note: If you do not have a username and password, you can sign up with a CDN 
partner by clicking Sign Up.

6. Select your channel.

7. Optionally, you can refresh your connection by clicking Refresh.

8. Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
0 to 999 seconds. However, greater delays require greater memory use. The amount 
of memory used is displayed when you enter the amount of delay.

9. Click OK when finished. 

   

Click Authenticate and 
enter password

Select Channel

Enter user name

Enter delay (optionally)

Click Refresh 
(optionally)
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Azure Media Services, Sermon.net, Verizon Digital Media 
Services. 

To stream to one of these CDN partners, follow these steps:

1. Optionally, enter a Name for your destination.

2. Select a CDN partner from the Destination menu.

3. Select an encoder. 

      

4. You can (optionally) click the Map button to open the Muti-Track Input Mapper.  For 
each Channel, select (by checking the box) one or more inputs.

        

5. Enter the domain name or IP address (this is provided by the CDN partner).

6. Enter the stream name of your broadcast (this is provided by the CDN partner).

Note:  If you do not have a stream name and password, you can sign up with the CDN 
partner by clicking Learn More.

7. Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
0 to 999 seconds. However, greater delays require greater memory use. The amount 
of memory used is displayed when you enter the amount of delay.

8. Click OK when finished.

        

Select 
Destination

Click Map 
(optionally)

Select an 
encoder 

Enter Stream 
name

Enter Address

Enter delay 
(optionally)
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 Brightcove, Limelight
To stream to one of these CDN partners, follow these steps:

1. Optionally, enter a Name for your destination.

2. Select a CDN partner from the Destination menu.

3. Select an encoder. 

      

4. You can (optionally) click the Map button to open the Muti-Track Input Mapper.  For 
each Channel, select (by checking the box) one or more inputs.

        

5. Enter the domain name or IP address (this is provided by the CDN partner).

6. Enter the stream name of your broadcast (this is provided by the CDN partner).

7. Click Set Credentials to enter your Username and Password. 

Note:  If you do not have a stream name and password, you can sign up with the CDN 
partner by clicking Learn More.

8. Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
0 to 999 seconds. However, greater delays require greater memory use. The amount 
of memory used is displayed when you enter the amount of delay.

9. Click OK when finished.

        

Select CDN

Click Map 
(optionally)

Select an 
encoder 

Enter Stream 
name

Enter Address

Click Set 
Credentials

Enter delay 
(optionally)
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Akamai 
To stream to Akamai, follow these steps:

1. Optionally, enter a Name for your destination.

2. Select Akamai from the Destination menu.

3. Select an encoder. 

      

4. You can (optionally) click the Map button to open the Muti-Track Input Mapper.  For 
each Channel, select (by checking the box) one or more inputs.

        

5. Enter your Akamai Stream ID and Event Name.

6. Enter your Akamai Angle and Video Rate.

7. Enter your user name and click Authenticate to enter your log in information.

Note: If you do not have a username and password, you can sign up with Akamai by 
clicking the Akamai icon, or by clicking Sign Up.

8. Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
0 to 999 seconds. However, greater delays require greater memory use. The amount 
of memory used is displayed when you enter the amount of delay.

Select Akamai

Click Map 
(optionally)

Select an 
encoder 
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9. Click OK. 

   

Click 
Authenticate 

Enter angle and 
video rate

Enter Stream ID 
and Event Name

Enter a user name

Enter delay 
(optionally)
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Twitter/Periscope
To stream to Twitter/Periscope follow these steps:

1. Optionally, enter a Name for your destination.

2. Select Twitter/Periscope from the Destination menu.

      

3. You can (optionally) click the Map button to open the Muti-Track Input Mapper.  For 
each Channel, select (by checking the box) one or more inputs.

        

4. Click Plus (+) to enter your username and password.

        

Select Twitter

Click Map 
(optionally)

Click  Plus (+) 
to Sign In
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5. Copy the Authorization Code and click on the link below it.

        

6. When the Authorization Code window displays, paste in the code and click 
Authorize.

      

Note: If the Authorization Code window does not display, or if an error window 
displays, try clearing your browser history or try using a different browser, and then 
sign in again.

7. Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
0 to 999 seconds. However, greater delays require greater memory use. The amount 
of memory used is displayed when you enter the amount of delay.

8. Click OK. 

Copy 
Authorization 
Code

Click on link

Enter delay 
(optionally)

Paste in code

Click Authorize
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Twitch
To stream to Twitch, follow these steps:

1. Optionally, enter a Name for your destination.

2. Select Twitch from the Destination menu.

3. Select an encoder. 

      

4. You can (optionally) click the Map button to open the Muti-Track Input Mapper.  For 
each Channel, select (by checking the box) one or more inputs.

        

5. Enter your Twitch username.

6. Click Authenticate to open the Twitch Log In window.

Note: If you do not have a username and password, you can sign up with Twitch by 
clicking the Twitch icon or by clicking Sign Up.

    

Select an 
encoder 

Select Twitch

Click Map 
(optionally)

Click 
Authenticate 
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7. When the Twitch Login window displays, enter your username and password and 
click Log In. 

    

8. Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
0 to 999 seconds. However, greater delays require greater memory use. The amount 
of memory used is displayed when you enter the amount of delay.

9. Click OK when finished 

    

Enter Username and 
Password

Click Log In

Enter delay 
(optionally)
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Vimeo
To stream to Vimeo, follow these steps:

1. Optionally, enter a Name for your destination.

2. Select Vimeo from the Destination menu.

3. Select an encoder. 

      

4. You can (optionally) click the Map button to open the Muti-Track Input Mapper.  For 
each Channel, select (by checking the box) one or more inputs.

        

5. Click Authenticate to enter your username and password.

    

Note: If you do not have a username and password, you can sign up with Vimeo by 
clicking Sign Up.

Select an 
encoder 

Select Vimeo

Click Map 
(optionally)

Click Authenticate 
and enter username 
and password
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6. When the Authorization window displays, click Allow.

    

7. Click the plus (+) icon to add a new event.

    

Click Allow

Click plus icon
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8. Enter your email and password, then press Enter.

    

9. Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
0 to 999 seconds. However, greater delays require greater memory use. The amount 
of memory used is displayed when you enter the amount of delay.

10. Click OK when finished 

    

Enter your email and 
password, press Enter

Click Done

Enter Stream Name

Enter Description

Enter delay 
(optionally)
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Wowza Streaming Engine. 
To stream to Wowza Streaming Engine, follow these steps:

1. Optionally, enter a Name for your destination.

2. Select Wowza from the Destination menu.

3. Select an encoder. 

      

4. You can (optionally) click the Map button to open the Muti-Track Input Mapper.  For 
each Channel, select (by checking the box) one or more inputs.

        

5. Enter the domain name or IP address (this is provided by the CDN partner).

6. Enter the stream name of your broadcast (this may be provided by the CDN 
partner).

7. Click Import Wowza Config to import a Wowza configuration to use.

8. Select User Agent. Default is Wirecast/FM1.0.

9. Click Set Credentials to enter your Username and Password.

Note:  If you do not have a stream name and password, you can sign up Wowza.

10. Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
0 to 999 seconds. However, greater delays require greater memory use. The amount 
of memory used is displayed when you enter the amount of delay.

11. Click OK when finished.

      

Select an 
encoder 

Select Wowza

Click Map 
(optionally)

Enter Stream name

Enter Address

Select User Agent

Enter delay (optionally)

Click to import config

Click Set 
Credentials
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Zixi 
To stream to Zixi, follow these steps:

1. Optionally, enter a Name for your destination.

2. Select Zixi from the Destination menu.

3. Select an encoder. 

      

4. You can (optionally) click the Map button to open the Muti-Track Input Mapper.  For 
each Channel, select (by checking the box) one or more inputs.

        

5. Enter Zixi connection information.

6. Enter your Zixi channel name and password.

7. Click Apply to generate the RTMP URL. You only need to do this one time because 
Wirecast stores the channel information for future streams. The default RTMP port 
is 1935. You may need to configure your firewall to enable connections on this port.

Note: If you do not have a username and password, you can sign up with Zixi by 
clicking the Zixi icon, or by clicking Sign Up.

8. Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
0 to 999 seconds. However, greater delays require greater memory use. The amount 
of memory used is displayed when you enter the amount of delay.

Select an 
encoder 

Select Zixi

Click Map 
(optionally)
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9. Click OK. 

    

Enter Zixi 
connection info

Click Apply

Enter Channel Name 
and Password

Enter delay 
(optionally)
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Facebook Live 
Note: You cannot stream to any other destination when Facebook is active. 

To stream to Facebook, follow these steps:

1. Optionally, enter a Name for your destination.

2. Select Facebook Live from the Destination menu (if not already selected).

3. Select an encoder from the Encoding menu. 

4. Choose the audio track to be used by selecting it from the Audio Track Selection 
menu.

      

5. You can (optionally) click the Map button to open the Muti-Track Input Mapper.  For 
each Channel, select (by checking the box) one or more inputs.

        

Note: If you change the encoding settings while streaming to Facebook, an error will 
occur. The encoder settings are set by Facebook.

6. Click Authenticate and Login to Facebook. If you are already logged into Facebook, 
you can click the Change button to login to a different Facebook account.

      

Note: If you do not have a username and password, you can sign up with Facebook 
by clicking the Facebook icon, or by clicking Sign Up.

Select an 
encoder 

Select 
Facebook Live

Click Map 
(optionally)

Click Authenticate 
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7. Select Go Live Now or Schedule for Later from the Post To menu.

      

8. If you selected Schedule for Later, select also a start date and a time.

      

9. Select Pages, Profile, Groups, or Events from the Post To destination menu. Click 
Refresh to refresh the page list. If planning to use co-branded content, check the 
Show verified pages only checkbox to filter out all non-verified pages. Enter a Title 
and a Description. Click Schedule of Facebook to refresh after changing any settings.

     

Note: When Scheduling events on Facebook you must start the broadcast within ten 
minutes after the designated start time. Otherwise, the event will be ended by 
Facebook.

Select Post 
To option

Select start date Select time

Select Post To destination

Click Schedule on Facebook

Enter Facebook  
information

Check show verified pages only
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10. After you request Facebook to schedule your event, Wirecast will display a notice 
verifying the day and time of the event.

       

11. Once your event is scheduled, the event date and time are displayed and you can 
update or delete the event.  You can also click Show Facebook Post to display your 
event in a browser.

      

• Update Event If you selected a previously scheduled event from the Schedule 
menu, you change the Date, Time, Title, and Description and click Update Event.

• Delete Event If you wish to delete a previously scheduled event, select that event 
from the Schedule menu and click Delete Event.

Event date 
and time

Click to delete event

Click to update event

Click to show 
Facebook post
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12. If you selected Go Live Now, select also Pages, Profile, Groups, or Events and ebter a 
Title and Description (as described in step 9 above). Optionally, click Advanced 
Options.

      

13. When the Advanced Settings window displays, setup co-branding details and 
Stream Type.

      

• With Facebook permits users with a verified page (blue check mark) to select a 
sponsor for branded content within their posts. When the user selects a verified 
page, they will see a blue check mark badge next to the page selection menu and 
gain access to the With field. Typing in the With field brings up the same results as 
you might see when following a normal browser based workflow. Branded content 
is only supported for Pages and is disabled for Groups and Events. Additional infor-
mation about Branded content restrictions can be found at: 
   https://developers.facebook.com/docs/graph-api/advanced/branded-content.

• Stream Type Select a stream type: Regular or Ambient. Ambient generates a con-
tinuous live stream of unlimited duration.

Click to show 
Facebook post

https://developers.facebook.com/docs/graph-api/advanced/branded-content
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14. If you selected to post to a Profile, select also a level of Privacy: Public, Friends, or 
Only Me.  Enter also any Places information to put the live stream on the Facebook 
Live Map and enable everyone to see where people are streaming from.

      

15. The places map looks like this:

      

Select Privacy 
and Places
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16. Click Create to start an event on Facebook.

      

17. Click OK when finished. 

Click Create
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Facebook Live - With User Code 
Facebook Live - With User Code enables you to stream to Facebook without needing to 
know the account password to log in to Facebook. The only interaction (after output 
settings is set up) is to begin the streaming in Wirecast, at which point Facebook 
detects the Wirecast stream and enters the preview mode.

This is a "set and forget" process. Once you have setup and established connection with 
a Facebook Encoder, the output settings never need to be re-entered. Each time a 
stream is initiated, the authentication from the account is retrieved and saved in the 
Wirecast settings, and a new broadcast is searched sought.

To stream to Facebook with User Code, follow these steps:

1. Sign In to the Facebook account you want to access.

2. In Wirecast, select Output > Output Settings. Then select Facebook Live - with User 
Code.

      

3. Optionally, enter a Name for your destination.

4. Select Facebook Live - with User Code from the Destination menu (if not already 
selected).

5. Select Automatic in the Encoding menu.  

Note: Selecting Automatic sets the target bitrate and encoding size based on your 
canvas. Wirecast sends your canvas size to Facebook which responds with the 
preferred width, height and bandwidth to use for that size canvas. 

Also, in restricted bandwidth situations it is recommended that you choose a preset 
with the desired bitrate for your actual bandwidth.

Select Facebook Live 
- with User Code
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6. Choose the audio track to be used by selecting it from the Audio Track Selection 
menu.

      

7. You can (optionally) click the Map button to open the Muti-Track Input Mapper.  For 
each Channel, select (by checking the box) one or more inputs.

        

8.  Select your Facebook account from the drop-down menu, then click the Plus 
button (+) to start the pairing process with a Facebook user.

 

      

Select 
Automatic 

Select 
Facebook

Click Map 
(optionally)

Click the Plus 
button

Select FB 
account
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9. Copy the user code obtained from Facebook, and click on the link provided.

 

      

10. When the Facebook window displays, paste in the User Code and click Continue.

      

11. Facebook will display a Success window when the code is accepted.

      

12. Wirecast displays a “Loading” paired encoders message while it searches to see if it 
is registered as an encoder with Facebook. Once Wirecast is properly registered as 

Copy User Code

Click Link

Paste in User Code Click Continue
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an encoder for the account, it starts “Checking” to find the broadcast (live video) 
where it is set as the encoder.

      

13. On Facebook, select Paired Encoder, set the Live Encoder to Wirecast, and then click 
Connect.

      

Select Paired 
Encoder Click ConnectSelect Wirecast
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14. If Encoding is set to Automatic, Wirecast searches for the live video broadcast from 
Facebook.  When found, Wirecast displays the server URL along with the stream key 
of the paired account. Click OK to close the Output Settings window.

      

Note: In low bandwidth situations, you may choose an Encoding Preset other than 
Automatic. The stream URL will still be automatically determined, but the specified 
encoder preset is used instead of Automatic.

15. In Wirecast, begin streaming to Facebook by clicking the Streaming icon.

      

Server URL Stream Key

Click Streaming icon
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16. When Facebook displays the Preview screen, click Go Live.

      

Note: Expect a 5-20 second lag between Wirecast output and what is seen on 
Facebook.

Click Go Live
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17. When Go Live is clicked, Wirecast detects this and automatically sends an OnGoLive 
message back to Facebook. This is what actually publishes the live video over 
Facebook. Facebook then displays the live broadcast with the elapsed time. Click 
End Broadcast to end the Facebook broadcast. 

      

18. When Facebook displays the “video has ended” window, click Done. Wirecast will 
detect this automatically and will stop streaming.

      

If you stop streaming from Wirecast by re-clicking the Streaming icon, the Facebook 
broadcast remains live and keeps looking for the feed from Wirecast.  If you re-start 
streaming from Wire cast (by re-clicking the Streaming icon again), Facebook will restart 

Click End Broadcast

Click Done
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its streaming. However, if you do not re-start streaming from Wirecast, Facebook will 
eventual time out and end its broadcast.

Microsoft Stream
In order to broadcast using Microsoft Stream, you must first configure your streaming 
using Office 365.  For a detailed procedure on how to do this visit the Telestream 
website at: 

https://support.telestream.net/s/article/Wirecast-10-Publish-to-Microsoft-Stream

When the Output Settings window displays, select Microsoft Stream as your 
Destination and click OK.

When the Output window displays, select an Encoder and Audio Track for you stream.  
Paste in the address copied from Office 365 where streaming was initiated.   Optionally, 
enter a Stream Delay if needed.  Click Ok when finished.

You can also click the Map button to open the Muti-Track Input Mapper.  For each 
Channel, select (by checking the box) one or more inputs.

Click OK when finished.

Click OK

Select Microsoft 
Stream

Select Microsoft 
Stream

Select Audio Track

Paste in Address

https://support.telestream.net/s/article/Wirecast-10-Publish-to-Microsoft-Stream
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YouTube
Note: Custom encoders cannot be used to stream to YouTube. They may only be used 
to encode a recording to disk.

To stream to YouTube, follow these steps:

1. Log into your YouTube account using your browser.

2. Optionally, enter a Name for your destination.

3. Select YouTube from the Destination menu.

4. Select an encoder. 

      

5. You can (optionally) click the Map button to open the Muti-Track Input Mapper.  For 
each Channel, select (by checking the box) one or more inputs.

        

6. Check (optionally) Automatically Start Event to automatically start your event on 
YouTube when you start streaming. Click the plus (+) icon to add a new event. 

  

Note:  If you do not have a YouTube account, click Sign Up (or go to 
www.youtube.com).

Select an 
encoder 

Select 
YouTube

Click Map 
(optionally)

Click plus icon

Check Auto Start 
(optionally)

www.youtube.com
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7. Enter all of your event information and click Save.

8. Click Authenticate, enter your login information, and wait for your event to appear 
in the Event menu box. Click the minus icon (-) to remove a selected event. 
Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
0 to 999 seconds.  Click OK when finished.

Note: If you are not already signed in, a browser with  is launched enabling you to 
sign into your YouTube account. Enter your account information and click Sign In.

Streaming
Click the Stream button to start streaming.

        

Click Save

Enter event info

Click 
Authenticate

Wait for event 
to appear

Enter a 
stream delay 
(optionally)

Click minus 
(-) to remove 
an event

Click the Stream button
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The Stream icon will blink until a connection is made. Once you are connected the 
Stream icon turns green. If you cannot connect an error message will display. 

        

Connection strength is indicated by how many bars are displayed in the Stream icon. 
Fewer bars indicates a weaker (slower) connection.

        

If the connection is ever broken, a no connection icon is displayed in place of the bars.

        

When the connection recovered, the no connection icon is replaced with the green bars.

Click Stream again to stop streaming. You can also record your broadcast by clicking 
Record.   

        

While streaming, status is displayed.

       

If you are streaming to Facebook, additional status is displayed on the right side of the 
status bar.

         

Green Stream icon

Green connection 
strength bars

No connection icon

Streaming 
time

Recording 
time

ISO Recording 
time

CPU usage

Frame rate
Streaming rate

Various 
reactions

Number of 
viewers
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If you are streaming via the Cloud, additional status is displayed on the right side of the 
status bar.

         

Note: Cloud-based streaming and distribution is available in Wirecast  for an 
additional monthly subscription.  Visit the Telestream website for more information.

Wirecast attempts to reconnect. Each time reconnection is attempted, the stream icon 
will blink. The number of reconnection trys is set in the General Preferences (Select 
File>Preferences, then click the General tab).

   

Record To Disk
If you want to archive your stream, you can use the Record To Disk destination.

Note: Wirecast auto-saves your Stream/recording. All formats (WMV, MOV, MP4) will 
be recoverable in increments of 20 seconds. Any recording less than 20 seconds is 
corrupted. ISO also recovers. In the case of an unexpected shutdown, the recoverable 
video is available in increments of one minute.

To record to disk, follow these steps:

1. Click the Record button at the top of the Wirecast Main window. 

    

Cloud icon Cloud status

Set retrys

Click Record
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2. When the Output window opens, click the Add button at the bottom of the window 
to add a recording destination

        

3. When the dialog box displays, select Record to Disk and click OK.

        

4. In the Output Settings window select Record To Disk (for MP4 or Windows Media, 
MOV)

5. Select an encoder.

6. Click Browse or enter the path to where you want your recording located.

7. Select the recording mode: Use Filename Only, Auto Increment Filenames, or 
Timestamp Filenames. If you select Auto Increment Filenames, your filename will 
have an incremental number appended to the end of it. This causes a new file to be 
created every time you start recording to disk, otherwise your previous file is 
overwritten (if you have selected Use Filename Only).

8. Click OK.
 

     

Click Add

Select Record to Disk

Click OK

Enter filename 
or navigate to 
file Location

Select recording 
mode

Select Record To Disk

Select an encoder

Click OK
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Note:  When recording to disk on FAT32 formatted drives, single files cannot be larger 
than 4GB in size. So, recording to disk on a FAT32 formatted drive may result in files 
that do not close properly if they exceed 4GB in size. It is recommended that you 
record to disk on a Windows NTFS formatted partition whenever possible.
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Encoder Presets

Introduction
Wirecast supports a wide variety of encoders (also known as codecs).

An encoder is a program that compresses the audio and/or video output of Wirecast for 
broadcast. Without an encoder, the uncompressed data is too large to successfully 
broadcast across a network. This is why encoders are so important.

The settings for encoders range from simple to very complex. Because of this, Wirecast 
offers presets of the most common settings for encoders. This provides a starting point, 
reduces complexity, and enables you to experiment and adjust settings as you test your 
broadcast.

Note: Encoder Presets can also be edited from the Output Settings window. To do 
this select Output > Output Settings, click the gear icon, then choose View Details from 
the drop-down menu.

Topics
 The Encoder Presets Window

 Windows Media Streaming

 MainConcept H.264

 x264
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The Encoder Presets Window
To open the Encoder Presets window, select Window > Encoder Presets. The Encoder 
Preset menu at the top of the window provides a list of encoder presets. Select a preset 
to edit.

     

Select an 
encoder preset
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Creating New Presets
The default encoder presets cannot be changed. However, you can make a copy of any 
preset, modify it as needed, and save it under a new name. You can refer back to the 
default presets at any time since they are never modified.

To create a new preset, you must make a copy of an existing preset. To do this, select an 
existing preset from the Encoder Presets menu that is close to what you need, change 
settings as needed, then click Save As to save the preset with a new name.

    

Profile Options
Many encoder presets enable you to select one of three profiles: Baseline, Main, or 
High.

Baseline Profile (BP) Baseline profile is primarily for low-cost applications that require 
additional data loss robustness. This profile is used in some video conferencing and 
mobile applications. It includes all features supported in the Constrained Baseline 
Profile, plus three additional features used for loss robustness (or for other purposes 
such as low-delay multi-point video stream compositing). The importance of this 

Select an 
encoder preset

change 
settings

Save as new 
encoder preset
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profile has faded somewhat since the definition of the Constrained Baseline Profile in 
2009. All Constrained Baseline Profile bitstreams are also considered to be Baseline 
Profile bitstreams, since these two profiles share the same profile identifier code value.

Main Profile (MP) The Main profile is used for standard-definition digital TV broadcasts 
that use the MPEG-4 format as defined in the DVB standard. It is not, however, used for 
high-definition television broadcasts, since the importance of this profile faded when 
the High Profile was developed in 2004 for that application.

High Profile (HiP) The High profile is the primary profile used for broadcast and disc 
storage applications, particularly for high-definition television applications. For 
example, this profile is used by the Blu-ray Disc storage format and the DVB HDTV 
broadcast service.

Windows Media Streaming
To modify a Windows Media encoder preset, follow these steps:

1. Open the Encoder Presets window

2. Select a Windows Media preset from the Encoder Presets menu.

3. Check the Video checkbox and select the Windows Media codec version to use.

4. Check the Audio checkbox and select the Windows Media codec version to use.

5. Use the Multiple Streams Panel (left side of window) to set up multiple 
simultaneous streams in a single encoder. This allows the media player receiving 
the stream to adjust it's quality depending on the connection speed and reliability. 

Multiple Streams 
Panel

Select a Windows 
Media preset
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The plus and minus buttons at the bottom enable you add or remove additional 
streams to your preset.

6. Select the Audio Format. This is a pre-configured audio encoder setting.

7. Enter the Video Size. This sets the width and height of your resulting broadcast. 
Every stream should have the same aspect ratio. For example, if 640x480 is used, it 
has an aspect ratio of 4:3. Therefore, all other streams should also have a 4:3 aspect 
ratio.

8. Enter the broadcast frame rate in frames per second (fps). This is a target rate and is 
only a goal for the encoder. It is not a guaranteed value. 

9. Enter the Key Frame Interval in seconds. This controls how often the encoder makes 
a new keyframe. The more keyframes your broadcast has, the more bandwidth it 
takes (since less compression can occur). However, more keyframes means motion 
in your video stream is better supported.

10. Enter the bit rate in Kbits (1000 bits) per second. This is a target setting for the 
encoder, not a guaranteed value. Higher numbers provide better quality - lower 
numbers, lower quality. The connection speed of your audience is a significant 
factor in determining your target bit rate. 

11. Set the smoothness using the slider. Video smoothness determines the trade-off 
between sharp images and smooth motion. Video appears smooth when objects 
move across the screen with non-jagged object edges. If you are dropping frames 
during encoding, consider decreasing video smoothness.

12. Select Complexity. Some video codecs support multiple complexity levels. 
Complexity level does not directly affect the bit rate of a stream, but it can affect its 
quality. Complexity level is a measure of the processing power needed to 
reconstruct the compressed data.

13. Enter the buffer size. The bit rate and quality depends on the buffer size. A larger 
buffer size enables more bits to be allocated for complex video. For example, if you 
set the buffer size to 10 seconds, the codec may choose to allocate some bytes to 
the first 8 seconds and the rest during the last 2 seconds. Increasing the buffer 
typically improves overall quality. For lower bit rates, it is recommended to increase 
the buffer size. For higher bit rates, increasing the buffer size has less effect. 
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MainConcept H.264
To modify a MainConcept H.264 preset, follow these steps:

1. Open the Encoder Presets window.

2. Select the MainConcept H.264 encoder preset from the Encoder menu.

     

Note: To use a newly created preset (See Creating New Presets).

3. Check the Video Encoding checkbox. When checked, the video for your broadcast 
is encoded. When unchecked, a blank video screen is provided. This is the preferred 
method of producing audio-only broadcasts.

4. Enter the Width of your broadcast video.

5. Enter the Height of your broadcast video.

6. Select the desired frames per second (fps) of your broadcast. This value is a target 
value for the encoder and the exact value is not guaranteed.

7. Enter the average bit rate in Kbits (1000 bits) per second. This is the target bit rate of 
your video. Higher numbers provide better quality. The connection speed of your 
audience is a significant factor in determining your target bit rate. The encoder 
compresses the video to approximate this target. However, at different times 
during your broadcast the bit rate may be higher or lower than the target rate.

8.  Select an encoder profile from the Profile menu. Three profiles are provided: 
Baseline, Main, and High. The Baseline profile is commonly used in mobile 
applications. It is also used in other applications which operate with limited 

Select Main 
Concept H.264
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processing power, storage capacity, and/or bandwidth. The Main profile is 
appropriate for general-purpose applications of broadcast media, such as high-
bandwidth Internet broadcasting. The High profile provides the highest broadcast 
quality encoding.

9.  Key Frame (optionally) allows you to enter the number of frames. A movie is a 
sequence of images and each image is called a frame. To compress video data, 
most encoders take a frame and make it a reference (also known as a key). This 
keyframe is sent as part of the broadcast, and all of the data after that keyframe is 
relative to it. The benefit of this is that the compressor only needs to send what has 
changed since the last keyframe. The main drawback of this is that over time it 
becomes harder for the encoder to distinguish the frame-difference information, 
especially if there is a lot of motion in the video. Another drawback is if your 
viewer’s computer misses a keyframe, the video is distorted until the next keyframe 
is sent. However, you can control how often the encoder makes a new keyframe by 
setting the number of frames. The more keyframes you broadcast, the more 
bandwidth required and less compression, but results in better quality video.

10.  Check (optionally) the Timecode Every checkbox and enter the number of frames 
between timecodes. Wirecast can generate timecodes embedded in the flash 
stream. If a frames value of zero is entered, the timecode is never sent. Wirecast 
sends metadata along with the frames. This data looks like an ONFi call. Various 
timecodes and timestamps are also sent with the stream.

11. Check (optionally) Strict Constant Bitrate. When checked, it forces the Average bit 
rate (see item 8 above) to maintain the exact bit rate entered. CBR pads the data 
(when necessary) to meet exact bitrate specified. Disabling CBR can result in 
slightly improved quality and decrease file size, but at the cost of greater bitrate 
fluctuations which could prove troublesome for certain streaming destinations. 
Selecting this option for recording is not recommended because it can result in 
decreased quality and larger files, with no real benefit.

12. Check (optionally) Keyframe aligned.   When checked, it facilitates adaptive bitrate 
streaming by ensuring that keyframes from multiple streams are in sync, along with 
the keyframes timestamp, DTS and PTS values. But this is true only if those other 
streams also have the option turned on and have the same keyframe interval. To 
accomplish this, Wirecast disables scene detection and manually inserts the 
keyframe at the exact keyframe interval specified. Therefore, to ensure quality and 
smooth switching in the player, the keyframe interval should be in the 1 to 4 
second range. When Keyframe Aligned is enabled, absolute timestamp is also 
enabled.

13.  Check (optionally) the Audio Encoding (AAC) checkbox. When checked, the audio 
for your broadcast is included. When unchecked, audio is absent. This is the 
preferred method of producing video-only broadcasts because the presence of 
silent audio uses bandwidth.

14.  Select the number of channels: Mono or Stereo. Mono uses less bandwidth than 
stereo, but stereo is more pleasing to the listener.

15.  Select the audio bit rate, in Kbits (1000 bits) per second, from the Target Bit Rate 
menu. This is the target bit rate of your audio. Higher numbers provide better 
quality. The connection speed of your audience is a significant factor in 
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determining your target bit rate. The encoder compresses the audio to 
approximate this target. However, at different times during your broadcast the bit 
rate may be higher lower than the target rate. The total broadcast bit rate is a 
function of video bit rate plus audio bit rate.

16.  Select the audio sample rate, in kHz (1000 Hz) per second, from the Sample Rate 
menu. This value specifies how many thousands of times per second to sample the 
audio in the broadcast. Higher values provide better quality sound, but at greater 
bandwidth.

17.  Click Save to save your settings.

x264
Note: The x264 implementation of the H.264 standard results in better quality and 
lower CPU usage for any given bitrate, but at the cost of higher memory usage. The 
default implementation is based on the MainConcept codec and uses less memory.

To modify an x264 preset, follow these steps:

1. Open the Encoder Presets window.

2. Select an x264 from the Encoder menu.

Note: To use a newly created preset (See Creating New Presets).

Select x264
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3. Check the Video Encoding checkbox. When checked, the video for your broadcast 
is encoded. When unchecked, a blank video screen is provided. This is the preferred 
method of producing audio-only broadcasts.

4. Enter the Width of your broadcast video.

5. Enter the Height of your broadcast video.

6. Select the desired frames per second (fps) of your broadcast. This value is a target 
value for the encoder and the exact value is not guaranteed.

7. Enter the average bit rate in Kbits (1000 bits) per second. This is the target bit rate of 
your video. Higher numbers provide better quality. The connection speed of your 
audience is a significant factor in determining your target bit rate. The encoder 
compresses the video to approximate this target. However, at different times 
during your broadcast the bit rate may be higher or lower than the target rate.

8. Select encoding quality (Ultra fast to Very slow encoding). Slower encoding results 
in better quality.

9. In the x264 command line options edit box, enter any command line options you 
want included.

10.  Select an encoder profile from the Profile menu. Three profiles are provided: 
Baseline, Main, and High. The Baseline profile is commonly used in mobile 
applications. It is also used in other applications which operate with limited 
processing power, storage capacity, and/or bandwidth. The Main profile is 
appropriate for general-purpose applications of broadcast media, such as high-
bandwidth Internet broadcasting. The High profile provides the highest broadcast 
quality encoding.

11. Key Frame (optionally) allows you to enter the number of frames. A movie is a 
sequence of images and each image is called a frame. To compress video data, 
most encoders take a frame and make it a reference (also known as a key). This 
keyframe is sent as part of the broadcast, and all of the data after that keyframe is 
relative to it. The benefit of this is that the compressor only needs to send what has 
changed since the last keyframe. The main drawback of this is that over time it 
becomes harder for the encoder to distinguish the frame-difference information, 
especially if there is a lot of motion in the video. Another drawback is if your 
viewer’s computer misses a keyframe, the video is distorted until the next keyframe 
is sent. However, you can control how often the encoder makes a new keyframe by 
setting the number of frames. The more keyframes you broadcast, the more 
bandwidth required. The result is less compression but better quality video. 

12. Check (optionally) Strict Constant Bitrate. When checked, it forces the Average bit 
rate (see above) to maintain the exact bit rate entered. CBR pads the data (when 
necessary) to meet exact bitrate specified. Disabling CBR can result in slightly 
improved quality and decrease file size, but at the cost of greater bitrate 
fluctuations which could prove troublesome for certain streaming destinations. 
Selecting this option for recording is not recommended because it can result in 
decreased quality and larger files, with no real benefit.

13. Check (optionally) Keyframe aligned.   When checked, it facilitates adaptive bitrate 
streaming by ensuring that keyframes from multiple streams are in sync, along with 
the keyframes timestamp, DTS and PTS values. But this is true only if those other 
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streams also have the option turned on and have the same keyframe interval. To 
accomplish this, Wirecast disables scene detection and manually inserts the 
keyframe at the exact keyframe interval specified. Therefore, to ensure quality and 
smooth switching in the player, the keyframe interval should be in the 1 to 4 
second range. When Keyframe Aligned is enabled, absolute timestamp is also 
enabled.

14.  Check (optionally) the Timecode Every checkbox and enter the number of frames 
between timecodes. Wirecast can generate timecodes embedded in the flash 
stream. If a frames value of zero is entered, the timecode is never sent. Wirecast 
sends metadata along with the frames. This data looks like an ONFi call. Various 
timecodes and timestamps are also sent with the stream.

15.  Check (optionally) the Audio Encoding (AAC) checkbox. When checked, the audio 
for your broadcast is included. When unchecked, audio is absent. This is the 
preferred method of producing video-only broadcasts because the presence of 
silent audio uses bandwidth.

16.  Select the number of channels: Mono or Stereo. Mono uses less bandwidth than 
stereo, but stereo is more pleasing to the listener.

17.  Select the audio bit rate, in Kbits (1000 bits) per second, from the Target Bit Rate 
menu. This is the target bit rate of your audio. Higher numbers provide better 
quality. The connection speed of your audience is a significant factor in 
determining your target bit rate. The encoder compresses the audio to 
approximate this target. However, at different times during your broadcast the bit 
rate may be higher or lower than the target rate. The total broadcast bit rate is a 
function of video bit rate plus audio bit rate.

18.  Select the audio sample rate, in kHz (1000 Hz) per second, from the Sample Rate 
menu. This value specifies how many thousands of times per second to sample the 
audio in the broadcast. Higher values provide better quality sound, but at greater 
bandwidth.

19.  Click Save to save your settings.

20.
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Making Great
Broadcasts

Introduction
These topics provide helpful information about how to prepare for creating great 
presentations.

Topics
 Overview

 High Quality Audio

 Good Lighting

 Broadcast Settings

Overview
There are many ways to make a good live event even better. But this appendix focuses 
on two main things to remember about video streaming: 

• High Quality Audio Input Great looking video with poor audio input appears 
unprofessional. 

• Good Lighting Poor lighting can ruin an otherwise excellent live event. If you are 
doing chroma keying, this may become the most important part of your setup. 

When video is saved to disk or sent over the network, it needs to be compressed. The 
compression process is done by encoders (codecs) which are optimized to work with 
clean input data. This means that if the audio or video is muddy to start with, it remains 
muddy after compression. Some codecs may even highlight poor input because the 
algorithm is built to look for differences.

Your goal should be to give the best possible quality audio and video to the 
compression process as possible. This means making sure what you see in the Live area 
is the best possible quality because Wirecast takes exactly what you see and sends it to 
the codecs.



Making Great Broadcasts
High Quality Audio

284

High Quality Audio
Audio has an artistic aspect to it. You can make a great live event even better by 
remembering to focus on a few details. Here are some suggestions on producing clean 
audio.

• Use a Good Microphone Though this may sound obvious, a good microphone can 
make a huge difference. Most DV cameras have an audio input for an external 
microphone. Use this, whenever possible, instead of the built-in microphone that 
comes with the camera. Built-in microphones are usually not good quality and tend 
to pick up hum from the electronics inside the camera. Even when it is not a great 
microphone, an external microphone almost always sound better.

• Use a Microphone Splitter If you are doing an interview with one camera, you can 
use two microphones with a splitter (less than $5). This often gives better results 
than one omni-directional microphone at a distance. You can also use a dual lapel 
microphone with a splitter.

• Position the Microphone Properly Place any microphone as close to the sound 
source as possible, even when using omni-directional microphones, because sound 
volume decreases greatly the farther away the microphone is placed. Stronger sig-
nals coming into the microphone results in better quality.

• Use Lapel Microphones Even inexpensive (less than $20) lapel microphones can 
make a huge difference because it places the microphone much closer to the per-
son speaking.

• Control Environmental Noise If a chair squeaks, use a different one. If you have a 
wood floor and you can hear people shuffling their feet as they talk, put down a 
rug. Do whatever it takes to keep noise at a minimum. Microphones pick up every-
thing.

Good Lighting
Do not underestimate the power of lighting. When an event is shot outdoors, a great 
deal of attention goes into lighting. For professionals, lighting is viewed as an artistic 
task. Many people make their living controlling lighting, so there is a lot to it. Here are a 
few suggestions to help you obtain reasonably good lighting:

• If you are using only one lighting source, do not shine it directly on your subject. 
You should diffuse the light by bouncing it off of a wall or by shining it through 
opaque material.

• Avoid deep shadows. Make sure you fill all areas of your subject with light. Some-
times this requires adjusting the light to bounce off a different wall or use two 
lights. Placing a light low and another one high is often a good way to light evenly.

• Do not light too evenly. If you evenly light a set, you may actually be worse off than 
not lighting the set at all. Take a sample shot and see if it looks natural. Good light-
ing usually has a little more light coming from above than any other direction. You 
should very rarely light just from below a subject.
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• Beware of having too much light on your subject. If your subjects are people and 
you must use a lot of light, use make-up to compensate for the overly bright light-
ing. This is not necessarily a bad thing, but you must choose how much effort you 
want to go through to make a good live event. If your lighting balance is excellent, 
you can avoid using make-up on your subjects. The key in adjusting the lighting is 
to look at your subject and make sure they do not look washed out.

• Watch professional events and learn from them. As you watch, notice the lighting 
instead of watching the program. Notice how they employ the suggestions listed 
above.

These guidelines might seem to suggest subtle improvements, but good lighting can 
make an amateur video look professional and a professional video look fabulous. The 
important thing to remember is that one or two properly placed lights makes a huge 
difference in the quality of your live event. 

Triangular Lighting
One advanced and very effective approach to good lighting is known as triangular 
lighting (or three light setup). Although this may sound complicated, it is actually quite 
simple. It involves setting up three lights (sometimes using natural light as one of the 
light sources), in a configuration that achieves a good balance. Here are the main 
elements of Triangular Lighting:

• Main Light (Key Light) This is the strongest of your lights and does most of the 
work. This light normally comes from one side of the camera (the left, for example) 
and is slightly raised. However, using just the main light results in shadowing.

• Fill Light This is a soft light placed directly in front of the subject. It removes shad-
ows and fills in the image. It is usually direct and usually comes from the same 
direction as the camera (or just to the side and behind it). It could be, for example, 
placed on the same level as the head of a person you are lighting. If you use only a 
fill light, your subject might appear too dark. The only purpose of a fill light is to add 
to the main light by filling in shadows. If your key light comes from the left of your 
camera, your fill light should come from the right, and vice versa.

• Back Light (Rim Light) This light is directed from behind the subject and above it. 
This is the hardest light to explain, but the best way is to describe it as an accent of 
your subject. If you look at a typical high school yearbook picture, you will notice 
that the top-left (or top-right) part of each head shot has a highlight of light in it. 
This light is the back light. It is also called a rim light because it makes a slight rim 
around the edge of the head of your subject. This light normally comes from 
behind and above the subject, and it is focused. Make sure it is not directed at the 
camera.

Most serious lighting starts with these three basic lights. There are also some great 
Websites that describe these techniques in great detail.
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Broadcast Settings 
Once you have good video and audio coming into Wirecast, the final item of 
importance is make sure the Broadcast Settings are configured correctly for your 
presentation. Though there are many broadcast parameters to modify, there are three 
that are the most important: bandwidth, motion, and encoder settings.

Bandwidth
The first item of importance is knowing how much bandwidth is available. Bandwidth is 
how much data you can broadcast from your computer. This depends on the speed of 
your network connection and the type of connection your viewers are using. More 
specifically, it is the minimum speed between you and all of your viewers.

Thus, you must know who your viewers are and what kind of connection they have. 
This may be difficult to know because you must determine if their connection is cable 
modem or DSL and whether or not they reside on your local network.

In some situations, you are broadcasting for just your local network (in an office 
building, for example). In this case you should discuss your plans with your network 
administrator and verify that you will not disrupt the network with your broadcasts. Ask 
them what your upper limit bandwidth should be. Your available bandwidth is the 
minimum of what you can upload, combined with what your viewers can download.

Motion
Once you know your bandwidth, you need to decide whether or not your video 
contains a lot of motion. Motion is how much things move around in your video 
presentations. An interview is considered low motion. A sports event, however, would 
probably be high motion. Wirecast comes configured with defaults to help ease your 
configuration task. Choose a default configuration that meets your motion (and 
bandwidth) constraints.

Encoder Settings
The parameters of the encoders are quite technical and can be overwhelming. It is 
beyond the scope of this document to describe the delicate balance required in setting 
them. There are professionals who fine-tune encoders to do exactly what is required. 
The Wirecast default settings are generally optimal for the various network 
environments. (See Encoder Presets for information on changing the encoder settings.)
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Overview
Portions of this software may utilize the following copyrighted material, the use of 
which is hereby acknowledged:

Steinberg VST Plug-In SDK Licensing Agreement 
(Version "3.6.6- 17.06.2016")

OBJECT OF THE AGREEMENT

1.The object of this agreement consists of the Steinberg VST PlugIn Software 
Development Kit version 3.6.6 respectively any preview version of this Kit, comprising 
of documentation, example code, and several PlugIn examples. These are described 
hereinafter as the "Licensed Software Developer Kit". 

2.In case a preview or beta version of the Licensed Software Developer Kit is provided, 
the Licensee is allowed to use the Licensed Software Developer Kit solely for internal 
evaluations. Any publishing, distribution or transfer to a third party is not permitted. 

3.Steinberg is the holder of all copyrights, rights of ownership, and other rights 
concerning the Licensed Software Developer Kit. 

4.The Licensed Software Developer Kit contains information about how to develop a 
Product, and how to extend an application so that it can host VST PlugIns, that are 
developed under the VST PlugIn Specification, either by Steinberg or any Third-Parties. 

Currently the Licensed Software Developer Kit is running on the following computer 
platforms: Apple Macintosh Computers under the Mac OS 10.8, 10.9, 10.10, 10.11 (32 
and 64bit) Windows 7, Windows 8 and Windows 10 (32 and 64bit) 

GRANTING OF RIGHTS

1.Steinberg hereby grants to the Licensee a non-exclusive, worldwide, nontransferable 
license during the term of this agreement to use the Licensed Software Developer Kit 
solely: 

• For the development of PlugIns/Application and/or for the development of an 
application that can host VST PlugIns (herein VST Product), 
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• Publish, sell or otherwise distribute a Product under his own brand name that is 
using parts or all of the Licensed Software Developer Kit. 

2.In case the Licensee receives a preliminary version of the Licensed Software 
Developer Kit, the Licensee is not allowed to publish any Product to the public using a 
preliminary Software Developer Kit. The Licensee is only allowed to publish Products to 
the public based on a Licensed Software Developer Kit which is not declared as a 
preliminary version by Steinberg. 

3.The Licensee has no permission to sell, licence, give-away and/or distribute the 
Licensed Software Developer Kit or parts of it for the use as software developer kit in 
any way, for example, integrated in any framework application, on any medium, 
including the Internet, to any other person, including sub-licensors of the Licensee or 
companies where the Licensee has any involvement. This includes re-working this 
specification, or reverse-engineering any products based upon this specification. 

4.In case the Licensed Software Developer Kit is modified, it shall not be published, sold 
or distributed without agreement of Steinberg. Furthermore, the naming of the 
Licensed Software Developer Kit shall not include "VST3.6.6 SDK" or any combination 
containing the VST brand without permission of Steinberg. 

5.In case the Licensed Software Developer Kit is extended by additional code, it shall 
not be used in any other description than "(Licensees company name) extension to the 
Steinberg VST3.6.6 SDK". 

6.The Licensee recognises the value of the goodwill associated with the mark VST Plug-
In Technology and acknowledges that such goodwill exclusively belongs to the benefit 
of Steinberg and belongs to Steinberg. The Licensee warrants that it will not use the 
mark VST PlugIn Technology on promotional merchandise, with the exception of demo 
versions of any of his product making use of this Licensed Software Developer Kit. The 
Licensee warrants that it will not use the mark VST PlugIn Technology on, or in 
connection with products obscene, pornographic, excessively violent or otherwise in 
poor taste. 

7.If the Licensee is developing a Product, that is using parts or all of the Licensed 
Software Developer Kit, and this product is not published under his own name but will 
be published under the name of a third party, this third party has to agree to be bound 
by Sections 2.1 to 2.3 and 3 of this VST PlugIns SDK Licensing Agreement. The third 
party has to completely comply with these provisions. If the third party is not in 
accordance with these conditions, the third party is not allowed to distribute this 
product which is using parts or all of the Licensed Software Developer Kit. 

8.If the Licensee is planning to publish a Product under his own name or under the 
name of a third party, that is using parts or all of the Licensed Software Developer Kit, 
the Licensee is under the obligation to inform Steinberg about it by sending the signed 
'Steinberg VST Plug-In SDK Licensing Agreement' to Steinberg, either by mail, or by fax. 

COPYRIGHTS NOTICE, USE OF TRADEMARKS

If the Licensee is publishing a Product under his own name that is using parts or all of 
the Licensed Software Developer Kit, the Licensee shall be under an obligation to refer 
to Steinberg's copyrights and trademarks in the following way: 
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a) In case that the Licensee is publishing a 'boxed product', the Licensee shall display in 
a visible manner the VST Logo and Steinberg's copyright notice on the packages. 
Steinberg's copyrights notice: "VST is a trademark and software of Steinberg Media 
Technologies GmbH" 

b) In case that the Product is published without a physical packages (e.g. download), 
The Licensee shall display the VST Logo and Steinberg's copyrights notice on the 
Licensee's website in the context of the Product. 

c) The Licensee shall include the VST Logo and Steinberg's copyrights notice in all 
electronic documentation, regardless of the media used, such as PDF manuals, website 
etc. and all printed and all electronic advertising materials. The VST Logo artwork and 
usage guidelines are part of the "Licensed Software Developer Kit" and are supplied by 
Steinberg in digital format. 

d) In the 'about box' or an alternative place (e.g. help menu, startup screen) of the 
Product in one of the following formats: VST PlugIn Technology by Steinberg Media 
Technologies, VST PlugIn Interface Technology by Steinberg Media Technologies 
GmbH. 

FEES AND ROYALTIES

1.This license is non-royalty bearing and the Licensee shall not obligated to pay to 
Steinberg any fees or royalties with respect to the VST PlugIn Interface technology. 

LIMITATION OF LIABILITY

1.Subject to the provisions in the following sub-sections, Steinberg shall only be liable, 
irrespective of the legal grounds, for damages caused by the intentional or grossly 
negligent conduct of Steinberg, its legal representatives, managerial employees or any 
other vicarious agents. In the case of damage caused by the grossly negligent conduct 
of any other vicarious agents, the liability shall be limited to those damages which must 
typically be expected within the scope of an agreement such as the present one. Any 
further liability other than as permitted under this agreement shall be excluded. 

2.Any liability of Steinberg for damages arising form violation of life, body and health, 
from the assumption of a guarantee or from a procurement risk as well as Steinberg's 
liability for damages pursuant to the Product Liability Act (Produkthaftungsgesetz) 
shall remain unaffected. 

3.To the extent the liability of Steinberg is excluded pursuant to the subsections of 
these provisions, this shall also apply to the benefit of Steinberg's employees in the 
event the Licensee files any claims directly against them. 

FFmpeg Project
GNU LESSER GENERAL PUBLIC LICENSE Version 2.1, February 1999 Copyright (C) 1991, 
1999 Free Software Foundation, Inc.

51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA Everyone is permitted to 
copy and distribute verbatim copies of this license document, but changing it is not 
allowed.
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[This is the first released version of the Lesser GPL. It also counts as the successor of the 
GNU Library Public License, version 2, hence the version number 2.1.] 

Preamble The licenses for most software are designed to take away your freedom to 
share and change it. By contrast, the GNU General Public Licenses are intended to 
guarantee your freedom to share and change free software--to make sure the software 
is free for all its users.

This license, the Lesser General Public License, applies to some specially designated 
software packages--typically libraries--of the Free Software Foundation and other 
authors who decide to use it. You can use it too, but we suggest you first think carefully 
about whether this license or the ordinary General Public License is the better strategy 
to use in any particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use, not price. Our 
General Public Licenses are designed to make sure that you have the freedom to 
distribute copies of free software (and charge for this service if you want); that you 
receive source code or can get it if you want it; that you can change the software and 
use pieces of it in new free programs; and that you are informed that you can do these 
things.

To protect your rights, we need to make restrictions that forbid distributors to deny you 
these rights or to ask you to surrender these rights. These restrictions translate to 
certain responsibilities for you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must 
give the recipients all the rights that we gave you. You must make sure that they, too, 
receive or can get the source code. If you link other code with the library, you must 
provide complete object files to the recipients, so that they can relink them with the 
library after making changes to the library and recompiling it. And you must show 
them these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we 
offer you this license, which gives you legal permission to copy, distribute and/or 
modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for 
the free library. Also, if the library is modified by someone else and passed on, the 
recipients should know that what they have is not the original version, so that the 
original author's reputation will not be affected by problems that might be introduced 
by others.

Finally, software patents pose a constant threat to the existence of any free program. 
We want to make sure that a company cannot effectively restrict the users of a free 
program by obtaining a restrictive license from a patent holder. Therefore, we insist 
that any patent license obtained for a version of the library must be consistent with the 
full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General 
Public License. This license, the GNU Lesser General Public License, applies to certain 
designated libraries, and is quite different from the ordinary General Public License. We 
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use this license for certain libraries in order to permit linking those libraries into non-
free programs.

When a program is linked with a library, whether statically or using a shared library, the 
combination of the two is legally speaking a combined work, a derivative of the original 
library. The ordinary General Public License therefore permits such linking only if the 
entire combination fits its criteria of freedom. The Lesser General Public License permits 
more lax criteria for linking other code with the library.

We call this license the "Lesser" General Public License because it does Less to protect 
the user's freedom than the ordinary General Public License. It also provides other free 
software developers Less of an advantage over competing non-free programs. These 
disadvantages are the reason we use the ordinary General Public License for many 
libraries. However, the Lesser license provides advantages in certain special 
circumstances.

For example, on rare occasions, there may be a special need to encourage the widest 
possible use of a certain library, so that it becomes a de-facto standard. To achieve this, 
non-free programs must be allowed to use the library. A more frequent case is that a 
free library does the same job as widely used non-free libraries. In this case, there is 
little to gain by limiting the free library to free software only, so we use the Lesser 
General Public License.

In other cases, permission to use a particular library in non-free programs enables a 
greater number of people to use a large body of free software. For example, permission 
to use the GNU C Library in non-free programs enables many more people to use the 
whole GNU operating system, as well as its variant, the GNU/Linux operating system.

Although the Lesser General Public License is Less protective of the users' freedom, it 
does ensure that the user of a program that is linked with the Library has the freedom 
and the wherewithal to run that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay 
close attention to the difference between a "work based on the library" and a "work 
that uses the library". The former contains code derived from the library, whereas the 
latter must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, 
DISTRIBUTION AND MODIFICATION This License Agreement applies to any software 
library or other program which contains a notice placed by the copyright holder or 
other authorized party saying it may be distributed under the terms of this Lesser 
General Public License (also called "this License").

Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data prepared so as to be 
conveniently linked with application programs (which use some of those functions and 
data) to form executables.

The "Library", below, refers to any such software library or work which has been 
distributed under these terms. A "work based on the Library" means either the Library 
or any derivative work under copyright law: that is to say, a work containing the Library 
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or a portion of it, either verbatim or with modifications and/or translated 
straightforwardly into another language. (Hereinafter, translation is included without 
limitation in the term "modification".) "Source code" for a work means the preferred 
form of the work for making modifications to it. For a library, complete source code 
means all the source code for all modules it contains, plus any associated interface 
definition files, plus the scripts used to control compilation and installation of the 
library.

Activities other than copying, distribution and modification are not covered by this 
License; they are outside its scope. The act of running a program using the Library is not 
restricted, and output from such a program is covered only if its contents constitute a 
work based on the Library (independent of the use of the Library in a tool for writing it). 
Whether that is true depends on what the Library does and what the program that uses 
the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code 
as you receive it, in any medium, provided that you conspicuously and appropriately 
publish on each copy an appropriate copyright notice and disclaimer of warranty; keep 
intact all the notices that refer to this License and to the absence of any warranty; and 
distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your 
option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a 
work based on the Library, and copy and distribute such modifications or work under 
the terms of Section 1 above, provided that you also meet all of these conditions: a) The 
modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices stating that you 
changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge to all third parties 
under the terms of this License.

d) If a facility in the modified Library refers to a function or a table of data to be supplied 
by an application program that uses the facility, other than as an argument passed 
when the facility is invoked, then you must make a good faith effort to ensure that, in 
the event an application does not supply such function or table, the facility still 
operates, and performs whatever part of its purpose remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is 
entirely well-defined independent of the application. Therefore, Subsection 2d requires 
that any application-supplied function or table used by this function must be optional: 
if the application does not supply it, the square root function must still compute square 
roots.) These requirements apply to the modified work as a whole. If identifiable 
sections of that work are not derived from the Library, and can be reasonably 
considered independent and separate works in themselves, then this License, and its 
terms, do not apply to those sections when you distribute them as separate works. But 
when you distribute the same sections as part of a whole which is a work based on the 
Library, the distribution of the whole must be on the terms of this License, whose 



Acknowledgements
Acknowledgements

293

permissions for other licensees extend to the entire whole, and thus to each and every 
part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work 
written entirely by you; rather, the intent is to exercise the right to control the 
distribution of derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the 
Library (or with a work based on the Library) on a volume of a storage or distribution 
medium does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead 
of this License to a given copy of the Library. To do this, you must alter all the notices 
that refer to this License, so that they refer to the ordinary GNU General Public License, 
version 2, instead of to this License. (If a newer version than version 2 of the ordinary 
GNU General Public License has appeared, then you can specify that version instead if 
you want.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary 
GNU General Public License applies to all subsequent copies and derivative works 
made from that copy.

This option is useful when you want to copy part of the code of the Library into a 
program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under 
Section 2) in object code or executable form under the terms of Sections 1 and 2 above 
provided that you accompany it with the complete corresponding machine-readable 
source code, which must be distributed under the terms of Sections 1 and 2 above on a 
medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated 
place, then offering equivalent access to copy the source code from the same place 
satisfies the requirement to distribute the source code, even though third parties are 
not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed 
to work with the Library by being compiled or linked with it, is called a "work that uses 
the Library". Such a work, in isolation, is not a derivative work of the Library, and 
therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library creates an executable 
that is a derivative of the Library (because it contains portions of the Library), rather 
than a "work that uses the library". The executable is therefore covered by this License.

Section 6 states terms for distribution of such executables.

When a "work that uses the Library" uses material from a header file that is part of the 
Library, the object code for the work may be a derivative work of the Library even 
though the source code is not.
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Whether this is true is especially significant if the work can be linked without the 
Library, or if the work is itself a library. The threshold for this to be true is not precisely 
defined by law.

If such an object file uses only numerical parameters, data structure layouts and 
accessors, and small macros and small inline functions (ten lines or less in length), then 
the use of the object file is unrestricted, regardless of whether it is legally a derivative 
work. (Executables containing this object code plus portions of the Library will still fall 
under Section 6.) Otherwise, if the work is a derivative of the Library, you may distribute 
the object code for the work under the terms of Section 6.

Any executables containing that work also fall under Section 6, whether or not they are 
linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a "work that 
uses the Library" with the Library to produce a work containing portions of the Library, 
and distribute that work under terms of your choice, provided that the terms permit 
modification of the work for the customer's own use and reverse engineering for 
debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it 
and that the Library and its use are covered by this License. You must supply a copy of 
this License. If the work during execution displays copyright notices, you must include 
the copyright notice for the Library among them, as well as a reference directing the 
user to the copy of this License. Also, you must do one of these things: a) Accompany 
the work with the complete corresponding machine-readable source code for the 
Library including whatever changes were used in the work (which must be distributed 
under Sections 1 and 2 above); and, if the work is an executable linked with the Library, 
with the complete machine-readable "work that uses the Library", as object code and/
or source code, so that the user can modify the Library and then relink to produce a 
modified executable containing the modified Library. (It is understood that the user 
who changes the contents of definitions files in the Library will not necessarily be able 
to recompile the application to use the modified definitions.) b) Use a suitable shared 
library mechanism for linking with the Library. A suitable mechanism is one that (1) 
uses at run time a copy of the library already present on the user's computer system, 
rather than copying library functions into the executable, and (2) will operate properly 
with a modified version of the library, if the user installs one, as long as the modified 
version is interface-compatible with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three years, to give the 
same user the materials specified in Subsection 6a, above, for a charge no more than 
the cost of performing this distribution. 

d) If distribution of the work is made by offering access to copy from a designated 
place, offer equivalent access to copy the above specified materials from the same 
place.

e) Verify that the user has already received a copy of these materials or that you have 
already sent this user a copy.

For an executable, the required form of the "work that uses the Library" must include 
any data and utility programs needed for reproducing the executable from it. However, 
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as a special exception, the materials to be distributed need not include anything that is 
normally distributed (in either source or binary form) with the major components 
(compiler, kernel, and so on) of the operating system on which the executable runs, 
unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other 
proprietary libraries that do not normally accompany the operating system. Such a 
contradiction means you cannot use both them and the Library together in an 
executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a 
single library together with other library facilities not covered by this License, and 
distribute such a combined library, provided that the separate distribution of the work 
based on the Library and of the other library facilities is otherwise permitted, and 
provided that you do these two things: a) Accompany the combined library with a copy 
of the same work based on the Library, uncombined with any other library facilities. 
This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work 
based on the Library, and explaining where to find the accompanying uncombined 
form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as 
expressly provided under this License. Any attempt otherwise to copy, modify, 
sublicense, link with, or distribute the Library is void, and will automatically terminate 
your rights under this License. However, parties who have received copies, or rights, 
from you under this License will not have their licenses terminated so long as such 
parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, 
nothing else grants you permission to modify or distribute the Library or its derivative 
works. These actions are prohibited by law if you do not accept this License. Therefore, 
by modifying or distributing the Library (or any work based on the Library), you 
indicate your acceptance of this License to do so, and all its terms and conditions for 
copying, distributing or modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the 
recipient automatically receives a license from the original licensor to copy, distribute, 
link with or modify the Library subject to these terms and conditions. You may not 
impose any further restrictions on the recipients' exercise of the rights granted herein.

You are not responsible for enforcing compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for 
any other reason (not limited to patent issues), conditions are imposed on you 
(whether by court order, agreement or otherwise) that contradict the conditions of this 
License, they do not excuse you from the conditions of this License. If you cannot 
distribute so as to satisfy simultaneously your obligations under this License and any 
other pertinent obligations, then as a consequence you may not distribute the Library 
at all. For example, if a patent license would not permit royalty-free redistribution of the 
Library by all those who receive copies directly or indirectly through you, then the only 
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way you could satisfy both it and this License would be to refrain entirely from 
distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular 
circumstance, the balance of the section is intended to apply, and the section as a 
whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other 
property right claims or to contest validity of any such claims; this section has the sole 
purpose of protecting the integrity of the free software distribution system which is 
implemented by public license practices. Many people have made generous 
contributions to the wide range of software distributed through that system in reliance 
on consistent application of that system; it is up to the author/donor to decide if he or 
she is willing to distribute software through any other system and a licensee cannot 
impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence 
of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by 
patents or by copyrighted interfaces, the original copyright holder who places the 
Library under this License may add an explicit geographical distribution limitation 
excluding those countries, so that distribution is permitted only in or among countries 
not thus excluded. In such case, this License incorporates the limitation as if written in 
the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the 
Lesser General Public License from time to time.

Such new versions will be similar in spirit to the present version, but may differ in detail 
to address new problems or concerns.

Each version is given a distinguishing version number. If the Library specifies a version 
number of this License which applies to it and "any later version", you have the option 
of following the terms and conditions either of that version or of any later version 
published by the Free Software Foundation. If the Library does not specify a license 
version number, you may choose any version ever published by the Free Software 
Foundation.

14. If you want to incorporate parts of the Library into other free programs whose 
distribution conditions are incompatible with these, write to the author to ask for 
permission. For software which is copyrighted by the Free Software Foundation, write 
to the Free Software Foundation; we sometimes make exceptions for this. Our decision 
will be guided by the two goals of preserving the free status of all derivatives of our free 
software and of promoting the sharing and reuse of software generally.

NO WARRANTY 15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO 
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.

EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR 
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
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WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE 
ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE LIBRARY IS WITH YOU. 
SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY 
SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING 
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR 
REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, 
INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT 
LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES 
SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE 
WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Syphon
Syphon is licensed under a Simplified BSD license. Copyright 2010 bangnoise (Tom 
Butterworth) & vade (Anton Marini).  All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list 
of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS 
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS 
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

MIT
Copyright (c) 2018 Telestream, LLC

Permission is hereby granted, free of charge, to any person obtaining a copy of this 
software and associated documentation files (the "Software"), to deal in the Software 
without restriction, including without limitation the rights to use, copy, modify, merge, 
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons 
to whom the Software is furnished to do so, subject to the following conditions:
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The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL 
THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR 
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR 
OTHER DEALINGS IN THE SOFTWARE.
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